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] Introduction

Curious World Maps has for years kept its position as the broadcast industry’s
number one tool for creation of branded 2D maps and geographic animations.
Vizrt has taken the leading map creation tool to a new level by adding support for
real-time 3D maps and adding the option to extend it to a client-server solution.
Viz Curious Maps (CM) takes branded map imagery and provides it to different
clients that are embedded within Vizrt’s control applications like Viz Trio and Viz
Content Pilot. Templates created within CM can also be accessed by Viz Weather,
through a newsroom plugin, Viz Artist, and even NLE systems.

This tight integration allows users to seamlessly create branded, animated maps
and add them to graphic templates or insert them directly into a 3D scene.

The map-making capabilities of CM can be further expanded with different map
data types in resolutions of up to 60 cm/pixel. High-resolution satellite imagery
from around the world can instantly be browsed, download and incorporated.

Viz World Client (WoC) Integrates CM mapping ability and database into Viz Artist
and Viz Engine graphics. By utilizing a set of geographic referencing plugins and
the maps produced by WoC, the creation of location based graphics using maps,
3D objects, texts, and so on, is seamless.

WoC includes a set of Viz Artist plugins and the Viz World Map Editor (WME). The
editor is integrated into Vizrt products, simplifying production and control of the
graphics.

Usage of WoC clients requires one or more Viz World Servers (WoS) installed,
running and connected to the network. WoS is a software module used for
creating template based maps and managing client requests. All the map styles,
map projects and designs are stored on the server. The server’s license
determines the number of concurrent client connections and the available data
sets. For more information, please refer to other Viz Curious Maps and Viz World
related user and administrator guides.

This section contains information on the following topics:

Document Structure
Related Documents
Contact Vizrt

1.1 Document Structure

This section gives a short introduction to the WoC, and what part it plays in the
complete CM solution.

The About section gives an overview of the new features and basic workflow.

The Requirements section describes the license, software and hardware
requirements for both WoS and WoC.
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The Viz Curious Maps section introduces the Viz Curious Maps (CM) application
which is the tool for creating map templates with different styles, projections and
so on. It also describes how to create a basic template, explaining the connection
between CM, WoC and the WoS.

The Viz World Server section describes how to install, run and remove Viz World
Server (WoS).

The Server Configuration section describes the map server configuration tool, and
in addition it explains how to add a license file.

The Server Launcher section describes the possible server configurations that
allow users to configure single or multiple servers to balance the server load and
optimize redundancy.

The Open Street Map section describes the download tool and how to use it for
downloading open street map data from Vizrt’s FTP service.

The Cache Configuration section describes the maps caching mechanism.

The Viz World Client section gives a brief overview of the Viz World Client (WoC),
some requirements and recommendations, installation and removal notes.

The Viz World Map Editor section describes the Viz World Map Editor (WME) user
interface and how to select and edit maps for use with graphics templates and
scenes.

The plugin sections describes all plugins available to designers that design Viz
Artist scenes. As an extension to the plugins section, you also have a section on
Geographically Referenced Maps.

The Viz World Plugin APl and Viz World Server REST Support sections give an
overview and explanation on how to use the plugin and REST API.

1.2

Related Documents

For complementary information, see the following documents:
1. Viz Artist User’s Guide. Information on how to create graphics scenes in Viz
Artist.

2. Viz Content Pilot User’s Guide: Information on how to create content based on
templates and how to play out elements in playlists based on these templates.

3. Viz Curious Maps User’s Guide: Information on how to create map projects
and map project templates.

4. Viz NLE Administrator’s Guide: Information on how to use your graphics in a
non-linear editing tool.

5. Viz Trio User’s Guide. Information on how to create real-time character
generated content based on templates and how to play out pages in shows
based on these templates.

6. Viz Weather User’s Guide:. Information on how to create real-time generated
weather information and interactive shows using branded maps.
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1.3 Contact Vizrt

We encourage your suggestions and feedback regarding the product and this
documentation. Our support E-mail address is support@vizrt.com. You are also
welcome to use the web-based support at www.vizrt.com, or to contact your local
Vizrt support personnel by telephone.
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2 About

This section describes the new features of the Viz World Client and Server, and the
basic workflow from design to playout.

This section contains information on the following topics:

New Features

Workflow

2.1 New Features

New database from Collins Bartholome.

DigitalGlobe Online:

- New DigitalGlobe Online service allowing access to global high resolution
imagery.

- FirstLook option - access to crisis event imagery from DigitalGlobe from
inside the Viz World workflow.

Better support for online departments, allowing easy APIs into the Viz World

Server and Viz World data. This can be used to produce branded maps for the

website.

Atlas plugin now works with the Globe geometry plugin.

Traffic:

- Improved street labeling with Street Labels.

- Traffic feed from Inrix.

Improved server redundancy options:

- Priority mechanism for server.

- New low-cost backup server.

- Compensation for dead server licenses which allow other servers to use
licenses for servers that for some reason are not online/running.

- A secondary cache for failover or static local cache for improved loading
time.

Multi-language support:

- Unlimited number of languages.

- Switching language on the fly from WME’s context menu.

New Viz World Plugin API.

New Map Name Editor for quick editing of user names and languages.

2.2 Workflow

The basic workflow from design of templates to playout is as follow:

1.

First step of the process is to create a single (or multiple) in-house map
project template that sets the look and feel of all the produced maps later in
the production chain. This is done using Viz Curious Maps (CM), selecting for
example style and color on the selected map area, type of border lines, label
fonts and available marker icons.
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2. The designed map project template is made available to users of Vizrt client
software via the Viz World Server (WoS).

3. A graphic designer creates Viz scenes that include maps, based on the same
map project template now residing on the Viz World Server. The designer has
the option to create 2D or 3D labels and markers inside Viz, instead of using
the ones exposed in Viz Curious Maps.

4. Based on the Viz scenes, graphical templates can be made for other Vizrt
applications.

5. An editor opens a template, from for example the Viz Content Pilot or Viz
Weather system, and creates a map to fit the main news or weather story of
today.
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3

Requirements

This section describes the prerequisites such as the licensing, software and
hardware requirements.

To install and configure the software, please see Viz World Server, Viz World
Client and Server Configuration.

This section contains information on the following topics:
- License Requirements

Software Requirements
Hardware Requirements
Ports and Connections

3.1 License Requirements
The following licenses are needed to run Viz World Server and Viz Engine:
A USB dongle license for Viz Engine.
A USB dongle license for Viz World Server
Note: Viz World Server is a feature included in the license file. If the server has
additional features enabled, make sure the new license covers those features as well.
3.2 Software Requirements
Viz World Server (WoS) and Viz World Client (WoC) version 11.0 installation is
required.
- It is recommended to install the server on a different machine.
Viz Curious Maps (CM) database version 11.0 or later is required.
Microsoft .NET Framework 4 is required for the Map Builder wizard.
To set up a Viz Curious Maps solution for graphics design, the following software
and version numbers are needed.
Viz Artist 3.2.2 or later
Viz Artist 2.8 patch level 4 or later and Extra Viz 2 Plugins 1.9 or later
For a newsroom/control room operation with Viz Curious Maps solution, the
following version numbers are required:
Viz Trio 2.7 or later
Viz Content Pilot 5.3 or later
Media Sequencer 1.19 or later.
3.3 Hardware Requirements
Minimum server hardware configuration:
CPU: Intel Core2 CPU, 2.0 GHz
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Memory: 4GB

Hard disk space: A full installation requires 1.3 GB free disk space. Optional
data packages will require between 4GB to 500GB free disk space.

OS: Microsoft Windows XP Professional.

Recommended server hardware configuration:
- CPU: 2 x Intel Xeon CPU, 3.2 GHz

Memory: 8GB

Hard disk space: A full installation requires 1.3 GB free disk space. Optional
data packages will require between 4GB to 500GB free disk space.

OS: Microsoft Windows XP64 Professional or Microsoft Windows Server 2003.

When using more than one server on a single machine (with Server Allocator) the
recommend hardware is needed.

Also note that fast and multiple CPU cores are the most important component of
WoS.

See Also

Server Launcher Configuration

3.4 Ports and Connections

The following describes all connections and default listening port numbers that
are important for any system/network administrator to know of. However, it is, if
possible, recommended to run the system on a network without firewalls.

102 (TCP) is a Viz World Server listener port for Viz World Client connections when
Server Allocator is not in use or only has one Viz World Server running.

103 (TCP) is a Viz World Server listener port for configuration tool connections to
the first Viz World Server instance (as configurations are controlled by the first
server instance).

10100 (TCP) is a Server Allocator listener port for Viz World Client connections,
and is only used in order for clients to get connection details about Viz World
Server(s). The first client connection will always be diverted to port 102. In case of
Multiple server instances port numbers are assignmed according to a predefined
schema. In case there is no Server Allocator, Viz World Server will itself switch to
port 102.

10100 (UDP) is a Viz World Server listener port for Server Allocator
communication.

10200 (UDP) is a Server Allocator listener port for Viz World Server
communication.

Both UDP ports are internal ports used between the servers.
Multiple server instances

If a machine is running multiple Viz World Server instances every extra instance
(second and above) opens other ports by this formula:
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Viz World Server listener port (TCP): 10100 + ID - 1.

Server Allocator listener port (UDP): 10200 + ID - 1 (this is an internal port
between servers) (where ID indicates the instance, e.g. 3rd server, ID = 3).

If four Viz World Server instances are configured, the following listener ports will
be used:
- 102 (TCP): 1st instance

10101 (TCP): 2nd instance
10102 (TCP): 3rd instance
10103 (TCP): 4th instance

10100 (TCP) : Viz World Client(s) connection to the Server Allocator.
103 (TCP): Configuration tool connection to the Viz World Server.

Internal ports used by Server Allocator and Viz World Server(s) to communicate
between themselves:
- 10100 (UDP): Server Allocator

10200 (UDP): 1st instance
10201 (UDP): 2nd instance
10202 (UDP): 3rd instance
10203 (UDP): 4th instance
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4  Viz Curious Maps

Figure 1: Viz Curious Maps

"o Curious World Maps 9.0 - Untitled =] x|
Fle Edt Vew Layer Shes Import Took ideo Help

DEH| ¥ Bax T8 SE B Ol0® @2 NE T

Viz Curious Maps™

i || 0. Pl ||

" Craate empty project

! Create pairt project !
' Createmap proiect  [Combination Database E ™,
Seltings |

' Use a project template

e

Combinaion Database

Cancel

“@la] v [ m [ ef | [[00000000 Dusion [ 00000200  Timecode ¢ Fiames Range.. | k| 1|

[ 00:00:01:24
Praperties |cnmer\ls| paint | Lighting | Layer Fx | keybars |
7 Transform B ~Emz=in ol T Quick Map
Locked IS Style Sheet
- - L Cylndical Equidistant 2 Apply [Pryseal seecton =] = A
Map Center Lang 0.00000 = Lat 0.00000 _‘; iysical Selection .‘Q
= = Uil g o] ‘ J
Rotations leng 0 ojtet | Laiitude are mapped diectly M| peto Arimate ” f
- w [ e v [ s _‘:j inta &, p coordinates. W
e e [ e "o
Posttion x [3900 =] v [z80.00 5] Quick.
Size % [ 1024 _‘::‘ v | 1024 _‘; Supparts Geolif export Vitual Earth Fade.. -5 _J_.‘
CurvedFaths
r =l 6P5 | Views [The workd =
Ready m/ J

This chapter introduces Viz Curious Maps (CM) which is the design tool for all
map templates used by Viz World Client (WoC) and Vizrt’s control applications.
This guide will not cover the aspects of maps design; however this chapter will
explain important elements to note when creating a basic map template. For more
information on template design see the Viz Curious Maps User’s Guide.

CM is a powerful design tool with a database back-end, used for the creation of
branded maps and geographic animations. By extending CM to a server edition, it
can provide real-time, branded map imagery to several clients embedded within
Vizrt's control applications. Templates created within CM can be dynamically
accessed through Vizrt’s control applications using the WoC.

CM has a comprehensive vector based database that includes regions, cities,
roads, rivers, and so on. The vector data is supplied to Vizrt under license from
Bartholomew Mapping (a division of Harper Collins publishers). CM also includes
global Tkm relief data in the DEM (Digital Elevation Model) format. The DEM data
is from the United States Geological Survey (USGS). Essentially, CM uses the best
mapping data available and is a full animation and compositing system.

This section contains information on the following topics:
- Project Template

- Styles Editor
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Markers

Map Projection

Map Position and Project Area Offset
Layer Stack and No Animation

4.1

Project Template

It is good practice to place all template (TPL) files in a single static location.

The recommended location is:
..\Program Files\Curious Software\Curious World
Maps\Users\Default\Projects

This folder and any sub-folders are automatically scanned for TPL files when the

Map Server is launched.

Note: The template location should be exactly the same on both the Maps Server and
any Viz Curious Maps standalone design systems. If the paths are not identical it
may well break the link to any image elements, e.g. Markers.

This section contains information on the following topics:
To open a project template

To save a project template

To open a project template

1. Select Open... (CTRL+0O) from the File menu.
2. Select Project Template (*.tpl, *.tpt, *.cgt) from the Files of type drop-list.
3. Select the template file and click Open.

To save a project template

1. Select Save (CTRL+S) from the File menu.
2. Select Project Template (*.tpl) from the Save as type drop-list.
3. Enter a filename, and click Save.
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4.2 Styles Editor
Figure 2: Styles Editor
|
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Using the Viz Cuious Maps (CM) Styles Editor, users can choose to modify an
existing default Style Sheet or create a new one.
The user has the ability to define and fully customize all of the available map data
elements via the CM’s Styles Editor. For example, the user can set region colors,
select any font (TrueType only), assign any static image (images with alpha are
supported) as a marker, modify shadow settings, change relief scale and lots
more!
The map Style Sheets defined within the CM Styles Editor are then saved as Project
Templates (TPL files). Each Project Template can include any number of Style
Sheets. These Project Templates can then be accessed via the Viz World Map
Editor (WME) within other Vizrt products, such as Viz Artist, Viz Trio, Viz Content
Pilot, and so on.
4.3 Markers

Many users work with customized Markers; hence, image files can be imported to
Viz Curious Maps (CM) from any location. CM will create a Relative or Absolute file
path to the actual image file (depending on its distance from the TPL). If CM
cannot locate an image file it will replace it with a ‘missing material’ red X.
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Figure 3: Markers

It is good practice to place all Markers in a single static location, as opposed to
multiple folders on a local computer and/or network.

The recommended, and default, location is:
..\Program Files\Curious Software\Curious World Maps\Markers

Note: When exporting a map related Viz Artist scene archive it is important to also
include the TPL files and any referenced image files (used for Markers, and so on).
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4.4 Map Projection

Figure 4: Map projection
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4

Virtual Earth F

An essential setting for 3D globe building in Viz Artist is To set the map
projection to an equidistant cylindrical projection (also known as equirectangular
or geographic projection). When using the map on a 3D globe in Viz Artist it will

give the right (or more correct) representation of the world.
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Figure 5: Wrong and correct projection

Using the wrong projection within Viz Artist, for example, with the Map Tiler
plugin to build a 3D globe, will produce a distorted projection.

This section contains information on the following topics:
To set the map projection

To set the map projection

1. Select the Properties tab.
2. Select from the Projection drop-list the Cylindrical Equidistant projection.

3. Select “The World” from the View drop-list (lower-right corner) to check that
the map is a flat and not a globe view of the World.

4. Click Apply.

4.5

14

Map Position and Project Area Offset

Within Viz Curious Maps (CM) there are two sizes to be aware of, the Project Size
and the Map Size. Both of these sizes have their own specific purpose and can
have different values; however, if the sizes are different or if the Map Position
does not match the Project Area exactly, the map will not look right when used in
Viz Artist, Viz Trio, Viz Content Pilot, and so on. Even a miniscule offset will break
the map.

Example: The Map Rectangle Tool (on the vertical toolbar) allows the user to freely

move the map around and can easily move the map out of position.

To avoid the issue entirely, one should delete the Map Layer and add a new one.
This automatically adds a map that fits the current Project Size, but note that it
will be using the Globe projection and requires correction.

This section contains information on the following topics:
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To set the project size
To set the map size
To add a new layer

To set the project size

1. Select Project Settings from the File menu.
2. In the Project Settings dialog box set the Width and Height parameters.
3. Click OK to confirm the new project settings.

To set the map size

1. Select the Properties tab on the Properties panel.

2. Select the Transform options, and set the same Size (X and Y) that was used To
set the project size.

3. Press Enter to confirm and update the map.

To add a new layer

Select Add Layer > Map from the Layer menu.

4.6

Layer Stack and No Animation

To avoid problems with the template (TPL) file, it is good practice to ensure that
only one layer is present in the Layer Stack. It is also important to remain at frame
1 in the timeline and refrain from adding any animation keyframes.
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Viz World Server

This section describes how to install, run and remove Viz World Server (WoS).

This section contains information on the following topics:
Installing Viz World Server

See Also
Viz World Server REST Support

5.1

Installing Viz World Server

Before an installation, check that the following hardware and software is available:
Viz World Server USB license dongle and license file

Viz Curious Maps full version (available locally or on the network)
This section contains information on the following topics:

To download the software

To install Viz Curious Maps Data
To install Viz Curious Maps

To install Viz World Server

To run the Server

To remove Viz World Server

To download the software

Whilst you have an active map support contract, you have a personal login to the
Vizrt FTP server (first year support is included).

Download the software from the Vizrt FTP at ftp://download.vizrt.com/ under
the Viz Curious Maps folder.

Note: You will need to use an FTP Client to access this site and not a regular web
browser.

Please use the FTP server to find the latest Vizrt software releases,

documentation, help files, drivers and more. You can also use the FTP to upload
and exchange files with Vizrt.

To install Viz Curious Maps Data

1. Start the Viz Curious Maps Data installer
2. Click Next

3. Click Install to begin the installation

4. Click Finish
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To install Viz Curious Maps

Before Viz Curious Maps is installed, you have To install Viz Curious Maps Data.

1. Start the Viz Curious Maps installer
2. Click Next
3. Click Yes to accept the license agreement
4. Select destination directory, and click Next
e C:\Program Files\Curious Software\Curious World Maps
Choose the components to install, and click Next
Select a start menu group, and click Next
Click Next to start the installation
Click Next to accept the Sentinel SuperPro Drivers installation
9. Confirm the installation of the Sentinel SuperPro Drivers
10.Click Finish
11. Optional Install QuickTime if it is not previously installed.
- If a newer version of QuickTime is installed the installation will be stopped.

© N oW

Tip: If you do not already have QucikTime installed you can download the installer
from the Apple website.

12.Click Next to continue

13.Choose setup language, and click OK

14.Click Yes to accept the license agreement

15.Choose destination folder, and click Next

16. Configure file and MIME types, and click Finish

17.Place the relevant Natural Earth files in the following location:

..\Program Files\Curious Software\Curious World
Maps\MapData\NaturalEarth

18.Place any relevant street data in the following location:

..\Program Files\Curious Software\Curious World
Maps\MapData\StreetData

19.Place the large DEMGlobal90m folder in a location of your choosing.

- Once Viz Curious Maps is up & running point the application to the data via:
View\Options\Map Data\Locations\CDEM Data

20.Optional: Install the dongle driver in the following location:

..\Program Files\Curious Software\Curious World
Maps\Installers\AladdinHardLock

- Installing the driver will allow Viz Curious Maps to detect and work with the
provided Vizrt dongle.

21.Start Viz Curious Maps.

To install Viz World Server

1. Run the installation file: VizWorldServer_x.x.x.exe
2. Click Next
3. Click Next to start the file transfer
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4. Click Finish

To run the Server

48 ¥iz CMS 10.0.0.2465 Pre Alpha 1 (Map DB ¥9.0) @ bgoorangez : 1010
Uiz CHMS 18.8.8.2465 Pre Alpha 1 (c> 1999-208? Vizrt Limited

License key: A392B15F PC
Hardware key found correctly.
License expires in 309 days

Loading datahase

Starting server : B3-FEB-2018 B3:45:17
Done

Maximum allowed simultaneous uwusers : 18
%lave Mode Enabled

1. Double-click the desktop shortcut, or
2. Select the program from the Start menu.
- All Programs > Curious Software> Viz World Server

3. A console window appears that loads the database. When done, the server is
ready to receive requests from clients.

To remove Viz World Server

1. Open the Add or Remove Programs tool
2. Select Viz World Server, and click the Change/Remove button
3. Click Finish
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Chapter 6: Server Configuration

Server Configuration

The server configuration tool is used to remotely configure the server settings .
The configuration tool is installed with Viz World Server (WoS) and can be installed
with Viz World Client.

From Windows start menu, select:
Server: Programs > Curious Software > Server Config, or

Client: Programs > Vizrt > Viz World Client > Server Configuration tool

CAUTION! The server is locked when using the configuration tool; hence, no client
connection will be accepted.

Note: When using Server Allocator with multiple servers, each machine running the
servers must be configured separately. Use the configuration tool to connect to all
the servers and configure them.

This section contains information on the following topics:
User Interface

Template
Locations
Users

License

Maps

Symbols
Timeouts
Proxy Server
Server Logging

See Also

Server Launcher
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User Interface

Figure 6: Disconnected main configuration window
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The server configuration window has two panes, the left pane displays the
configuration sections and the right pane displays the parameters of the selected
section.

Before using the configuration tool, a connection to the server must be
established. When a connection is established, the Connect button will be
disabled and the Disconnect button will be enabled. The right pane will be
populated with the parameters of the selected section.
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Figure 7: Connected main configuration window

There are currently 0 other users | Send Logoff Message | | Force Logoff | | Restart |

Ready [:][ |

Send Logoff Message: Sends a logoff request will to the server. The server will
end the session normally.

Force Logoff: Sends a logoff message to the server, ending the session
immediatlly.

Restart: Restarts the server instantly. The configuration tool will be
disconnected from the server. When a Map Server is defined (see Server
Launcher Configuration tool), and more than one instance of Viz World Server
is defined, all instances will be restarted.

CAUTION! When Viz Maps Server Config tool is running the server is locked. No
client connection will be accepted.

To connect to the server

Enter the server name or IP address in the Map Server field, and click Connect.

See Also

Locations

Users

License

Maps

Standalone Clients
Symbols

Timeouts

Proxy Server
Server Logging
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6.2 Template

Project Template

The project template is used to spedfy the image size
and available styles for all dients, You should create
a template file using Curious World Maps.

C:\Program Files\Curious Software\Cu

Project Template Folder

The project template folder is used to contain
templates which any user can open.

C:VProgram Files\Curious SoftwareCu

Project Template: Defines the default project that will be used by the server
when initially asking for a map or the client requestes a project that does not
exist.

Project Template Folder: Defines the folder in which the project templates are
stored. When the user clicks the Open New Template button on WME’s Map
Tool Options toolbar, the displayed templates list will be fetched from the
template files in the Project Template Folder.

6.3 Locations

The Locations section defines the path to required Viz Curious Maps software
components.

Locations for the installed compaonents.

Root | C:\Program Files\Curious Software\Curious Wt | | Browse. ..
Licenses | C:'Program Files\Curious Software\Curious W | | Browse

Settings | C:'Program Files\Curious Software\Curious We | | Browse...

kML | C:'\Program Files\Curious Software\Curious We | | Browse. ..

Root: Defines the installation folder for Viz Curious Maps
Licenses: Defines the license file(s) folder for Viz Curious Maps.
Settings: Defines the path to the settings folder for Viz Curious Maps.

6.4 Users

The Users section displays the users configured on the server. Viz World Clients
use the pre-defined Guest user to log on to the server. The Users > Guest screen
is used to set some of the guest user permissions.
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allow Guest
allow Guest Projects

GuestProject | c:\program Files\Curious Software\Curious We _
Folder q II. [ Browse...
Guest kML | . i i " i A .
ider C:'\Program Files\Curious Software\Curious Wt | |Browse. ..

- Allow <user name>: Allows the user to connect to the server when running
WME or Viz.

- Allow <user name> Projects: Allows the user to access projects defined in the
<user name> Project Folder.

- <user name> Project Folder: Defines the path to a folder containing the user’s
projects.

6.5 License

Figure 8: License parameters

Thu Feb 11 11:37:33 2010 |

Viz CM5 10.0.0, 2554 RC (Map DE v10.0)
00226496810 PC [ License key: A392B15F PC
Hardware key found correctly.

537 queries sent to dongle, bl
-
v.

Add License From File... ] [ Dump License Info... l

The License section displays information about the current server license and
enables the user to load other license files.

- Add License From File: Opens a file browser that enables the user to load
additional license features from a different license file and to add it to the
system. After a new license file is added, the Apply button is enabled.

- Dump License Info: Saves the license information, that is displayed in the text
box, to a file.

- Apply: Applies the new license information to the system’s license file.
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This section contains information on the following topics:
To manually add a license file

To add a license file using the Maps Server Configuration tool
To add a license file using Viz Curious Maps

To manually add a license file

Locate the License file (*.lic), copy and paste it into the Licenses folder (see
example path below).

Note: If the license is not valid, the server will not start, and the server console will
exit.

To add a license file using the Maps Server Configuration tool

1. Start the server configuration tool.

2. Select the License section.

3. Click the Add License From File ... button.

4. Locate and select the file and click Open to add the new license file.
- The license becomes visible in the Edit License window.

5. Click Restart to start the server with the new license.

Note: If the license is not valid, the server will not start, and the server console will
exit.

To add a license file using Viz Curious Maps

When starting the Viz Curious Maps design application without a license, a
window appears telling that no license can be found.
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Ho License IE

Wiz Curious kaps iz unable to run az you do not appear to hawve a curent, valid
licenze.

To purchaze a licenze for thiz software, or request a time-limited
EVALUATION censze enabling all features, pleaze wizit us at
LA, CLNoLE-gofbware, com

Ethernet |L: pﬂ19bbdf5c39 PC

Lizenze key: A7YEZEE41BEIDT15E Viz
Hardware key found comectly.

Hardware Key:

Lizenze...

Start the Viz Curious Maps application

Click the License button to open the Software License window

Click the Edit License File ... button to open the Edit License window

Click the Add License from a File ... button to browse for the License file (*.lic)
Select the License file and click Open

- The license becomes visible in the Edit License window

6. Click OK to save the License. The license is saved to the License folder

7. Exit the application and run the Viz World Server.

uvT D W N—

Note: If the license is not valid, the server will not start, and the server console will
exit.

6.6 Maps

The Maps section is used to define general map settings.

This section contains information on the following topics:
- Database

Database Features
Disputed Regions
Default Projection
Map Legend
Locations

User DEMs
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- Attribution

- Bing

- Digital Globe

- Events

- Display

- Street Admin

- Imported Data
< Plugins

- Place Finder

6.6.1 Database

Figure 9: Maps Database parameters
Database |Combination Database v

Shared User Map Data
IIzer Map Details and Alternate Mames are loaded from
text files created with Curious World Maps.

ser Map Details are added using the Mew Detail button

C:\Program Files\Curious Software\Cu

Alternate Mames for map details can be set in the Map
Details Properties tab

C:\Program Files\Curious Software\Cu

Abbreviations

C:\Program Files\Curious Software\Cu

- Database: Select the data base type. It only displays location entries that are
visible in the map area.

- Shared User Map Data: Defines the source of data used by the database.

6.6.2 Database Features

Accented characters

() Remove non latin-1 accents on database load

") Remove non latin-1 accents if not supported by font

(¥ Display Mull character where font does not support accented character

Database Features

The detailed databases contain additional features from sources that
may not accurately align with the base data. Reset this switch to hide
these features.

IUse all data sources for searching

- Accented characters: Handles accent characers in labels such as ~ in Fraczak.

- DataBase Features: Defines if the WME search tool will use additional
databases in the system or only the main database of Viz Curious Maps.
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6.6.3 Disputed Regions

Region | Arunachal Pradesh kl
Configuratior | Default &I

Region: Displays a list of the disputed regions defined in the system. Select
one of the dsputed regions to be configured.

Configuration: Displays a list of region and border options related to the
selected disputed region in the Region parameter. Select an option from the
list and the graphic display will change according to the selected option.

6.6.4 Default Projection

Figure 10: Default projection parameters

Drefault Projection

The default Frojection iz uzed when a client openz a template that
doezn't have a map layer

Globe v

[Globe projection

Supportz Geotiff export

Sets the default projection for when a client opens a template that does not have a
map layer. The following options can be set:
Globe: Sets a globe projection.
Cylindrical Equidistant: Sets an unprojected map. Longitude and latitude are
are mapped directly into Xand Y coordinates.
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6.6.5

28

Miller Equidistant (37 30): Relative distances are correct. Angles are correct
around 37 degrees 30 minutes North.

Miller Equidistant (43): Relative distances are correct. Angles are correct
around 43 degrees North. Minimum scale distortion over continents.

Miller Equidistant (50 28): Relative distances are correct. Angles are correct
around 50 degrees 28 minutes North.

Gall Isographic: Relative distances are correct. Angles are correct around 45
North.

Lambert Cylindrical Equel Area: A cylindrical equal area projection which uses
the equator as the parallel of no distortion.

Behrman Cylindrical Equel Area: A cylindrical equal area projection which uses
30 degrees North as the parallel of no distortion.

Tristan Edwards: A cylindrical equal area projection which uses 37 degrees
38.3 minutes North as the parallel of no distortion.

Peters: De-emphasizes area exaggeration in high latitudes.

Gall Orthographic: A cylindrical equal area projection which uses 45 degrees
North as the parallel of no distortion.

Balthasart Cylindrical projection: An orthographic projection onto a cylinder
secant at the 50 degrees parallels. It is cylindrical equal area, but distortion of
shape increases with distance from the standard parallels. Scale is true along
the standard parallels and constant between two parallels equidistant from the
equator. This projection is not equidistant.

Mercator: Mercator projection. Scale and angles correct only at the equator.
Very distorted at the poles.

Miller: Distances and angles are only correct on the equator. Shapes and areas
are distorted, especially at the poles - but less than with Mercator.

Albers Equal Area Conical: A conical projection which is useful for maps which
are wider than they are high, such as the continental United States.
Stereographic, Polar Stereographic (North and South): A projection which has
minimal distortion at the center of the map. Most useful for maps that are
zoomed to show whole countries.

Tranverse Mercator: A projection which has minimal distortion at the center of
the map. Most useful for maps that are zoomed to show whole countries.

Map Legend

Default unit tites for Map Legends

kKm | km
Mies | miles
Metres | metres

Yards | yards

Feet | feet

Sets the default unit titles for map legends.
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6.6.6 Locations

Figure 11: Maps Locations parameters

Locations for the installed components.
Changing these settings wil require a server restart.

[ ]support Legacy Databaszes (World/Europe/USA)

Waorld Data
Europe Data

U5A Data

Combination
Relief Data

Street Data

Disputed
Regions

CDEM Data

C:\Program Files\Curious Software\Curious W
C:\Program Files\Curious Software\Curious W
C:\Map_extrasiLicensed Street Data

C:\Program Files\Curious Software\Curious W

C:\Program Files\Curious Software\Curious W

Matural
Earth

[ Installed Imagery... ]

Browse...

Browse...

Browse...

Browse...

Browse...

Browse...

m
=0
o
=
L
m

Browse...

The Locations parameters define the path to folders containing relevant data for

the specified parameters.

5| Matural Earth Imagery

Datasets

Microsoft Virtual Earth

Overlays

? 45cm-5endai-Japan-CMR

Path: C:\Wizrt Software'Viz Curious Mapst\JAPAN-CMB 41 Sm-BASE -Mortherm-Japan-CMAY

DigitalGlobe ...ine (Platinum)

DigitalGlobe ... (US Domestic)

Resolution is View Dependent
Licensed OK

Resolution is View Dependent
Licensed OK

Resolution is View Dependent
Licensed OK

27646 % 36536 0.39 Meters/Pixels

[ Show all

j 45cm-Minam..a-Japan-CMR 20748 x 12250 0.40 Meters/Pixels

Edit...

Mo color correction
Reset Impaort

X5

The Natural Earth option can be used to add, remove and color correct global
and/or local CMR (Curious Multi Resolution) imagery. Global imagery is what is
typically used as base maps, whereas local imagery are more detailed imagery of
local places (e.g. coastal areas and cities).

See Also

Open Street Map
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6.6.7 User DEMs

Figure 12: Maps User DEMs parameters
Imported DEM (Digital Elevation Model) Data

Imported Relief Data is stored in a directory as mipmap
files and can be shared amongst users if placed in a
shared directory.

C:\Program Files\Curious Software\Curious World Map:

Max undo disk usage (MB) | 100 3

The User DEMs (Digital Elevation Model) define the path to a folder containing Viz
Curious Maps elevation data.

6.6.8 Attribution

Figure 13: Attribution image placement

Set the position of the on-screen attribution by dragaging
it to the desired position:

[

Cutput Attribution in this font: W

Defines where the attribution should be placed on the screen.

Attribution image (gray rectangle): Sets the location of the attribution image
on screen.

Output Attribution Font: Sets the font used for the on screen credit.
To position the attribution image

Drag the gray rectangle that represents the attribution image area to the
desired position.
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6.6.9 Bing

Figure 14: Bing Maps Platform parameters
Bing Cache

Ise this option to change the location of the Bing cache.

F:\MapData‘\FlanetObserver 15 Browse...
Empty Cache

Bing Connection

l Test Connection I

Bing Maps Platform (previously known as Virtual Earth) is a set of images (satellite
and others) stored on Microsoft’s Bing Maps Platform servers. The images can be
used in Viz Curious Maps, but requires a credit mark (Attribution image) to be
displayed on screen.

Bing Cache: Defines a cache folder for the images retreived from the Bing
Maps Platform server.

Empty Cache: Deletes all files from the cache folder.

Bing Connection: Allows you to test that the Bing Maps Platform server is
online.

Note: Microsoft Bing requires an internet connection and will not work
without a license.

6.6.10 Digital Globe

Figure 15: Digital globe
Digital Globe Cache

IIse this option to change the location of the Digital
Globe cache.

C:\dg Browse...
Empty Cache

Digital Globe Connection

I Test Connection J

Sets the location of the digital globe cache. For reference, see the Bing section.

Note: Digital Globe requires an internet connection and a license. If used
without a license a watermark will appear.
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6.6.11

32

Events

Event Cache
|Ise this option to change the location of the event imagery cache.
C:\Program Files\Curious Software\Curious World Maps'\Ma) | Browse. ..

Empty Cache

Providers

Digital Globe First Look Service | Enabled

Test Connection

First Look Service by Digital Globe ® is an on demand access to fresh imagery
taken hours or days after an event happens. The Viz World Server fetches a
complete list of available event imagery from the service when Viz World Server is
starts. From the Viz World Map Editor’s Images Tab you can search for, buy and
add events images to the map.

Event Cache: Sets the cache location for the event imagery files

Providers: Lists the available event imagery providers. The check box Enabled
allows you to enable and/or disable the selected service. The button Test
Connection allows you to test the connection.

Proxy Settings
The Viz World Server should be allowed to access the following servers:

http:/ /www.digitalglobe.com
https://services.digitalglobe.com
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6.6.12 Display

Figure 16: Maps Display parameters
Alternate Label Display

IIse this option to choose the order in which alternative
place and region names are presented,

Standard el Alternate || |User el Abbreviation e

Street Data
Draw streets with square ends
Square ends for pre-connected data, round otherwise

] Automatically scale map labels - based on the default template size

Alternate Label Display: Sets a custom language and defines the labels’ source
priority, effecting the list of label options displayed to the user. For creating

multi-language files and using them see the Map Name Editor and the Using
the Map Name Editor sections.

Street Data: Defines the visual properties of street edges when drawn on the
maps.

Auto Feature Preview: Defines what features will be previewed in Viz World
Map Editor (WME) when pressing the auto features button.

See Also

Map Name Editor
Using the Map Name Editor
Maps Configuration
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6.6.13  Street Admin

Figure 17: Maps Street Admin parameters

Australia
Belgium
Denmark
Finland
France
Germany
Great Britain
Italy
Luxembaurg
Metherlands
MNorway
Portugal
Russia

Spain
Sweden
USAD7.02.01

] o O O O O O O O O O O O

The Street Admin section is used to display information about the loaded roads
data in the system and road data licensing information.

Re-Scan: When pressed, the configuration tool will check the loaded street data
and refresh the display.

6.6.14 Imported Data

Allows you to add shape files (shapes, lines, names and so on) which later can be
imported to Viz Artist through Viz World Map Editor (WME) and added to your
map.
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6.6.15

6.6.16

Plugins

A.wve | Plugin

Flugin : Yahoo PlaceFinder

Config :
Active

Version

A list of plugins that are used for searching the web (not the Viz World database).

Place Finder
Froject and Style

Project M ame:

Shyler

Map Size
hap width:

Framing

Frame Map By

Degault Map Size [Deqg):

Regionz and Labels

Add Regions:

[] Full Description Labels
[] &dd Search Label

Viz World Server allows receiving maps of locations/features, same as the Place
Finder plugin. This can be used by Escenic or any other web application, or for

-

Map Height:

Search Result

Disabled

demonstrations of Viz World. For more information, see the Place Finder section.
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6.7 Standalone Clients

Figure 18: Standalone Client parameters

Configuration for standalone dients

Export Folder | Ct\Program Files\Curious Software\Curious Wt

A standalone client is an application running WME on machines without a Viz
installation.

Export Folder: Defines the save path for standalone client applications.

Image formats are presented to users when saving images. Add a format for
each combination of file format and compression options you wish to use,

Export Formats | 1pEG - Best (*.jpa)
JPEG - High (*.jpg)
JPEG - Medium (*.jpg)
BMP (*.bmp)

SGI Image (*.50i)
Photoshop (*.psd)
Compuserve GIF (*.gif)
PICT (*.pct)

PNG (*.png)

TGA (*.tga)

QuickTime Image (*.gtif)
Compressed Tiff (*.tf)

Geotiff (*.4f)
Mame:
-
[ ] Georeferenced
[130 Terrain v
Width ::: Height :::
[ Add ] [ Remove

Export Formats: Image formats are presented to users when saving images.
Add a format for each combination of file format and compression options you
wish to use. The Options button allows you to set color (black and white,
grayscale, 256 colors etc.), and filter options.
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6.8 Symbols

Symbols are created and exported from Viz Curious Maps, and can be imported
using the server configuration tool such that client users can add them to their
maps.

See Also
Symbols Tab

6.9 Timeouts

Figure 19: Timeouts parameters
User Timeouts

IIsers are automatically logged off after

10 minutes inactivity (Plugins)

Y
w
e
w

10 minutes inactivity (interactive navigator)

Periodic Restart

The server will only automatically restart when there
are no users connected.

Restart server periodically
{*) After 12 2| hours

(CiatTime 0100 |+ time

This section is used to set server timeout values.

User Timeouts: Sets the timeout values for clients logged onto the server:

- Minutes Inactivety (Plugins): Sets the timeout for client connections when
the WME is opened through the CMWClient plugin. If no map requests are
sent to the server during the period of time (in minutes) specified in this
parameter, the server will disconnect the client.

- Minutes Inactivety (Interactive Navigator): Sets the timeout for client
connections when an interactive Navigator scene is used. If no map requests
are sent to the server during the period of time (in minutes) specified in this
parameter, the server will disconnect the client.

Periodic Restart: Enables automatic restarts of the server. It is mainly targeted

at 24/7 stations, where Viz Engines are up and constantly requesting maps.

The Automatic restart enables the server to restart at the specified time or

after a defined period of time, disconnecting all clients and clearing used

memory. This is imprtant when the server is used heavily and a lot of maps are
generated.
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- Restart server periodically: Sets the server to restart periodically based on
the After or At Time parameters.

- After: Sets the amount of time (hours) for how long the servers should be
running before the server should be automatically restarted.

- At Time: Sets the time for when the server should be restarted.

6.10 Proxy Server

Figure 20: Proxy Server parameters

Proxy Account

MName:

Paszsword:

This section is used to define the proxy server conncetion settings. Viz World
Server will connect to the internet to fetch data from Bing Maps Platform or
Imagery on Demand servers. If the system uses a Proxy Server that requires
authentication, this page is used to provide the login details for the Proxy Server.

Name: Sets the user name.
Password: Sets the user password.

See Also
Bing
Digital Globe

6.11 Server Logging

Figure 21: Server Logging parameters

Server Debugging

|:| Qutput messages in server log

This section defines if the server will log system messages to a log file or not.
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7/ Server Launcher

Figure 22: Viz World Server Launcher

ﬁ Wiz World Server Launcher 12.0 I. = ﬁ]

%]
=)
=]

Viz World’s Server Launcher is a tool used to start, stop and configure the Viz
World Server and Server Allocator. The Server Launcher is by default run as a
service.

The Server Launcher is an application installed as part of the Viz World Server, and
can be found on the programs menu.

When the Server Launcher is configured, the Server Allocator distributes client
requests between the registered servers and server machines, balancing server
loads and the number of client requests. When configured in a complex
environment, multiple map servers with multiple Server Allocators can be used to
allow full redundancy and optimal resource distribution.

Starting a single instance of the maps server can be done from the program menu
or by using the desktop icon.

Starting the Server Allocator, in order to setup a redundant system and/or
configure more than one instance of the map server on one server, is done using
the Server Launcher.

When the Server Launcher is running it will typically be floating on top of the
desktop; however, it can be minimized to tray. The tray icon allows you to
minimize the application to tray and restore it.

Minimize To Tray
Skop Server

Opkions

Exit Launcher

Exit & Shutdown Server

Restore / Minimize To Tray: Restores or minimizes the Server Launcher from
or to tray.

Start / Stop Server: Starts and Stops the Server Allocators and the Viz World
Server without exiting the Server Launcher application.
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Options: Opens the Options window for configuring the number of Viz World
servers and Server Allocators. See Server Launcher Configuration for more
information.

Exit Launcher: Closes the Server Launcher application. Server Allocator and Viz
World server will still be running.

Exit & Shutdown (Not Recommended): Closes the Server Launhcer application.
Stops all Server Allocator services and the Viz World server.

This section contains information on the following topics:
Server Launcher Configuration

Configuration Options

7.1

40

Server Launcher Configuration

Dptions £
~Preferences ——————— Launch Options

Lacal Server Counk |2 "I ™ Service

¥ | Start o swsbenm starkup

v Enable Priority login
&+ Console Application

w
I Run Server Allocator Mote § Wiz World Server will stop if consale is

Machine Counk |F‘ri|:-riI:E Instances |
Machine Ibgnnrangez bgoorangez [z 1 Jal
+
Counk IE j

Priority |1 ~| —‘
Instances I Al Set

—Controlled WS

QI Cancel

Viz World Server is configured using the Server Launcher.

Click the Server Launcher’s Options button in order to configure the map server.
Preferences: Allows the user to set the local server count and enable the Server
Allocator.

- Local Server Count: Defines the number of server instances that will run on
the machine simultaneously. Default value is 1. When setting the number of
instances for each machine, machine hardware should be considered. Every
server instance requires physical memory (RAM) and makes intense use of
the CPU. Do not abuse this parameter, since client and server performance
will be affected.

- Enable Priority Login: Enables Viz World Server to prioritize its inbound
client connections. Viz’ configuration interface will allow you to prioritize
client connections from Viz Artist and On Air Viz Engine’s used for preview
and program output. Viz Engines must be in On Air mode for them to be
prioritized. For Viz World Map Editor you can set it from the Context Menu.
For more information on how to set priorities see the Maps Configuration
section.
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7.1.1

- Run Server Allocator: When disabled (not selected), the Server Allocator will
not run on the machine. When enabled (selected), the Server Allocator will
run and use the parameters defined in the Server Launcher’s Options
window. Default mode is disabled. Server Allocator does not require any
license and can be run on any machine.

IMPORTANT! If the Server Allocator is enabled, even for just 1 machine, a machine

must be defined in the Controlled WoS list.
Launch Options: Allows the user to run Viz World Server and the Server
Launcher as a service, or in console mode. If run as a service, the system can
automatically start all server instances when the machine starts without the
need to login. If run in console mode, all instances must be manually started.

Controlled WoS: When enabled (see Run Server Allocator), the Controlled WoS
settings allows the user to configure the controlled WoS instances.

- Machine: Sets the name of a machine running Viz World Server.

- Count: Sets the number of instances running on the machine. Default is 1.

- Priority: Sets the machine’s priority. If more than one machine is defined,
the priority must be set for each machine.

- Instances: Sets the number of instances that are controlled by the machine.
If the machine has more than one instance running, it is possible to open
the Instance Control (click Set) To set the controlled instances.

Note: When the Server Allocator allocates a server to a client, it will pass this name to
the client, hence, its hostname/ip address must be accessible to all clients.

This section contains information on the following topics:
Setting Priorities
Configuring the Server

Setting Priorities

Normally all servers will use the same priority (1). In more complex scenarios a
lower priority can be used, for example when two servers are running two
instances each and an allocator.

One server is typically dedicated to an On Air engine and another to a Viz Artist
(designer) client such that a designer client will not steal a token from an On Air
engine.

Example setup:
- Map server A is for the On Air engine and it controls two instances on map
server A with priority 1, and two instances on map server B with priority 2.

Map server B is for the Viz Artist designer and it controls two instances on
map server B with priority 1, and two instances on map server A with priority
2.

The Server Allocator will not redirect any clients with map server A as default to
map server B if it can give them an instance on map server A because map server
B has a lower priority. So, only if the instances on A are out of license tokens, or
not responding, the Server Allocator will direct clients to map server B. And the
same for B.
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Another example is in a scenario where there are two allocators (one in Location 1
and another in Location 2), all clients from Location 1 should be connected to the
server in Location 1, and all clients from Location 2 should be connected to the
server in Location 2, and only if any thing goes wrong should clients be allowed to
connect from Location 1 to Location 2.

7.1.2 Configuring the Server
To add or remove instances
Click the + or - buttons in the Options window to add or remove instances.
To set the controlled instances
|
Instance | Controlled |
1 Controlled
2 Mok Contralled
Cancel |
1. Click the Set button in the Server Launcher’s Options window.
2. Double-click the instance to set the control mode to Controlled or Not
Controlled.
3. Click OK.
Note: The number of controlled instances is displayed in the Instances field and
column seen in the Options window.
See Also
Server Launcher Configuration
Configuration Options
7.2 Configuration Options
When using multiple map servers, running multiple map servers on each machine,
with a Server Launcher launched on each of the machines, optimal usage of
system resources can be obtained. The system can be configured with one
allocator for multiple map servers, one allocator on one machine with multiple
servers or multiple allocators with multiple server machines.
This section contains information on the following topics:
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7.2.1

7.2.2

Single Server Allocator Configuration
Multiple Server Allocator Configuration: Classic Redundancy

See Also

Hardware Requirements

Single Server Allocator Configuration

The simple environment setup is when running one map server with multiple map
server instances and a Server Launcher. In this configuration, the Server Allocator
will accept client requests and divert them to the server instances on the same
machine. Client connections will be equally divided between the map server
instances, allowing better response time and load balancing of server processes.

Multiple Server Allocator Configuration: Classic Redundancy

Having multiple servers, where in each there is a Server Allocator running
that controls all WoS instances of all machines.

This configuration guarantees most redundancy as each Server Allocator is
updated with the current status of all WoS servers, and in case of a failure in one
of the machines, other Server Allocators can provide redirection to any available
WoS.

Figure 23: Multiple Server Allocators with Multiple Map Servers.

Server
Allocator

Server
Allocator

¥iz World Server VWiz World Server Wiz World Server Viz World Server

The above diagram describes a system with two machines running a Server
Allocator and two map server instances on each machine. If the client is
configured with both machine names, full redundancy within the system will be
accomplished.

Note: Any configuration combination between the Server Allocators and the map
server instances is valid.

Chapter 7: Server Launcher 43



8

Open Street Map

The Open Street Map (OSM) Downloader is a tool for downloading street maps
from the Open Street Map initiative.

The street maps are prepared by Vizrt and can be downloaded from the Vizrt FTP
at download.vizrt.com. In order to get access you need to sign up for an account.
Please contact your local Vizrt representative for more information or contact
support (support@vizrt.com).

This section contains information on the following topics:
OSM Downloader Interface

Working with the OSM Downloader

8.1

44

OSM Downloader Interface

Figure 24: Open Street Map Downloader
IW OSM Downloader 1.0.0.0 =B |

Vizrt FTP Credentials

Username usermname Password sessssssssss Remember me  Connect Rescan

® > el b TelAviv

DOWNLOAD QUEUE
Motorway Major Roads Minor Roads Natural

Israel\Tel Aviv ( 267.6 KE

Downloaded

Destination Folder | C:\Temp\OSM

Download

Username and Password: Your Vizrt FTP username and password

RememberMe: Allows the tool to remember your username and password for
the next OSM download session

Connect: Allows you to connect to the Vizrt FTP and the Viz World Server

Breadcrumbs: Allows you to select the street data you want to add to your
download list. The selected data will appear as a breadcrumb

+: By selecting which street map you want from the drop-list you simply click
the + button to add the item to your download list

Rescan: Allows the Viz World Server to update the street data after the OSM
data has been downloaded
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Download queue: Lists all OSM items ready for download and allows you to
select the type of street data (i.e. Motorways, Major Roads, Minor Roads,
Natural, Places, and POI). You can also check/uncheck each download item. If
you want to delete items from the queue you simply select an item and press
the Delete button or click the right mouse button.

Destination folder: Defines where you want to keep the downloaded data on
local disk. Note that the Viz World server expects the files to be in the default
folder (see how To configure the OSM downloader).

Total queue progress: The progress in percents of all items to download
Download: Start downloading from ftp to local folder.

See Also
Working with the OSM Downloader

8.2

Working with the OSM Downloader

To install the OSM downloader

The Open Street Map downloader must be installed alongside the Viz World
Server. This is done by installing Viz World Client components on the server.

Run the Viz World Client installer

Select Custom

Select the Viz World Server Config component
Click Next

Click Finish

uvT D W N —

To configure the OSM downloader

Before the open street maps can be downloaded and used by your designers you
need to configure the Street Data location.

Tip: Both tools can be started from the following location: ¢:\Program
Files\vizrt\Common\Maps

1. Run the Viz World Server Configuration tool

2. Connect to your map server

3. Select the Maps —-> Locations section to configure the Street Data location
4. Run the Open Street Map downloader tool

5. Set the Destination folder to match the Street Data location

To download open street maps

Before you start to download open street maps you need to have a Vizrt FTP
account, and the software installed and configured.

1. Run the Open Street Map downloader tool
2. Make sure you have a connection to your map server
3. Enter your Vizrt FTP account credentials and click Connect
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® > United States of America P New Hampshire Cheshire County

Belknap County

Camroll County
Motorway Major Roads Cheshire County
Coos County
Grafton County
Hillsborough County

Mermimack County

United States of America\New Hampshire\Belkna

Rockingham County
Strafford County

Sullivan County

United States of America\New Hampshire\Carroll

United States of America\New Hampshire\Cheshire County

4. Browse and select data
5. Click + (plus) to add data to your download queue
6. When done, click Download

See Also

- OSM Downloader Interface
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9 Viz Artist Configuration

This chapter contains information on how to configure the render engine. The
following sections provide informaiton on how to configure cache directories, the
Viz World initialization file and a general description of Viz Artist’s configuration

section:

Maps Configuration
Cache Configuration

Cache Location

Defining the Cache
Cache Folder Structure
Control Applications and Caching

Maps Configuration

Map Server

Active

Server

Project

Available

Map Size

Cache Directory

Memory (Images)

localhost

MGF¥ Bing Map Template/MGFX BING Map Template
ARTE_PLATEALU.tpl
BMN9_street.tpl

watn  IEERS{R| veione INEEERER1R
C:\NAB
ilﬂ On disk (Days)

= o

2nd Cache Directory
Priority

Languages

Wiz World Version 12.0 And Above

Citemp\MapsCache

English

Attributions
Attribution Font
Bold

COn Top

Verdana

an Italic an
On On Right On

Map Server: Enables or disables Viz World Server (WoS) connection for Viz
World Client (WoC).

Server: Sets the Viz World Server host.
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Project: Sets the default map project that will be opened with the client
application.

Available: Lists all available Viz World Server projects.

Map size: Sets the default map size that will be used with the client
application.

Cache: Enables caching of maps for faster preview and fetching of maps.
Especially useful for journalists and operators using Newsroom Component
and Viz Trio respectively.

Cache Directory: Sets the cache directory for cached maps which can be a local
drive, mapped drive or a Universal Naming Convention (UNC) path.

IMPORTANT! Make sure the Cache Directory folder is configured with read and write
access rights.

Memory (Images): Sets the number of images to keep in memory.
On disk (Days): Sets the number of days to save images on disk.

2nd Cache Directory: Enables a second cache (see Cache above). The main
purpose of the second cache is to enable redundancy in those cases where a
main cache directory is on a different computer and for some reason fails.
Another use case is to use it as a local cache to save loading time (e.qg. if you
load all borders for the entire world you would have T00MB+ of cached files).
In order to shorten load time you can copy large static files to the correct local
cache folder. In the 3D Map Setting plugin you will also find a Sync Local Cache
Folderbutton which will copy all the needed files to your local cache. Note that
the second cache directory settings can only be used by Viz World version
12.0 and later.

Priority: Sets the machine’s connection priority to the Viz World Server (Wos).
Setting a number, where 1 is the lowest and 100 is the highest you may
override connection priorities set by other machines. The configuration
interface will allow you to prioritize client connections from Viz Artist and On
Air Viz Engine’s used for preview and program output. Viz Engines must be in
On Air mode for them to be prioritized. For Viz World Map Editor you can set it
from the Context Menu. To enable this behavior on the server side you need to
enable WoS to prioritize its connections/logins. For more information, see the
Server Launcher Configuration section. If the configuration option is not
visible, please read how To add the VizWorld.ini file and set the priority.

Network Monitor: Enables you to monitor relevant network connections (server
and cache folders). If you do not monitor the network and you try to connect
over a “disconnected network”, connecting to a server or a UNC path, it will
take time before the system reports back (e.g. 30 seconds or more). Enabling
network monitoring will avoid such connection issues. Note that the network
monitor will only monitor a cache folder that use a UNC path (not mounted/
mapped drives). If the configuration option is not visible, please read how To
add the VizWorld.ini file.

Languages: Sets the current language to be used on labels fetched from Viz

World Server. For more information, see the Display section.

Attributions: Adds an attribution to the map. Alternatives are; Static and

Dynamic.

- Dynamic: Displays the attribution when a licensed imagery is in view and
disappears when the image is out of view.

- Static: Displays the attribution as long as there is a licensed imagery in the
scene.

Attribution Font: Sets the font for the attribution.
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Bold: Sets the attribution font to bold.
Italic: Sets the attribution font to /talic.

On Top: Places the attribution image to the top in the screen. Default is
bottom.
On Right: Places the attribution image to the right in the screen. Default is left.

To add the VizWorld.ini file

1. Create a and save a VizWorld.ini file to the following location:
C:\Program Files (x86)\vizrt\Viz3\plugin\data\maps

2. Open the file and enter the following:
Monitor=1
Priority=1
Language= [my Language ID]

3. Save the file and start e.g. Viz Config to see the configurable parameters

Monitor enables network monitoring. For more informaiton see the Network
Monitor setting under the Maps Configuration section.

Priority sets Viz’ connection priority to the Viz World Server. For more
information see the Priority setting under the Maps Configuration section and the
Server Launcher Configuration section on how to enable prioritized connections
on the server side.

my Language ID refers to the order of languages in your list of languages (e.g.
English = 0, Arabic = 1, Hebrew = 2 and so on). For more information see the
Languages setting under the Maps Configuration section.

9.2

Cache Configuration

When working with Viz World in a server/client environment, a cache is used to
reduce load time of scenes in Viz. The cache is a shared network storage folder,
common to all Viz Engines in the system. The cache is managed by the Viz Engine
machines.

Note: In complex environments, Viz Engine machines can be grouped so a different

cache is defined to each group.

Map data flow

The maps data stored in the cache is produced by the Viz Engine machines,
running Viz World Client applications. When WoC is launched, it connects to the
server and enables the user to select a map and add information to the map.
When the user accepts the selected map (by pressing the OK button in the maps
editor (WME)), the map information will be sent to the scene (and to the relevant
WoC plugins used in the scene) from the server. WoC plugins will load the
recieved data and then store it in the cache. Now, when a scene is initialized, the
WoC plugins will look for the data in the cache and load it, without connecting to
the server.
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Since the most time-consuming task in this process is generating the maps, using
the cache reduces that time to a minimum and the maps are generated only once.

Note: Before setting a cache folder in a server/client environment, a shared network
drive, mapped on all Viz Engine client machines should be created. The cache folder
is defined on the shared drive, so all machines will have access to the cache.

See Also

Cache Location

Defining the Cache

Cache Folder Structure

To configure the cache directory

9.3 Cache Location
The following are some simple guidelines that will ensure caching is optimized
when using one or several Viz Engines.
One: Set the cache location local to that renderer.
Two or more: Set the cache location to the map server (or other shared
network drive) so that one renderer is not favored over others.
9.4 Defining the Cache
The client cache is defined using Viz Engine’s configuration tool (Viz Config).
When configuring the cache environment make sure that the following parameters
are identical on all Viz machines:
Cache Directory
On Disk (Days)
Tip: Control clients should have their cache location(s) set to the same location as
defined by the Viz Engine(s).
This section contains information on the following topics:
To configure the cache directory
To configure the 2nd cache directory
To configure Viz Engine
To configure the cache directory
Cache Directory c:ftemp
vemory (images)  [NEERER onosk 02 ECEEZNR
1. Start Viz Config or open the configuration interface by clicking the Config
button on the main menu in Viz Artist
2. Select the Maps section
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3. Set the Cache Directory to the defined shared network drive and the folder
used as the cache’s main folder

Note: The Cache Directory has to be identical on all Viz Engines that share the cache.

UNC paths are also supported.

4. Set the Memory (Images) to the required value (default is 32). This parameter
defines the maximum number of map images stored in Viz memory when
initializing a playlist

IMPORTANT! Set the number of images to zero (or a low value) on control machines

used in the system. The control machines are inferior to Viz Engine machines and it

makes no sense to load a large number of images when it is only used for preview.

5. Set the On Disk (days) parameter to the maximum number of days that the
images will be stored in the cache. When Viz is launched, it will clean the
cached map images that are older than the value defined in the On Disk (days)
parameter

6. Click Save

To configure the 2nd cache directory

2nd Cache Directory

Priority “i‘ﬂ MNetwork Monitor Active

1. Start Viz Config or open the configuration interface by clicking the Config
button on the main menu in Viz Artist

2. Select the Maps section

3. Set the 2nd Cache Directory to your local computer or a defined shared
network drive and the folder used as the cache’s main folder

4. Optional Enable network monitoring
5. Click Save

N

See Also

Maps Configuration

9.5 Cache Folder Structure

When using cache in a client/server configuration, WoC plugins will manage the
cache and sort generated data in several folders under the cache folder. The
cache folder hierarchy is created automatically. Only the cache root directory is
configured in Viz. The defined cache folder for all clients is the root cache folder.
Under the root cache folder, a version sub folder is created using the WoC plugins
version. Under each version folder, several sub folders are created, according to
the requested data:

3DLine-Cache: Stores lines from the WME as OpenGL vertices.

3DBorder-Plugin-Cache: Stores selected borders based on the Region-Cache
data.
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3DRegion-Plugin-Cache: Stores selected regions based on the Region-Cache
data.

AtlasCacheFolder: Stores Downloaded images from Microsoft to enable a
smooth animation and faster response time during navigation. Images are
stored under sub-folders according to the texture compression used.
BorderManagerFullWorld—-Cache: Stores unselected borders based on the
Region-Cache data.

CWMClient-Cache: Stores map images and label information that is reused by
Viz when loading the scene.

Region-Cache: Stores region vector data.

Street-Cache: Stores street vector data.

StreetManager-Cache: Stores unselected streets based on the Street-Cache
data.

Note: The 3DBorder, 3Dregion and BorderManagerFullWorld cache is based on
Region-Cache data after a projection is set, and converted to an OpenGL format.

Example: The country Norway will only have one cache file under Region-Cache
(since there is only one Norway), but could have many under other folders with
different projections.

General Caching Rules

The CWMClient-Cache folder is cleaned when Viz is launched (any of the Viz
Engines using the cache), according to the On Disk parameter value.

The data in the cache folders (except for the CWMClient cache) are not deleted
when cleaning the cache since it does not change and it can be reused all the
time.

See Also

To configure the cache directory

9.6

9.6.1
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Control Applications and Caching

This section describes commands/actions and setups that will result in maps data
being cached when using the Viz Trio and Viz Content Pilot control applications.

This section contains information on the following topics:
Viz Trio
Viz Content Pilot

Viz Trio

This section describes Viz Trio specific commands/actions that influence how
map data is cached when Loading pages, Initializing all pages and performing a
Direct Take.
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IMPORTANT! Set the same cache directory for the local Viz, and program and
preview channels.

This section contains information on the following topics:
Loading pages
Initializing all pages
Direct Take

Loading pages

Opening a scene for preview generates all cache files needed for the scene in the
file cache. Any change to the page through Viz Trio (CWM location, hop locations,
labels, selected regions and so on), immediately generates all required cache files.
When pressing 7ake, Viz Engine will load to memory all needed map cacheable
elements through the file cache that the preview machine just generated without
the need to connect to the map server.

Initializing all pages

The Initialize All button/command will load all scenes to memory (program &
preview renderers). All necessary map data will be loaded from the cache files.

Note: It is assumed that each page has been loaded in preview once before, and that
cache files have been created.

Direct Take

The Direct Take button/command will immediately load the scene into Viz Engine.
All necessary map data will be loaded from the cache files that the preview has
generated once.

Note: It is assumed that each page has been loaded in preview once before, and that
cache files have been created.

See Also

To configure the cache directory
Viz Content Pilot

Viz Content Pilot

When running Viz Content Pilot in a non-preview configuration, any change to any
map element that requires caching will not create cache files. This will result in
longer loading time of the Viz Engine because data maps, labels and polygon data
has to be requested from the map server. It is important to request at least a
single image preview, such that cache files will be created.
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IMPORTANT! If you are running a local Viz, set the same cache directory for the local
Viz as for the program and preview channels.

See Also

To configure the cache directory
Viz Trio
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10 Viz World Client

This section describes the procedures on Installing the Client and Configuring Viz
Engine.

Viz World Client (WoC) is used to integrate maps and geographical data into
scenes. Its components are the Viz World Map Editor and design plugins.

This section contains information on the following topics:
Installing the Client

Configuring Viz Engine
Software Requirements

10.1

Installing the Client

Viz World Client (WoC) installs new components in two places:
Viz 2.X (c:\Program Files\vizrt\viz\) or

Viz 3.X (c:\Program Files\vizrt\viz3\), and
Common files (c:\Program Files\vizrt\common\))

There are two ways of installing the client; a standard installation which requires
the user to perform and confirm all actions during the intallation, or a silent
installation that enables the user to install Viz World Client without using the
installer’s dialog boxes.

A silent installation can be performed in two ways; a standard silent mode
installation is performed by setting the /s flag before running the installer. The
more advanced silent installation enables the user to perform a custom
installation, by creating an InstallShield Silent Response (ISS) file, should a Typical
installation not fit the requirements.

This section contains information on the following topics:
- To install the client

To install the server configuration tool

To install the client in silent mode

To record a silent mode installation

To install the client in silent mode using an ISS file
To remove the client

To install the client

1. Double-click the VizWorldClient_12.x.x.x.exe installer to start the installation.
2. In the Setup Type window, select Typical, and click Next

- Select Custom To install the server configuration tool.
3. Select the Yes, | want to restart my computer now option and click Finish.

To install the server configuration tool

1. Double-click the VizWorldClient_12.x.x.x.exe installer to start the installation.
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2. In the Setup Type window, select Custom, and click Next.

3. In the Select Features window, select the Viz World Server Config option, and
click Next.

4. Select the Yes, | want to restart my computer how option and click Finish.

To install the client in silent mode

1. Create a shortcut of the client installer’s executable file.

2. Right-click the new shortcut and select Properties from the appearing context
menu.

3. Select the Shortcut tab, and in the Target path add the following flag:

/s

1. Click the OK button to confirm the change.
2. Run the shortcut to install the client in silent mode.

Note: The default installation for new installers (first time) includes the client and the
Standalone Clients. An upgrade will update the existing installation.

IMPORTANT! Any unexpected events during silent installation will result in a failure.
Unexpected events can be: Need to restart the computer and Viz not installed in
default path.
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To record a silent mode installation

Figure 25: Setting the Target path, Silent installation

B8 VizWorldClient_12.0.0.7995.exe - Shortcut Properties (IR

Securty | Details I Previous Versions
General | Shortcut | Compatibility

E VizWordClient _12.0.0.7535 exe - Shortcut

Target type: Application

Target location: Cliert

Target: iCliert_12.0.0.7955.exe" /r A1"C-\tempwoc iss'|

Start in: "CaMiznt SoftwareWiz Word Server and Cliert™(Cli

Shortcut key:  Mone

Run: [ Mormal window - ]

Comment:

Open File Location ] [ Change lcon... ] [ Advanced... ]

Note: One manual run of the installer is required to record user actions. After the
sequence of user actions is recorded, the installer can run in silent mode, repeating
the recorded user actions.

1. Create a shortcut of the client installer’s executable file.
2. Right-click the new shortcut and select Properties from the appearing context
menu.

3. Select the Shortcut tab, and in the Target path add the following flags and file
name with the suffix .iss.:

/r /f1"My File Name.iss”
Note: The file path should be a full or a relative path and must be double quoted. If a
file and/or a file path is not specified it will be named setup.iss and saved to the
WINDOWS folder.
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Note: There should be a space between the /r flag and the /f1 flag, but there is no
space between the/f1 flag and the specified file name.

4. Click the OK button to confirm the change.

5. Run the shortcut manually To install the client. Make the selections to create
the desired silent installtion.

6. After completing the installation, check that the specified .iss file was created.

Note: The procedure described above, using an application shortcut, can be
executed from a command shell running the installtion file with the described flags.

To install the client in silent mode using an ISS file

1. Create a new shortcut of the client installer’s executable file.

2. Right-click the new shortcut and select Properties from the appearing context
menu.

3. Select the Shortcut tab, and in the Target path add the following flags and the
pre-recorded file name with the suffix .iss.:

/s /f1"My File Name.iss”

Note: There should be a space between the /s and the /f1 flag, but no space
between the /f1 flag and the specified file name.

4. Click the OK button to confirm the change.
5. Run the shortcut to install the client in silent mode.

Note: The procedure described above, using an application shortcut, can be
executed from a command shell running the installtion file with the described flags.

To remove the client

1. Start Add or Remove Programs and click the Change/Remove button next to
the Vizrt Viz World Client item to start the client installer, or

2. Run the installer

3. Select the Remove Installed Files option and click Next
4. Click Finish
See Also

Configuring Viz Engine
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10.2  Configuring Viz Engine

For the Viz World Client to be able to connect to Viz World Server, a Viz Engine
must be present. Viz Engine has its own configuration tool (Viz Config) that is
used to configure the connection to the Viz World Server.

Before proceeding with the procedures, make sure that the following is installed:
A license file (*.lic)
A USB hardware dongle
Provided that project templates are available, the Viz Config window, after a
successful configuration, will look something like the picture above. It is
recommended to set a default project; however, this is not required. Project
templates are made in Viz Curious Maps by designers, offering different sets of
maps, label styles and so on.

To configure Viz Engine

Map Server Active

Server bgooranged

Project VizDvefProject.tpl

VizDetProject.tpl

VizDefProject' .tpl
Available VizDremol_CYL.tpl

VizDremol_MRC.tpl

WeatherMemao.tnl

Map Size Width ilﬂ Height ilﬂ
Cache Directory ciftemp

Memory (Images) “ilﬂ On disk (Days) ilﬂ

iz World Wersion 11.1 And Above

2nd Cache Directory

Priarity “ilﬂ MNetwork Monitor Active

Virtual Earth Attribution Crynamic Static
Attribution Font

Bold [on
Italic ﬁ
On Top E
On Right _Off |

1. Start Viz Config

2. Select the Maps section, and click the Active button to activate the
configuration window and connection.
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Enter the Server name of the map server (hostname or IP address).

- In a Server Allocator setup, with multiple servers and/or full redundancy,
add the map server names only separated by commacs).

. Click Save and restart Viz Config.
. Select the Maps section again, and select a Project template from the Available

project template list.

- This becomes the default map setting when using Viz World Client. It is
possible, in Viz World Client, to select alternative project templates.

. Set the Default Width & Height which will set the default image size for the

maps.
- The image size can be changed by the CWMClient plugin in Viz Artist.

. Save and close Viz Config.

See Also

Installing the Client
Cache Configuration
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11 Viz World Map Editor

Viz World Map Editor (WME) is a core component of the Viz World Client (WoC)
installation. WME can be integrated with numerous Vizrt products that enables
users to select, frame and populate maps and use them in Viz. The WME connects
to the Viz World Server (WoS) and retrieves the map to be used.

This section contains information on the following topics:
Map Editor

Using the Map Editor
Map Name Editor
Using the Map Name Editor

11.1 Map Editor

Figure 26: Main window

The WME window includes the map area, navigation and map editing area, map
details area and the map tool bar. The user can select (zoom and pan) a region on
the map, or use the search tool to find the requested location. The user can add
information to be displayed over the map by selecting objects from the database
or by manually marking a place on the map. The added objects are displayed in
the Map Details area.

This section contains information on the following topics:
Map Area

Navigation and Map Editing Area
Search Tab
Explorer Tab
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Extra Data Tab
Images Tab
Symbols Tab
Map Tool Bar
Map Details Area

Map Area

The map area displays the current map and enables the user to modify the map
interactively, according to the selected tool in the buttons toolbar and by using
the integrated Zoom Options.

Context Menu

Guides Screen Safe

Languages Title Safe

Server Priority Logo

Background

Guides: Allows you to display default guides (e.g. safe and title area) or
custom guides and/or images (e.g. logo and background). For more
information, see how To add custom guides.

Languages: Defines the language setting for labels. See the Server
Configuration tool’s Display section and how To create a new language file.

Server Priority: Sets the connection priority given by the Viz World Server. See
the Server Launcher Configuration section and the Enable Priority Login
option. If you are working on scene design using Viz Artist, Viz Artist also
needs to be configured (separately). See Viz Artist’s Maps Configuration
section.

To add custom guides

With custom guides you have three options; two for placing an image as a
background or logo and one for placing guides such as title and safe area boxes.

1.

On the Viz World Server machine locate and open the CustomGuides.txt file

under C:\Program Files (x86)\Curious Software\Curious World

Maps\Settings

Enter the following to show an image (e.g. logo) on top of the map:

- Syntax: Type "Title" Ratio Width(%) Height (%) "Filename" Image
X (%) Image Y (%) Opacity (%)

- Example: Image "Logo" 1.333 80 80 "C:\logo.png" 0 0 75

- This will add an image on top of the map, the image will be applied with
75% opacity (alpha is supported).

Enter the following to show a background image on top of the map:
- Example: Image "Background" -1 90 90 "C:\background.png" 5 5 25
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- This will strech background.png to fit the current aspect ratio (-1) with 5%
on each side as margin at 25% opacity.

4. Enter the following to add a custom guide to the map:
- Syntax: "Title" Ratio Width (%) Height (%)
- Example: "4:3 Title Safe" 1.333 80 80

- Valid width and height values have to be between 50 and 100. Set ratio
(width divided by height), or -1 for current aspect ratio. You can define up
to 5 custom guides.

Zoom Options

In the upper left corner of the Map Area there are two rectangular blue shaped
buttons that can be used to zoom in and out of the map. In addition it is also
possible to use the mouse (left button) and/or in combination with the keyboard.

The zoom options, besides menus and buttons, are:
- Drag and draw a rectangle to zoom in to fit.

Click the left mouse button to zoom in.

Hold down SHIFT to zoom out.

Hold down CTRL to zoom in in smaller steps.

Hold down CTRL and ALT to zoom out in smaller steps.

Navigation and Map Editing Area

The navigation area enables the user to locate places by searching the database or
selecting a place from the explorer list. When a place is found (or selected) the
user can fit the map to the requested area, add information to the map, highlight
the region and modify the map using the Viz Curious Maps database.

Using the Results

After conducting a search or using the explorer, the results will be displayed as a
list. When an entry is selected, the buttons on the right side of the list will become
enabled:

>

Add to map: Adds the selected entry to the map. The selected entry will be
added to the map graphically as defined in the selected map style. A map style
defines map symbols, fonts, icons, colors, and so on. For map styles see also
Map Tool Bar and the Map Style drop-down menu.

B

Center map: Pans the map to center the selected entry (keeping the current
map scale size).

-~

Fit to fill: Centers the map and scales the map to fill the map area.
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11.1.3

@

Show details: Opens the browsing tool, which displays the context information
for the selected detail. The context information includes the regions

containing the detail (that is country, state and county) and the capital of that
country.

Search Tab

Figure 27: Search result, Turkey

Search | Explorer | Extra Data || Images | Symbols
Find @&l O visible
Search: Parig Tx
Crosz 5t

Type: | &l - 5 Durce:m
Al
internal

tap DB
T | Mame

Extra D ata
&%, Paris, Lamar County

:’,‘; Paris, TX United...ates, Larnar County

The search tab is used for searching the database for a place, using a string or

sub string typed in the name text box. The search results can be filtered by using
the radio buttons and the drop down list.

Searching is instant (after the first three characters) and optimized according to
relevance; hence, if you search for Paris your result will show all places named
Paris, but if you search Paris TX you will get Paris in Texas, USA.

Search | Explorer | Extra Data || Images | Spmbols
Find: @A (O Visible
Search: broadway AMD 44
Cross Sk

Type: | all = 5 Durce:l Al -

T |Mame |
<1> Broadway & W 44...ew york new york

- 21
|l]| Broadway, new york new york
|H?| W ddth St, new york new york [ﬁ

If you have street data (see Extra Data Tab) you can also search for crossroads
using AND or & (e.g. Broadway AND 44th).
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Search Parameters

Find All: When selected it displays all matching entries in the database.

Find Visible: When selected it only displays matching entries visible in the
current map.

Addr and Cross st.: Enables the user to search for specific addresses.

Type: Limits the result list according to the selected Type. For example region,
capitals, tourist attraction, and so on.

Source: Searches a range of sources.
- All: Searches all sources.
- Internal: Searces the map database and extra data.

- Map DB: Searches the built-in database that comes with the Viz Curious
Maps installation.

- Extra Data: Searches all extra data packages bought in addition to the
standard Viz Curious Maps installation (see Map DB).

- Web: Searches Yahoo for online point data.
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Explorer Tab

Figure 28: Explorer result of British Columbia

Search | Explorer | Ewtra Data | Images | Symbols

[]wizible -
- Canada - ‘
Alberta | P
British Columbia =l [
Manitoba Lo
Mew Brunswick
Mewfoundland and Labrador =
Morthwest Territories
Mova Scotia =
[Towns> 100k |+ | <Fiten>
Type | Mame
a?; Abbotsford, British Columbia
a’]',; Burnaby, British Columbia
a?\j Coquitlam, British Columbia
E Kelowna, British Columbia
a?; Langley, British Columbia
a’]',; Marth Vancouver, British Columbia
a?\j Richmond, British Columbia
E Saanich, British Columbia
a?; Surrey, British Colurnbia
';] Vancouver, Britich Columbia
a?\j Victoria, British Columbia

The explorer tab is used for selecting a location from a list of places derived from
the server’s database. The list is displayed in a tree format showing countries,

regions,

cities, and so on.

Explorer Parameters (list filter)

Visible: Only displays location entries visible in the current map.

Type: Limits the search result list to the selected type like region, capitals,
tourist attraction, and so on, when one of the entries in the list of available
types are selected.

Filter: Filters the search result further.

Note: To find New York, type N, then type E, etc. with every character typed in the
string filter the list will be smaller.
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Extra Data Tab

Figure 29: Extra Data tab, Points of Interest

Searchl Explorer  Extra Data | Imagesl S_I,Iml:u:ulsl

[~ wisible [rnipart KAML... | Data... |

- Telemnark,, Mo
- Teramo, &bruzzo, [t
- Tromsz, Mo
-est-Agder, Mo
- Westfold, Mo
- Wibo Valentia, Calabria, It
- kML Files
o tdf2008 kol

(]

[ Wisible <Filters

Alversund
Alvgen
Askgy
Austevall
Austmarka
Austrheim
Bekkjarvik

OO0

i

Bildgyna
Bj@rgurn
Blomsterdalen
Bratthalmen
Bamlo
Bammelhavn
Dale
Dirnrmelswvik
Eidfjord
Eidsvéag

Eikelandsosen

SO0

.ﬁ.ddressl Intersectinnsl Back |

|Name‘l’ IA 4;3

)

N

The Extra Data tab is used for selecting a street from the streets database on the

server, and Keyhole Markup Language (KML) files.

Note: Streets data requires additional license features and the installation of street

data on the server.

This section contains information on the following topics:
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Streets
Import KML

Streets

Searchl Explorer  Extra Data | Imagesl S_I,Iml:u:ulsl

[ “izible Import ERL... | Data... |
—- Hardaland, Mo &] ':B:'&
= Streets |
b obonwaays ﬂ
Prirary Foads ]
Main Roads P |
Other Roads '
4 Land Uze b
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[ Wisible Ifurulien

Type MName ¥ | #3

.ﬁ.ddressl Intersectinnsl Back |

Streets data is available from the Streets node, and are sorted by Motorways,
Primary Roads, Main Roads and Other Roads. Use the Filter search to search for
streets.

Import KML
Search I Explorer  Extra Data | Imad —] KML File X
I wisible Import BME 11 (ME Tour de France 2008 @
+- Telemark, Mo Stage 1 start
+- Terama, Abruzzo, [t Stage 1
+- Troms, Mo Stage 1 finizh
+- Vest-Agder, Mo Stage 2 start
+- Westfold, Mo Stage 2
+- Wibo Valentia, Calabria, It Stage 2 finish
- KML;?;UB - Stage 3 start
t km
Stage 3
[l N I HEFY P M

[~ Wisible |<Fi|ter> ‘%3|

Type | MName ¥

Keyhole Markup Language (KML) files can be imported and added to the map. The
KML data will be accessible from the Extra Data tab as with street data. By clicking
the KML Files node, all the imported KML files will appear as sub nodes. Click one
of the imported KML files to open the KML file windowthe respective file will be
file.
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KML files currently must be manually imported into the server. Files are placed in
the KML folder under the Curious Software folder.

11.1.6 Images Tab
| Search | Explorer | Bxtra Data | Images | Symbols

<Filter =
¥ Last 7 Days i
L

deR W

¥ Last 31 Days

Explusiun in Brazzaville, Congo
EUS Midsection Tornadoes

: : Flood and Ocean Storm in Madagascar

-Floud in El Tarf, Algeria
—_—

-Fluud in Peru
—_

PCydune Giovanna
=7

¥ Older

-Flund in Mozambigue
— ey

;j Fhilippines Earthquake

ﬂﬂne—"r‘ear Anniversa... in Cairo, Egypt

The image tab allows you to search for and buy Digital Globe First Look event
imagery. You can also browse and evaluate first look imagery (with watermark);
however, only users who are licensed for Digital Globe First Look can purchase the
images with valid credentials.

First Look Service by Digital Globe ® is an on demand access to fresh imagery
taken hours or days after an event happens. The Viz World Server fetches a
complete list of available event imagery from the service when Viz World Server is
starts. Clicking the Force Refresh button will update this list.

Events are organized by time, where latest events are on top.
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- Add the selected image to the map: Adds an event imagery to the map

- Center the map on the selected image: Centers the view of the map to the
location of the event imagery

- Fit the map to the selected image: Fits the map view to the event imagery

Image Purchase =]
ORDER. COMFIRMATION

This service is available only for Digital Globe online users.

The FirstLook Image you have selected is available for the price
and duration indicated at the information page ("WIEW™ button),
and access to and use of the selected image is subject to the terms
of the End User License Agreement (EUILA) set out at such page.

Clicking on the following "I AGREE"™ button, and entering your user
name and password indicates (i) you have read the End User
License Agreement, (i) your agreement to pay the guoted price,
(iii) your acceptance of the specified time limit regarding permitted
use of the image, and {iv) your acceptance of the terms of use set
outin the ELLA.

Pricing and End User License Agreement Pricing I I Terms
Username:
Password:

IAGREE | | Cancel

- Purchase selected image and add it to the map: Opens an Image Purchase
dialog box that allows you to read the Pricing and Terms (EULA) for the
images. In order to purchase an event imagery, you have to be licensed for the
Digital Globe First Look service, and have valid credentials that are supplied
with the license file. The purchased image will be added to your map.

Event Info B
Points of intrests:
Title: Heavy Floods in Ecuador —
Date: 2012-03-09 20:35:00 UTC Babahoyo
Categories: Matural Disaster Balac
Machala

Description: A state of emergency was dedared Thursday for five
Ecuadorian provinces where floods triggered by winter
rains have left 20 people dead and 2,523 displaced.

el ol fed

- Event detailed information: Opens a dialog box showing a full description of
the event. From this dialog box you can also add the points of interest to your
map in addition to the add, center, fit and purchase operations already
available under the Image tab.

See Also

- Events server configuration
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11.1.7 Symbols Tab

Symbols are added using Viz Curious Maps, and can be imported using the Server
Configuration tool or Viz Curious Maps.

To add symbols

Start Viz Curious Maps, preferably on the maps server.
Create or open a map project.
From the Tools menu, select Symbols.

In the Symbols dialog box, click the + symbol (bottom) to search and select
for a symbol.

5. Close Viz Curious Maps.
6. Restart the Viz World Server to load the new images.

AW N =

11.1.8 Map Tool Bar

Figure 30: Map tool bar

|NaturaIEarth ﬂ |TheWU[|d j Region Pick Browse Move  Add Add Edit
Zoom Zoom Pan Feature Map Label Label |Streets Shape  Shape

B 9] e | o @ .3« 8

The map tool bar includes a row of buttons controlling the map interactive mode.
The map area enables an interactive map selection and manipulation and the map
tool bar is used for selecting the map interactive behavior.

This section contains information on the following topics:
- Map Tool Options

To create a map using the Quick Map location browser
To set the map location

To pick a label and add it to the map

To move a label

Map Tool Options

| Matural E arth j

Available Map Stylesheet: Displays a list of available map styles of the selected
template. Select a map style to apply the style’s design to the displayed map.

| The world |

View Presets: Displays a set of view presets. Available options are: The World,
United States, N America, S America, Americas, Africa, Asia, Middle East, S
Asia, Europe and United Kingdom.

=

Open New Template: Loads one of the defined templates installed on the
server creating a blank map with the template’s styles and settings. When
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pressing this button a confirmation window will open. When confirmed, the
template window will open. Select one of the projects in the list and click OK.
A new map will appear in the map area using the new template’s default styles
and settings.

9

Undo button: Cancels the last change on the map.

&

Redo button: Cancels the last canceled change on the map.

Quick Map
Set Location

Bird’s Eye: Displays the available imagery Bird’s Eye imagery from the Bing
Maps Platform. When clicking the button, the imagery for the area of the
current map will be displayed enabling the user to select an image for the
map.

Quick Map: Opens the Quick Map location browser that enables the user To
create a map using the Quick Map location browser.

Set Location: Opens the Set Location dialog which enables the user To set the
map location using longitude, latitude and map size values (radius around the
defined point).

il

Region Zoom: Enables the user to click and drag the mouse on the map to

create a rectangle surrounding an area on the map (rubber band).

- The rectangle displays two icons; a cancel icon in the upper right corner and
accept icon in the lower left.

- The rectangle keeps the aspect ratio set for the map unlike regular zoom
(see below).

- Region zoom can be adjusted before accepting the area selection.

&

Zoom: Zooms into the map on every click on a point in the map centering the
clicked point in the Map Area. Another option is to drag and create a selection
area. When the mouse button is released, the selected area will become the
selected map. Selecting an area using the zoom option does not maintain the
aspect ratio.

Note: Both Region Zoom and Zoom allows for area selection in the Map Area;
however, Region Zoom will maintain aspect ratio and allow the user to cancel the
operation after the selection was made.

Pan: Enables the user to click and drag on the map to move the map in the
direction of the drag.
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Pick Feature: Shows a group of available places from the database as
“phantom labels”. This feature enables the user To pick a label and add it to
the map. The labels will appear over the map only when an entry is selected in
the explorer tab or in the search area.

(%]

- - |

Browse

Features

@ Toscana
@ Arezzo

?ﬁ- Foma (Rome), Roma

< Ju] 2]
| H-l -:f"‘ajl Close I

Browse Map: When clicked any click on the Map Area will update the browse
window with context information for the clicked position. The context
information includes regions containing the position (for example country,
state and county) and the capital of the country.

53}

Move Label: Enables the user To move a label in the Map Area. Map Label
enables the user to move the tip and the caption of user-created labels or to
rotate them. In other labels only the caption can be moved and rotated.

Note: Rotation of labels in WME will not effect label objects generated by Viz (3D
labels). The rotation is noticed only when using labels as part of the map texture.
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=

= 1

New Detail

Name: I My Flace

Style: IF'Ian:e ;I

¥ Remember label and publish to all user

a4 I Cancel |

Add Label: Adds a label at the click point, enabling the user to enter and select
a label text and label icon type.

- Remember label and publish to all users: When this option is checked, the
new label will be added to the database. Whenever the place is selected all
the customized labels will be available for selection by the user. When the

option is unchecked, the modified label will be used only by the current
map.

=%, Nos n i .
w J-#I:::mj A Wil Wi Label | [SS é

A Ll

Streets: Enables the user to selectand label streets on the map. Street data
must be loaded for this feature to work (see Extra Data Tab).

Mﬂ \/Points
(Ve

Add Shape: Adds shapes to the map. Select between points (straight) and
bezier (curved). Selecting the Add Shape button also opens a small toolbox for
selecting shape designs. Available options are:

- Area: Fills the drawn shape, and will also close the line (see Closed Line).

- Closed Line: Allows the user to close the shape without setting the final
point (e.g. 2 points will draw a third closing the line with the first point).

- Open Line: Allows the user to draw a line that is not closed.

- Delete Last: Deletes the last drawn line.

- Cancel: Cancels the draw opertion.
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\ Offset Road

Edit Shape: Allows the user to edit the shapes and streets added to the map.
Streets (roads) can be offset, while shapes can be adjusted using the Point
toolbox that appears when the Edit Shape button is selected.

Note: Shapes and streets can be edited further using the maps plugins (e.g. 3D Line
and 3D Line Manager.

To create a map using the Quick Map location browser

Quick Map &l
Country | China g‘:;ii’;‘ | g::::go” Features

Cambodia h] Anhui -~ Type | Name¥
Cameroon Beijing

Canada — |Chongaing

Cape Verde Fujian G Tongzhou, Beijing
Cayman Islands Gansu

Central African Republic Guangdong

Ceuta Guangxi Zhuangzu Zizhiqu

Chad Guizhou

Chile Hainan

China. Hebei

Christmas Island Heilongjiang

Cocos Islands Henan

Colombia Hong Kong

Comoros %] Jvicber (¥l

B+ B+

G| Porim g ol

1. Click the More button’s Quick Map option in the WME.
2. Select or search for a country in the Country list.

- The map area will fit to the selected country and the State/Region list will
show a list of available regions of the selected country.

- When a country is selected in the list, the Add to map and Mark Area
buttons will be enabled.

3. Select an entry from the list, the County/sub region list will be filled.
4. Click Finish to close the location browser and create the map.
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To set the map location

1.

Set Location

|_|:||-|gl|:x:| 114.0000C :
- Kilometres

Lat, ) I 22,00000 _l? I:EEES
ards

Radius I 360.00 ﬁ I Kilometres ;I

Cancel |

Click the Set Location button in the WME to open the Set Location dialog box.

2. Enter the longitude, latitude, and map size radius in miles, kilometers, meters

or yards.

3. Click OK to calculate and display the map in the Map Area.

To pick a label and add it to the map

i rm .
g:‘r‘vgka—ﬁe\itung
oo & : ¥ ;
I~ Visible lm IW oot : B
@ o . N m& 4
""} Biangks-Eelitung T ¢ . . Eulavesi Tengah
2 serten T o
t e ¥ EE S e
8 o Eng.dmaterasaatan .
6 Jakarta Raya ; A
1. Perform a search and select a location.
2. Click the Pick Feature button to display all the phantom labels for the selected
area.
3. Click a label to add it to the map.
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To move a label

Pick.  Browse Mowve add add Edit
Feature Map  Label Label |Streets Shaoe Shape

& (&) (3 il

Move Label Point

1. Click the drop-down button to open a list of options.
2. Select one of the options and then select a label on the map and move the
label around in the graphic display.

11.1.9 Map Details Area

Figure 31: Map details area
tap Detailz

)

Austria

B
e
I
B

G

.

Israel

:

Thailand

)

England

€
a3

Style: |Selected Region v |

Font Size: |12 vI [~ AllCaps

The Map Details area displays a list of all the added locations over the map. The
user can modify the map, by selecting one of the added places and the control
buttons on the right side of the map details area.

Map Details parameters

Style: Sets or modifies the graphic display representing the selected place on
the map. The style selection will affect the highlighting color used to mark the
selected place, the label, and so on.

Font Size: Sets the font size used for the label in the graphic display. Font size
is only relevant for the display in the editor and for text labels that are
exported as part of the map texture; hence, it will not affect the size of labels
rendered by Viz.

All Caps: Uses only capital letters in the graphic display when showing the
selected place’s label.
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Rename Label

| My Place ﬂ

I Remember change and publizh to all users

| Q. | Cahcel |

LGS

Rename label button: Opens the Rename Label dialog box that will allow the

user to customize and add other labels to the database by entering a new label

for the selected place or by selecting an existing label from the list of labels or
modifying an existing label.

- Remember change and publish to all users: When this option is checked, the
renamed label will be added to the database. Whenever the place is selected
all the customized labels will be available for selection by the user. When
the option is unchecked, the modified label will be used only by the current

map.

Delete place from map: Removes the selected entry from the map (and from
the map details list).

Delete all places from map: Removes all added places from the map (and from
the map details list).

11.2  Using the Map Editor

This section describes how to use the Viz World Map Editor (WME) with Viz Artist,
Viz Content Pilot (VCP) client (which includes how to use Viz Template Wizard and
the Newsroom Component), Viz Trio and Viz Weather.

This section contains information on the following topics:
To test with Viz Artist

To test with Viz Content Pilot
To test with Viz Trio
To test with Viz Weather
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To test with Viz Artist

Server Built Ins Control Views Stage  |Server/Stage

Import Archive Config Post onar | [EHEERFE
[

Function Container Container
Folders - FP cwmclient Plugin [
£ A 5
1 Arange ‘ Viz Curious Maps Editor (CME) | Refresh Map | Refresh Map (Force New) |
£ Container A P [ Texture Labels | 3D objects | Miscellaneous |
£1 Control | ) TN Lock Aspect Ratio on
HopByne
Texture Size Manual Pal | ntsc | w0 |
-
E Texture Width =0
& . Texture Height 1024 %ﬂ
Texture Compression None DXT1 oxia | oxas |
L] w Texture Quality Linear Mipmap
CiMaps | [» !l{
E
£ Maps-Adv v {ﬁgl
] e,
£ Maps-Man i NavFinder  Navigator
€] Maps-Obs
] Presenter o T r
£ SeriptPlugins
©) splinerx g l@v
£ TextFx Tracelt = WPosition
] Texture
£1 Time
£] Teols
] Transformation
£] text

£ textuers

Fonevigator | 4[K | b (@ | ] oo - |EE-2 e ] § &

[ |
‘Sl

IEI. Pyramid-Control| ﬂ
| g .
e '

]
N
Key]
]
o
e
Save |saveAs| Close | /03 users/viernBGovia_Undo | Redo | Grid]

m

=

o
@

. (24 vizCuriousMapsClient \vizrt!

o

Viz Artist requires no additional setup as long as the Viz World Client is installed,
and the map server settings in Viz Config’s Maps section have been activated.

1. Open a map scene

2. Locate and click the CWMClient icon in the tree structure to open the
CWMClient Editor.

3. In the editor, click the Viz World Map Editor (WME) button to open the editor.
4. Search and select a map, and click OK to add a map to the scene

Note: Make sure that ControlMap plugins are placed on the same containers as the
CWMClients in order for Viz Content Pilot to be able to change their maps.
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To test with Viz Content Pilot

‘&3 Viz Template Wizard v. 5.3.0 - Database: VIZ-xw4300/D0C
File Edit View VizEngine Tools Help

Standard

@ REIEINI B@EEEII@I@

- . -Smpt T TTwiImagelnfl: TTWImagelnf
e "——
= (£ 2 (To Map) an

[1 - SCENE*vizWorld/8200 - Designing

alNone

2 .|| BAnchors [akLeft,akTop]
= AutaSize I

ControlObjectName d
2 Enabled W =
4 EvObjects (TStrings)
s Height a6
& HideObjects (TStrings)
7 ‘|| HideonEmpty I
8 | |2 1mageSources [isAdvancedCuriousMap]

e I‘ isAdvancedCuriousMap
: nd

isCuriousMap
isDatabase
isFileOpen

T 119

Line: 1, char: 1

Design mode

Viz Content Pilot’s (VCP’s) map server parameters are stored on the VCP database.
The parameters can be set or changed using the VCP client (Options >
Preferences > Viz World).

For an operator or journalist to be able to change maps, the map scenes must use
the ControlMap plugin. Also, before the scene can be used in the VCP client or
Newsroom Component a map template must be created using Viz Template
Wizard.

1. Start Viz Template Wizard
2. Import a Viz Artist map scene to the Viz Template Wizard

- If a ControlMap plugin is used by the designer an image component will be
automatically added to the template

- A template user clicking the image component will then be able to open the
Viz World Map Editor to select a map

3. The ImageSources property should be set to IsAdvancedCuriousMap
4. Save the template to a concept

Once the template is stored it can be opened by the VCP client or Newsroom
Component.
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i Viz Content Pilot v5.3.0 - User: jfr - Database: viz-xw4300/doc - MSE: localhost =&
Fle Edt Options Tools VizEngne Windows Hep
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Font Size: =| I AlGaps

[CME 9.0.0. 1696 RC (Viz CMS 9.0 Beta 5 (Map DB v9.0))  Zoom Tool: Hold down SHIFT or ALT to zoom out. Hold down CTRL for fine control.

BGOs22WL @8 m

1. Start the VCP client or Newsroom Component, and open the newly created
template.

Click the image in the template to open the WME.

Enter a search criteria (for example London)

Select London City, England from the list

Tick London City, England, and click the zoom button (map icon) for England
Click OK to close the WME.

Save a data element of the template and add it to the playlist.

Play or preview the scene on a local Viz Engine renderer to see the map
animations.

PNV A WN
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To test with Viz Trio

Viz Trio - Version 2.9.0 (Build 55429)

i Browse Viz Curious Maps

Seatch | Explorer | Sireets | Images |

Pick Browse Move Add Regon add  Edit
Featre Map Label Label Zoom Zoom Pan Streets Shape  Shape

1 - e e

rn

[ vien Grey ScaleCylindii =] | ~

Birds | Quick | Set
= el Epe | Map | Location

Find: & a1 € Visible
e a5
Memed: [
sdde [ Cessst
Search
Type |Mame ¥

Description

Style e |
o 1 (From MAP) _Longitude: 0
® 2 (To Map) Longitude: of| Font Size: =] I &1 Eaps
ME 9.0.0. 1696 RC (Viz CMS 9.0 Beta 5 (Map DB v3.0))  Zoom Tool: Hold down SHIFT or ALT to zoom out. Hold down CTRL for fine contral.

= \1Z-xwa300 (program) | [ [ [l | @ [Editing page 8200

Viz Trio’s map server parameters are set by the local Viz Engine that Viz Trio uses
to render the scenes locally; hence, there is no need to configure Viz Trio.

Start Viz Trio

Select Import Scenes from the drop-list in the Editing window.

Locate and import a tutorial scene to create it as a Viz Trio template.

Select and double-click to open the newly added template.

Click the Browse Viz World button to open the editor.

Enter a search criteria (for example London)

Select London City, England from the list

Tick London City, England, and click the zoom button (map icon) for England
Play the scene in Viz Trio so see the map animations

© ®NOUThAWN =
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To test with Viz Weather

To enable the Viz Curious Maps capabilities, add the following entry to the Viz
Weather INI file:

[CURIOUS]

cwm_enabled=y

simplified=n

Open a map enabled scene in the editor

Click the Map button on the editor toolbar

Click the Map icon to select a map

Select From Server

- When selected, a full version of the map editor opens
Select a map project

Enter a search criteria (for example London)

Select London City, England from the result list

Enter a new search criteria (for example England)

Select England from the result list

CIEAEY

10. Adjust the view and style of the map

- Use the map buttons (lower right) in Viz World Client
11.Click OK to close the map editor.
12.Play the scene in Viz Weather to see the map animations.

A W N =

© 0N W
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Map Name Editor

- _
i Map Names Editor

World Server  localhost

P Word P

Capital

Denmark
Djibouti
Dominica
Dominican Republic
East Timor
Ecuador

Egypt

El Salvador
Equatonial Guinea
Eritrea

Estonia

Ethiopia

Region

Democratic Republic Democratic Republic of the

Town > 1M Town > 100K Town > 10K Town > 1K

Country
Denmark Country
Djibouti Country
Dominica Country
Dominican Republic Country
East Timor Country
TH7 FILAA0E

IZT - PSTE Country

Ecuador Country
Egypt oM«
El Salvador WT270 9N IILARL CRILEFD . Country
FREF = PEE
TYUrUTE

IA=PHiE

IFALPEHET Country

Equatonial Guinea TN NXTa Country

Eritrea NN Country

Estonia I0DN Country

Ethiopia OTnN

Showing 273 Features

The Map Name Editor is a batch feature translation tool meaning that you can use
it to edit multiple language translations stored at the Viz World Server.

- World Server: Allows you to connect to the Viz World Server using either
hostname or IP address. Click the Connect button to connect with the server.

Once logged in you can display all features at four different region levels; World,
Country, Region and Sub Region level. However, this depends on the levels
available for each country (e.g. the United States of America has all four levels,
while Oman only has three levels).

Once you have chosen the regional level you want you can further filter your result
or select one or several of the pre-configured layer buttons.

P Word P

Capital

Democratic Republic
Denmark

Djibouti

Dominica
Dominican Republic
East Timor

Ecuador

Egypt

Region

Filter :

Town > 1M Town > 100K Town > 10K Town > 1K Other

v DB Name
Democratic Republic o Country
Alternate Name
Denmark Uies Nome Country
Djibouti v Abbreviations Country

Dominica German Country

Dominican Republic ¥ Hebrew Country
HFAE—JLEES Country

T4 PR

East Timor RRrpEe

¥ Type

Ecuador Country

Egypt IT - FSTH Country

If you right-click the column headers you can display different columns. The
standard columns are Display Name, DB Name, Alternate Name, User Name,
Abbreviations and Type. In addition you can add you custom language
alternatives and choose to display them using the context menu.
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See Also

Using the Map Name Editor

Using the Map Name Editor

This section describes how to use the Map Name Editor. See the following
sections for more information:

To create a new language file
To add language specific translations
To use the new language file

To create a new language file

1. Start Windows Explorer
2. Under C:\Program Files\Curious Software\Curious World Maps\SharedData
create a folder named Languages

3. In the folder you can either place an empty file called <my language>.mdx or
copy and rename UserNames.mdx (if you already have changed a lot of the
label names)

P Word P Belgium P Bruxelles

Capital Region  Townlm Townl00k TownlOk | Townlk Other

Anderlecht Anderlecht Town10K

Brussels Bruxelles _ Capital

4. Start the Map Name Editor executable found under C:\Program Files\Curious
Software\Curious World Maps and edit the new file

- Your language will be added as a new column

5. Click Save Changes

To add language specific translations

j—

. Start the Map Name Editor
2. Connect to your Viz World Server

3. Right-click and select your language column representing your custom
language file
4. Search for the name that needs a language specific translation

ol

Enter the translation and click Save Changes

To use the new language file

1. Start the Server Configuration tool and log on to your Viz World Server
2. Select the Maps’ Display section

3. Set the Alternate Label Display’s first option to be M-Language (multi-
language)
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4. Start for example Viz Artist, create a maps scene and launch the Viz World
Map Editor (WME)

Guides

Languages

Server Priority

menu

6. For Viz Artist add/edit the VizWorld.ini file under C:\Program Files
(x86)\vizrt\Viz3\plugin\data\maps and add the following entry:

language=[my Language ID]
7. or (dynamically) send the following command to Viz Engine:

MAPS LANGUAGE [my Language ID]

Note: my Language ID refers to the order in the list of languages, English = 0,
Norwegian = 1etc. See the above screenshot.

See Also

Map Name Editor
Display
Maps Configuration
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12 Geometry Plugins

The Viz World Client (WoC) installation includes a package of plugins used for
enhancing the geographic referencing ability in Viz Artist. The WoC plugins
includes geometry, container, shader and scene plugins.

This chapter describes all geometry plugins. The geometry plugins are found in
three plugin folders:

Maps: Contains Standard plugins.
Maps-Adv: Contains Advanced plugins.

Maps-Obs: Contains Obsolete plugins, installed only for backward
compatibility. These plugins should not be used when designing new scenes.

See the following sections for more information:

Standard

2D Label

3D Border

3D Line

3D Model

3D Region

3D Roads

Atlas

Curious 3D Terrain
Geolmage
Globe

Pyramid Control
Region Halo
Shadow Agent
Street Labels

Advanced

3D Border Control
3D Line Control
3D Region Control

Obsolete
Flat MR

See Also

Container Plugins
Shader Plugins
Scene Plugins
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2D Label

The plugin can be found in the following folders:
Viz Artist 2: Object -> Built in.

Viz Artist 3: Built Ins -=> Geom Plugins -> Maps.

Figure 32: 2D Label example

The 2DLabel plugin is used for creating two dimentional labels on the map, based
on labels received from the selected map or automatically generated labels
generated by the LabelManager plugin according to the map information received
from the Navigator plugin.

Note: When adding a 2DLabel plugin to a container, a World Position plugin and an

Alpha plugin will be added automatically to the same container. The Label Manager

scene plugin has to be added manually to the scene when using the 2DLabel plugin
without a Navigator plugin.

This section contains information on the following topics:
Plugin Description

See Also

Navigator plugin
Label Manager plugin
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12.1.1  Plugin Description

The 2D Label plugin has five sections of parameters (GUI Options).

This section contains information on the following topics:

Label
Bevel
Caption
Special
Fade

Label

Figure 33: Label, 2D Label editor

2DLabel Plugin (12.0.0)

Margin Options
Width Margins
Height Margins
Outline Width

Label Celor

Outline Color

w2

Label

Bewvel

Caption

Special

Fade
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I < e
Ll o0 Sl
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Separate

+ Margin Options:

- Equal Spaced: Uses equal spacing for the side margins and top/buttom

margins.

- Separate: Uses different margins for each side of the labels.
Width Margins: Sets the margin between the sides of the text and the label

background edges.
Height Margins: Sets the margin between the top and bottom of the text and

the label background edges.

Outline Width: Sets the width of the label’s background outline.

Label Color: Sets the color of the label’s background fill.

Outline Color: Sets the color of the label’s background outline.

Note: The numeric values next to the color parameters are the alpha values of the

label and the label outline.

Note: The color palette effects only the selected color parameter (label or outline),
and it will appear when one of the color parameter is selected. (Viz 3). When using
Viz 2 the color palette is displayed in all tabs.
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Bevel

Figure 34: Bevel, 2D Label editor

2DLabel Plugin (12.0.0) i
Label I Bevel Caption Special Fade
Bevel T
Roundness milﬂ
Detail o | 1 | 2 3 |
Lock Aspect ’;
2

Bevel: This parameter defines the bevel value of the label’s background

corners.

Roundness: This parameter defines if the background corners will be rounded

or not.

Detail: Defines the quality of the label object (when a higher value is selected,
more polygons will be used to build the label object).

Lock Aspect: When enabled (On), the bevel and roundness parameters will be
applied to the corners of the label object equally. When disabled (Off, the
bevel and roundness parameters will be applied to the corners using the
object’s height and width ratio.

Caption

Figure 35: Caption, 2D Label editor

2DLabel Plugin (12.0.0)

i

Label | Bewvel | Caption Special | Fade |
Pivot Pointer Outline | Center | Offset | Position |
Width Type Angle Length
i T
Connection Bewvel i‘ﬂ
Rotate Labels off Oon
Caption Mode Stand Alone I Controlled
Server Shift Debug Off on

Presets WHME

Number Of Presets 1 | 2 | 3 | 4
Current Preset 1 2 | 3 | 4 |
Direction (deg) milﬂ
Distance (cm) i‘ﬂ
2

Pivot: Defines the label’s object shape and location in relation to the label’s

geographic location:

- Pointer: The label object includes a pointer going out of the label
background and pointing at the label’s geographical position. When
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selected, additional parameters will be enabled: Width and Connection
Bevel.

- Qutline: The label object has a rectangular shape and the outline of the
shape is on the label’s geographical position.

- Center: The center of the label is placed over the label’s geographical
position.

- Offset: The label is placed at the defined offset from the label’s
geographical position.

Width Type: Defines if the (strap) width should change as the caption is

moving away from the tip or stay fixed.

Width: Defines the width of the pointer’s base overlapping the label

background. This parameter is only enabled when Pointer is selected.

Connection Bevel: Defines if the area connecting between the pointer and the

label background is to be rounded or sharp. This parameter is only enabled

when Pointer is selected.

Rotate Labels: Defines if labels, created in Viz (3D labels), will be rotated like

the labels in Viz World Map Editor (WME). If set to Disabled, all labels will be

displayed horizontally. If set to £nabled, labels that were rotated in Viz World

Map Editor will be rotated in Viz.

Caption Source: Defines how the labels will be placed on the map.

- When WME is selected, the labels will be placed as they were placed on the
map in the Viz World Map Editor.

- When Presets is selected, the LabelManager plugin will use the defined
presets to place the labels over the map. The LabelManager plugin will
optimize the label position such that the labels will not overlap.

- When WME is enabled the Number of Presets and Current Preset options are
hidden and the option WME Offsets Distance paramater is enabled.

Number of Presets: Defines the number of label position presets available to

the user (one to four presets). This parameter is only enabled when Caption

Source is set to Presets.

Current Preset: Selects the preset number to be configured, using the

Direction and Distance parameters. Each preset should be selected and the

label position should be adjusted. This parameter will be enabled only when

Caption Source is set to Presets

Direction: Sets the angle of the label in relation to its geographic position.

Distance: Sets the distance of the label from its geographical position.

WME Offsets Distance: When WME is enabled, this parameter enables the WME

to offset the distance (default ON). When disabled (OFF) only the direction

offsets from WME is used and the distance ignored.
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Figure 36: Special, 2D Label editor

Shape

Size

Mawvigator Overlay
Near Scale
Far Scale

Static Map Scale
Scale

Caollision Mode

Hide If Empty

2DLabel Plugin (12.0.0) i
Label | Bevel | Caption | Special Fade
MNaone Circle Sqguare | Straight |
[ 50 3l
Disabled | Fixed [  Scaling
[ 1000 Sl
BEE < R
Off I cn
| 1000 3l
Tip Based BBox Based
Off I on

Shape: Defines the pointer shape:
- None: The pointer will have a sharp point shape.

- Circle: The pointer will have a circle at the tip of the pointer.

- Square: The pointer will have a circle at the tip of the pointer.

- Straight: The pointer will have straight lines at the tip of the pointer.

Size: Defines the size of the shape at the tip of the pointer. The parameter is
only enabled if the pointer is selected and a tip shape is set.

92
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Navigator Overlay: Defines how the label will be displayed over the map.

Available options are Disabled, Fixed, Scaling, Near Scale and Far Scale.

- Disabled: Places the label on the map using its geographical referencing.

- Fixed: Places the label by keeping its geographical referencing but using a

different camera (either with dynamic image or with a front layer). The label
size will remain fixed.

- Scaling: Places the label by keeping its geographical referencing but using a
different camera (either with dynamic image or with a front layer). The Label
will scale trying to imitate the camera movement.

- Near Scale: Defines the maximal size of the label on the screen (that is when
zooming in what will be the final size of the label).

- Far Scale: Defines the minimal size of the label on the screen (that is when
zooming out what will be the final size of the label).

Static Map Scale: Defines if scaling of the label will be performed over a static
map (no Navigator plugin used). When disabled (Off), no scaling will be
applied to the labels. When enabled (On), an additional parameter will be

enabled:

- Scale: Sets the scaling factor of the labels when used over a static map (no

Navigator Plugin).

Collision Mode: Defines how the labels will be placed when an overlap or

collison between two labels occur:

- Tip Based: The pointers of overlapping labels can cross or touch, but no
overlap of label bodies are allowed.

- BBox Based: A bounding box is calculated around the entire label (label
body and pointer). Overlap between a label’s bounding box is not allowed.

Fade

Fade defines the fade effect parameters to be used with the duplicated labels.
Fade has two fade modes; Stand Alone and Controlled.

Figure 37: Stand alone fade mode, 2D Label editor

2DLabel Plugin (12.0.0)

i

Label | Bewvel | Caption

Special | Fade

Stand Alone Controlled
Fade On Time Dizabled I Enabled
tmeToree) TSI

Fade On Distance i Frsabsland
Fade On Lat/Long Disabled Enabled

-

Stand Alone: The label appearance is manually defined by setting the

additionally enabled parameters:

- Fade On Time: Defines a label fade effect, beginning at a relative point to
the defined hop duration. An additional parameter will be enabled, 7ime To
Hop, defining when the fade will occur.

- Fade On Distance: Defines a label fade effect, beginning at a relative
distance from the hop final location.
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- Fade On Lat/Long: Defines a label fade effect, beginning at a Longitude and
Latitude offset from the hop final location. An additional parameter will be
enabled, Lat/Long, defining the offset from in degrees.

Note: The Fade On Distance parameter is only enabled if Navigator Overlay is set to
Scaling.

Figure 38: Controlled fade mode, 2D Label editor
2DLabel Plugin (12.0.0) |

Label | Bewvel | Caption | Special | Fade

Stand Alone I Caontrolled

Step Auto On Hop | Paint 1 Paoint 2 Hop And Above
Selected Label Timings At End I Close To End Ahead well Ahead

Label Priority Auto Normal | High Always

w2

With Fade Mode set to Controlled, the label appearance is automatically set by the
2DLabel plugin. It can also be based on the Label Manager plugin settings and the
Navigator plugin animation (hops).

Step: Controls when the label will fade in and out in relation to an animation.

In general the fade can be based on the camera distance (for example; captials

are in view when disctance is below 1000KM) or on timing in relation to the

hop:

- Auto: When a label is of type point (added by the user) it will fade in and out
based on distance to hop. If the label is of type place/region it will be faded
in and out based on the distance set in Label Manager plugin. If the hop is
not close enough for the label to show and the label was added by the user
it will be faded in based on hop timing and not distance.

- On Hop: Links the fade to the hop timing.

- Point 1/Point 2: These are reserved for labels where the distance is
configured by the Label Manager plugin.

- Hop and Above: Turns on at the hop and stays on thereafter.

Selected Label Timing: If the label’s fading is based on hop timing, this
parameter sets the time in relation to the hop time. It is disabled if Step is set
to Point 1 or Point 2. Since the label appearance is automatically calculated
this timing offset will be used in the calculation. Select one of the options:

- At End: Labels appear at the end of the animation.

- Close to End: Labels appear just before the end of the animation.
- Ahead: Labels appear before the end of the animation.

- Well Ahead: Labels appear well before the end of the animation.

Label Priority: Defines the priority of the currently edited label in relation to
other labels when a conflict between label positions occurs. The highest
priority will be preferred when displaying the labels.

- Auto: Sets the label priority using the Label Manager plugin.

- Normal, High: When there is a conflict between two normal (or high) priority
labels, the Label Manager plugin decides which label to show.
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- Always: When always is selected, the label will be displayed even if it
conflicts with another label (with any priority).

12.2

3D Border

The plugin can be found in the following folders:
Viz Artist 2: Object -> Built in.

Viz Artist 3: Built Ins -=> Geom Plugins -> Maps.

Figure 39: 3D Border example

The 3DBorder plugin is used for applying graphic designs to the border data
retrieved by the 3D Map Setting scene plugin. Each 3DBorder plugin is used to
filter and define which borders will be drawn.

Note: When adding a 3DBorder plugin to a container, a 3D Line Shader plugin will
be added automatically to the same container. The 3D Map Setting plugin has to be
added manually when using the 3DBorder plugin.

This section contains information on the following topics:
Plugin Description

See Also

3D Line Shader plugin
3D Map Setting plugin
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Plugin Description

The 3D Border plugin has five sections of parameters, and a Rebuild button.

The Data tab is used for defining which borders will be displayed by the plugin.
The Width tab is used for defining the border width and other graphical related
attributes. The Outline tab is used for adding an outline to the borders. The Effect
tab is used for defining an animation of the border. The Advanced tab is used for

defining general parameters of the border.

This section contains information on the following topics:

Data

Width

Outline

Effect
Advanced
Rebuild button

Data

Figure 40: Data, 3D Border editor

3DBorder Plugin (12.0.0)

Cutline

Effect Adwvanced

[ Data  width |
Draw Country I Region
Select Region | Sub Regicn
Selaction | Disabled Enabled

2

All
Both

Draw: Sets the border type that will be drawn by the plugin. Available options

are Country, Region and All.

- Country: Draws country borders only. When Country is selected, additional
options are made available: Country, Coastline and Both (see Select).

- Region: Draws region borders only. When Region is selected, additional
options are made available: Region, Sub Region and Both (see Select).

- All: Draws all available borders retrieved by the 3D Map Setting plugin.
Select: Displays the available Country or Region options when either of the two

buttons are selected.

- Country: Draws inland country borders only.
- Coastline: Draws country coastline borders only.

- Both (Country & Coastline): Draws both inland and country coastline

borders.
- Region: Draws region borders only.
- Sub Region: Draws sub region borders

only.

- Both (Region & Sub Region): Draw both region and sub region borders.
Selection: Defines if the plugin will use the selected regions in the map
(received from the CWMClient plugin) or not. If enabled, only the borders of
the selected regions in the map will be drawn. If disabled, all borders will be
drawn according to the plugin settings (country, region, and so on).
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Width

Figure 41: Width, 3D Border editor

3DBorder Plugin (12.0.0) i

Data I Width Cutline | Effect | Advanced

_ Fixed (Pixels) [ scaling _ Fixed (mm)
Width (Kilometers) [ 250 =l
Minimum Width (Pixels) 0.0001 Sl
Maximum Width (Fixels) iIR
Minimum Draw Width (Pixels) “iIR

Fade Edge (%:) i‘ﬂ

See Me Now
2

Width

Fixed (Pixels)- Uses a fixed width when drawing the line. This parameter will
cause the line to maintain the same width regardless of camera position/
distance. Available parameters are Width and Fade Edge.

- Width (Pixels): Sets the line width in pixels.

- Fade Edge (%): Sets the percentage of softness added to the edges of the
line. When set to 0% the line edges will be sharp and when set to 100% the
edges will be soft.

Scaling: When selected, line width will vary according to the camera distance
from the map. Available parameters that allow the user to set the line
attributes are Width, Minimum Width, Maximum Width, Minimum Draw Width
and Fade Edge.

- Width (Meters): Sets the line width in meters on the map. The closer the
camera to the map, the wider the line will be drawn.

- Minimum Width (Pixels): Sets the minimal line width in pixels. If the
calculated line width (according to the Width parameter) is smaller than the
Minimum Width value, then the Minimum Width value will be used.

- Maximum Width (Pixels): Sets the maximal line width in pixels. This value
will be used when the camera distance is small and the line width should
have been larger than the Maximum Width value (in pixels).

- Minimum Draw Width (Pixels): Sets the minimal line width in pixels. If the
calculated line width (according to the Width parameter) is smaller than the
Minimum Draw Width value, and larger than the Minimum Width parameter,
then the line will not be drawn.

- Fade Edge (%): Sets the percentage of softness added to the edges of the
line. When set to 0% the line edges will be sharp and when set to 100% the
edges will be soft.

Fixed (Mm)- Uses a fixed width, in viz units, when drawing the line. This

parameter will cause the line to maintain the same width regardless of camera

position/distance. Available parameters are Width and Fade Edge.

- Width: Sets the line width in pixels.

- Fade Edge (%): Sets the percentage of softness added to the edges of the
line. When set to 0% the line edges will be sharp and when set to 100% the
edges will be soft.

See Me Now: Calculates (when width is set to scaling) the width needed for the

line to be visible at a given distance.
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Outline

Figure 42: Outline, 3D Border editor

3DBorder Flugin (12.0.0)

2|

Data | Width | Cutline Effect | Advanced
Outline None | Master | Slave I Stand Alone
Outline Width (%) [ 00 =R
Outline Fade (%) milﬂ
Outline Color |— ilﬂ

None: No outline to the borders is drawn by the plugin.

Master: Acts as the master plugin for outline behavior. Other 3DBorder plugins
can be set as clients of this plugin. The same outline attributes will be applied
to borders drawn by the master plugin and by all other slave plugins. When

selected, additional parameters will be enabled:

- Outline Width (%): Sets the width of the outline, as a percentage of the

border width, where 0% is the border width.

- Qutline Fade (%): Sets the percentage of softness applied to the outline

edges.

- Outline Color: Sets the color of the outline and the alpha value of the

outline.

Slave: Draws the outline according to the defined outline in the master plugin
above it in the scene hierarchy. All other parameters will be disabled,

displaying the master’s values.

Stand Alone: Defines the outline parameters for the borders drawn by this 2D

Label plugin only:

- Outline Width (%): Sets the width of the outline, as a percentage of the

border width, where 0% is the border width.

- Qutline Fade (%): Sets the percentage of softness applied to the outline

edges.

- QOutline Color: Sets the color of the outline and the alpha value of the

outline.

Note: The hierarchy structure is important when using the master/slave outline
configuration. The master plugin should always reside as the first container in the
group of 3DBorder containers. An Expert plugin should be added to the map (above
the 3D Roads containers) and Z-Buffer Draw should be set OFF.
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Effect

Figure 43: Effect, 3D Border editor

3DBorder Plugin (12.0.0) i
Data | Width | Cutline I Effect Advanced
Border Length ilﬂ
Fode o Bl
2

The Effect tab is used for creating an animation on the line size. After the line

object is created, it can be animated by setting keyframes of the length

parameter.

- Length: Sets the line length, where the value 100 represents 100% of the line
length.
Fade: Defines the softness that is added to the line edge as the length
animation advances. When the length is 100, the end of the line will not be
affected by the Fade parameter.

Height Offset: Offsets the borders from the map (on the fly).

Advanced

The Advanced tab is used for defining general prameters for the 3DBorder object.

Figure 44: Advanced, 3D Border editor

3DBorder Flugin (12.0.0)

i

Height Offzet

Border Quality
Culling Threshold
Add Level Down
Control Mode
Set Groups

Line Shader

I Adwvanced

Data | width | outline |  Effect
i o
Controlled High | Medium | Low |
Disabled Enabled

Dizabled I Enabled
|

Simple I Advanced

Update Texture Mapping IW Always Stationary |
Low Angle Compensation Disabled | Enabled Adwvanced
Debug l;
Min Angle milﬂ
Max Angle ilﬂ
Cutline Angle Offset ilﬂ
Width Factor (%) mi@
Alpha Factor (%&) milﬂ
Wireframe IE
Print Sub Area Data | Rebuild |
ﬂ

Border Quality: Selects the quality of the border line:

- Controlled: Border quality is calculated by the navigator distance from the
border object.
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- High: Uses high quality when drawing the border line (performance will be
slower).

- Medium: Uses medium quality when drawing the border line.

- Low: Uses low quality when drawing the border line. Border line will look
pixelized when zomming into the map.

Culling Threshold: Defines the size of the borders that will be drawn. Select an

option that will fit the graphic design or other factors. For example; If a

country has small islands and the threshold is set too high, the islands will not

be drawn correctly or drawn at all.

Add Level Down: Defines if the sub region borders will be drawn with the

region borders, or if regions will be drawn with countries.

Control Mode: Defines if the 3DBorder object is externally controlled by the

3DBorderControl plugin or not. Border objects are controlled by groups. Set

the group number for the object.

Update Texture Mapping: Should the texture coordinates be updated based on

line width.

Low Angle Compansation: Lines become too thin at low camera angles as a

result of the perspective distortion. When that happens, there are not enough

pixels to support a smooth, antialiased line, and the lines look jaggy and

aliased. This mode compensates for that by both widening the lines and

applying transparency when they are viewed at too low angles.

Wireframe: Shows the border object as a wireframe.

Rebuild

Figure 45: Rebuild, 3D Border editor

Rebuild

The Rebuild button triggers the plugin to redraw the borders according to the
plugin parameters. Some parameters are updated as the parameters are changed
and do not require a rebuild command, but it is good practice to rebuild the
borders after setting the parameters.

12.3
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3D Border Control

3DBorderCirl

—
A

2CBorderCo

The plugin can be found in the following folders:
Viz Artist 2: Object -> Built in.

Viz Artist 3: Built Ins -> Geom Plugins -> Maps-Adv.
The 3DBorderControl plugin is used to control the attributes of a group of

3DBorder objects. The plugin controls the applied material, border width, edge
softness and visibility.
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Note: The 3DBorderControl plugin does not build the 3DBorder objects. The
controlled 3DBorder objects should be built before the 3DBorderControl is used.

This section contains information on the following topics:
Plugin Description

12.3.1  Plugin Description

The 3DBorderControl plugin has two modes: Control for defining the control
mode and Width for setting the border parameters.

Container: Placeholder for the top container of the 3DBorder objects. All
controlled 3DBorder objects must reside directly under the top container. Any
lower level containers will not be effected.

This section contains information on the following topics:
Control

Width

Control

Figure 46: Control mode Level, 3D Border Control editor

3DBorderContral Plugin
Cantainer = R group

Cantral Width
Control Mode Lewvel Graup
Diraw Country I Region All
Select Fegion | Sub Region | Both

Control Mode: Defines how the objects will be grouped when controlled by the
3DBorderContol plugin. When set to Level, the 3DBorder objects will be
grouped by their data type (that is country, region and sub-region).

Draw: Defines what data types will be drawn. 3DBorder objects with other data

types will not be switched off:

- Country: Shows 3DBorder objects displaying country borders only.

- Region: Shows 3DBorder objects displaying region and sub region borders
only, according to the user selection. Available options are; Region (draws
region borders), Sub-Region (draws sub-region borders) and Both (draws
both region and sub-region borders).

- All: Draws all border types (that is country, region and sub-region).
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Figure 47: Control mode Group, 3D Border Control editor

JDBorderControl Plugin

Container TR group

Contral Width
Control Mode Lewvel I Group
Group 2 wald

Group: Defines the group number that will be visible and controlled by the
3DBorderControl plugin. Groups are defined in the 3D Border plugin in the
Advanced tab’s Set Groups parameter.

Width

Figure 48: Width, 3D Border Control editor

3DBorderControl Plugin )
Container = |R| group
Width [ Fixed ( Pixels) Scaling | Fixed (Mm) |
Fade Edge (%) ﬁgj

Fixed (Pixels)- Uses a fixed width when drawing the line. This parameter will
cause the line to maintain the same width regardless of camera position/
distance. Available parameters are Width and Fade Edge.

- Width (Pixels): Sets the line width in pixels.

- Fade Edge (%): Sets the percentage of softness added to the edges of the
line. When set to 0% the line edges will be sharp and when set to 100% the
edges will be soft.

Scaling: When selected, line width will vary according to the camera distance

from the map. Available parameters that allow the user to set the line

attributes are Width, Minimum Width, Maximum Width, Minimum Draw Width
and Fade Edge.

- Width (Meters): Sets the line width in meters on the map. The closer the
camera to the map, the wider the line will be drawn.

- Minimum Width (Pixels): Sets the minimal line width in pixels. If the
calculated line width (according to the Width parameter) is smaller than the
Minimum Width value, then the Minimum Width value will be used.

- Maximum Width (Pixels): Sets the maximal line width in pixels. This value
will be used when the camera distance is small and the line width should
have been larger than the Maximum Width value (in pixels).

- Minimum Draw Width (Pixels): Sets the minimal line width in pixels. If the
calculated line width (according to the Width parameter) is smaller than the
Minimum Draw Width value, and larger than the Minimum Width parameter,
then the line will not be drawn.
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- Fade Edge (%): Sets the percentage of softness added to the edges of the
line. When set to 0% the line edges will be sharp and when set to 100% the
edges will be soft.

Fixed (Mm)- Uses a fixed width, in Viz units, when drawing the line. This

parameter will cause the line to maintain the same width regardless of camera

position/distance. Available parameters are Width and Fade Edge.

- Width: Sets the line width in pixels.

- Fade Edge (%): Sets the percentage of softness added to the edges of the

line. When set to 0% the line edges will be sharp and when set to 100% the
edges will be soft.

12.4 3D Line

[

A0OLine

The plugin can be found in the following folders:
Viz Artist 2: Object -> Built in.

Viz Artist 3: Built Ins -=> Geom Plugins -> Maps.

Figure 49: 3D Line example

The 3DLine plugin has several graphic uses:

Chapter 12: Geometry Plugins 103



12.4.1

104

Drawing shape lines created in Viz World Map Editor (WME) when selecting a
map. A line design is created in the hierarchy and defined in the CWM Client
plugin (see 3D Objects and Shapes, CWM Client editor).

Drawing a line between label locations, defined in the WME, from the first label
in the list to the last label in the list. Labels in the CWM Client plugin must be
enabled when using this mode.

Drawing a line along hop points defined in a Navigator scene. The line will
follow the path af the Navigator animation between the hops.

Drawing a line using a Long/Lat coordinates list. The line will be drawn from
the first Long/Lat pair to the last.

Note: When adding a 3DLine plugin to a container, a 3D Line Shader plugin will be
added automatically to the same container. The 3D Map Setting plugin has to be
added manually when using the 3DLine plugin with Navigator plugin.

Note: Some of the uses of 3Dline plugin as described above requires the use of the
Label Manager plugin in the scene.

This section contains information on the following topics:
Plugin Description

See Also

3D Line Manager
3D Line Shader
3D Map Setting
Label Manager
Navigator

Plugin Description

The 3D Line plugin has four sections of parameters, and a Rebuild button.

This section contains information on the following topics:
- Width

Outline

Effect

Control
Advanced
Rebuild button
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Width

Figure 50: Width, 3D Line editor

3DLine Plugin (12.0.0) i

IW Outline | Effect | Control | Advanced
Width Fixed ( Pixels) Scaling Fixed { mm )
Width (Meters) Rl
Minimum Width (Pixels) [ 0.0001 S
Maximum Width (Pixels) “ilﬂ
Minimum Draw Width (Pixels) “ilﬂ
Fade Edge (%) milﬂ

Rebuild
See Me Now

Note: Width parameters, Fixed (Pixels) and Scaling, will effect the line object only if
the scene uses a Navigator plugin. In case of a static map, use the Fixed (Mm) to set
the line width.

Fixed (Pixels)- Uses a fixed width when drawing the line. This parameter will
cause the line to maintain the same width regardless of camera position/
distance. Available parameters are Width and Fade Edge.

- Width (Pixels): Sets the line width in pixels.

- Fade Edge (%): Sets the percentage of softness added to the edges of the
line. When set to 0% the line edges will be sharp and when set to 100% the
edges will be soft.

Scaling: When selected, line width will vary according to the camera distance
from the map. Available parameters that allow the user to set the line
attributes are Width, Minimum Width, Maximum Width, Minimum Draw Width
and Fade Edge.

- Width (Meters): Sets the line width in meters on the map. The closer the
camera to the map, the wider the line will be drawn.

- Minimum Width (Pixels): Sets the minimal line width in pixels. If the
calculated line width (according to the Width parameter) is smaller than the
Minimum Width value, then the Minimum Width value will be used.

- Maximum Width (Pixels): Sets the maximal line width in pixels. This value
will be used when the camera distance is small and the line width should
have been larger than the Maximum Width value (in pixels).

- Minimum Draw Width (Pixels): Sets the minimal line width in pixels. If the
calculated line width (according to the Width parameter) is smaller than the
Minimum Draw Width value, and larger than the Minimum Width parameter,
then the line will not be drawn.

- Fade Edge (%): Sets the percentage of softness added to the edges of the
line. When set to 0% the line edges will be sharp and when set to 100% the
edges will be soft.

Fixed (Mm)- Uses a fixed width, in viz units, when drawing the line. This

parameter will cause the line to maintain the same width regardless of camera

position/distance. Available parameters are Width and Fade Edge.

- Width: Sets the line width in pixels.
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- Fade Edge (%): Sets the percentage of softness added to the edges of the
line. When set to 0% the line edges will be sharp and when set to 100% the

edges will be soft.

See Me Now: Calculates (when width is set to scaling) the width needed for the

line to be visible at a given distance.

Outline

Figure 51: Outline, 3D Line editor

3DLine Plugin (12.0.0)

Width I Outline Effect

Control Adwvanced

Outline off I Oon

Outline Width (%) [ 00 Sl
Outline Fade (%) mi‘ﬂ
Outline Color |— ilﬂ

Rebuild
2

Outline: Enables (On) or disables (Off) outline.

- Outline Width (%): Sets the width of the outline, as a percentage of the

border width, where 0% is the border width.

- OQutline Fade (%): Sets the percentage of softness applied to the outline

edges.

- QOutline Color: Sets the color of the outline and the Alpha value of the

outline.

Note: The color palette is visible in all tabs of the editor, but it will only effect the

outline color.

Effect

The Effect tab is used for creating an animation on the line size. After the line
object is created it can be animated by setting keyframes on the length

parameter.

Figure 52: Effect, 3D Line editor

Outline | Effect

Width |
Length ~ oo B
rade BN i<

100 il ﬂ

Animation Length (frames)

[off _on |

Lock To Nawvigator

Run Animation |

Rebuild |

Length: Sets line length, where 100 is 100% of the line length.
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Fade: Defines the softness that will be added to the line edge as the length
animation advances. When length is 100 the end of the line will not be
affected by the Fade parameter.

Animation Length (frames): Sets the default length of the reveal animation in
frames (relates to the Run Animation option) and allows you to run a simple
reveal animation by pressing the Run Animation button (used by 3D Map
Telestrator)

Lock To Navigator: When using the 3D Line plugin with a Navigator plugin, the
line will animate with the Navigator animation. The starting point of the line
will be the first hop location and the ending point of the line will be the last
hop position. The line will animate as the hop animations are playing.

Control

The Control tab is used for defining external control parameters. External control
is done by the 3DLineControl plugin.

Figure 53: Control, 3D Line editor

3DLine Plugin (12.0.0) i
Width | Outline | Effect | Contral Advanced
Control Mode Dizabled I Enabled
Set Groups |
Shared Memory Global I Scene Distributed
Identifier |
Rebuild

2

Control Mode: Defines if the object is externally controlled or not.

Set Groups: Defines the groups that the currnet 3DLine object is a member of.
The same group names should be used in the 3DLineControl.

Shared Memory: What type of shared memory (viz 3 only) can be used in order
to control the lines

Identifier: Shared memory name and general purpose Identifier for this line.
Can be used to control the line or to share a display list data between scenes.
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Advanced

Figure 54: Advanced, 3D Line editor

3DLine Flugin (12.0.0) i
Width | Outline | Effect | Control I Advanced
Cap Edges MNone | Round | Square Iw
Cap Fade Size milﬂ
Wireframe ﬂ
Height Offzet milﬂ
Line Offset milﬂ
Enable World Periodicity l?ﬂ
Update Texture Mapping IW Always | Stationary |
Low Angle Compensation Dizabled | Enabled Im
Debug ﬂ
Min Angle milﬂ
Max Angle ilﬂ
Outline Angle Offset i‘ﬂ
Width Factor (%) [ 4000 SR
Alpha Factor (%) milﬂ
Rebuild
w2

Cap Edges: Sets the line’s cap shape:

- None: The line edges will not change.

- Round: Adds a a filled round shape to the line caps,

- Square: Adds a filled square shape to the line caps,

- Feather: Adds a feather shape to the line caps, An additional parameter will
be enabled when Feather is selectd: Cap Fade Slze.

Wireframe: When enabled (On), the 3DLine object will be drawn as a

wireframe.

Height Offset: Sets the height offset for the 3D Line object on the map (on the

fly).

Line Offset: Sets the line offset for the 3D Line object on the map (on the fly).

Split International Date Line: When enabled (On), a line object that crosses the

date line will continue from the other side of the map. When disabled (Of#, it

will continue across the date line.

Update Texture Mapping: Should the texture coordinates be updated based on

line width. You have the following options; Disabled, Always or Stationary.

Stationary will only update the texture mapping when navigator is moving.

Note: When enabled, symbols are easier to control, but as line width changes the
cause texture changes which might be disturbing.

Low Angle Compensation: Lines become too thin at low camera angles as a
result of the perspective distortion. When that happens, there are not enough
pixels to support a smooth, antialiased line, and the lines look jaggy and
aliased. This mode compensates for that by both widening the lines and
applying transparency when they are viewed at too low angles.

Debug: Enables debug messages in the console.

Min Angle: If the angle between the camera and the ground below the line is
lower than "Min Angle", then line width and transparency will not be changed.
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Max Angle: If the angle between the camera and the ground below the line is
higher than "Max Angle", then the line width is increased by the "Width Factor"
and the transparency is scaled by the "Alpha Factor". If the angle is between
Min Angle and Max Angle then the width and transparency are interpolated.
Outline Angle Offset: For outline width, apply an offset to the angle calculation
in order to make the outlines affected at higher angles than the lines
themselves

Width Factor (%): A factor for modifying line width when applicable.

Alpha Factor (%): A factor for modifying line alpha when applicable.

Rebuild

Rebuild

The Rebuild button triggers the plugin to redraw the lines according to the plugin
parameters. Some parameters are updated as the parameters are changed and do
not require a rebuild command but it is good practice to rebuild the lines after
setting the parameters.

12.5

12.5.1

3D Line Control

3DLineContr

The plugin can be found in the following folders:
Viz Artist 2: Object->Built in.

Viz Artist 3: Built Ins ->Geometry -> Maps-Adv.

The 3DLineControl plugin is used for controlling 3D Line object groups. The
Groups are then controlled in terms of width and color. The groups are derived
from the settings in the 3DLine objects.

This section contains information on the following topics:
Plugin Description

Plugin Description

Figure 55: Control tab, 3DLineControl plugin.
3DLineCaontrol Plugin {10.1.00 (Tt

Cantainer Rl

Caontraol wridth
-

Container: Sets the top container above the controlled 3DLine objects.

Group: Defines the controlled group number. A group is defined in every
3DLine object.
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Figure 56: Width tab, 3DLineControl editor

30LineContral Plugin (10.1.0) (T

Container R

Contral I it idth

iridth Fized { Pixels) I Scaling Fixed { mmm )

width (Kilometers) | s0.0 el
Minimurn Width (Pixels) 0.0001 gl
Maximurn Width (Pixels) ilﬂ
Minirmurn Crraw Width (Pixels) “ilﬂ
Fade Edge (%) milﬂ

Width: Select one of the options to control the line width, Fixed (in pixels or in

mm), or scaling.

- Width: When fixed width is selected (pixels or mm), set the width value.
Fixed width the line will maintain the width value through all camera zoom
range. When Scaling is selected, width is set in actual kilometers and the
line width will be calculated according to the camera zoom.

- Minimum Width (Pixels): Set the minimal value of line width in pixels. this
value will be used if the calculated width according to the width parameter
is smaller than the minimum width value (when zooming far out).

- Maximum Width (Pixels): Set the maximal value of line width in pixels. this
value will be used if the calculated width according to the width parameter
is larger than the maximum width value (when zooming in).

- Minimum Draw Width (Pixels): This value defines the minimal line width

drawn.
- Fade Edge (%): Defines the edge fade width as a percentage of the line
width.
12.6 3D Model
_3DModels
£
i HiE
The plugin can be found in the following folders:
Viz Artist 2: Object —> Built in.
Viz Artist 3: Built Ins -> Geom Plugins -> Maps.
The 3DModels plugin is used for adding 3D models to your graphics scene. As the
models also contain geographical reference you may also place the model on a
map.
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The above 3D model is a model of Mont Saint-Michel located on the north-
western coast of Normandy, France. The model is downloaded from http://
sketchup.google.com/3dwarehouse.
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In the above image the model is placed on a satellite imagery from Digital Globe.

This section contains information on the following topics:
Plugin Description

Working with 3D Models

12.6.1  Plugin Description

File: Allows you to select the file to load. Capable of loading files in Collada
format with the *.dae extension or *.kml/*.kmz extension (which has
geographic information for the model and a link to a *.dae file inside).

Model Optimization: Defines the level of optimization for the model while the
model is loading. More optimization may increase loading time while
improving rendering performance in some models.

Fill Mode: Allows you to select the rendering mode; solid, wireframe or dotted.
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One Size: Allows you to recale the loaded model to a fixed size. Useful in non-
georeferenced mode.

Go To Model: Used in georeferenced mode to take the camera to the model. In
georeferenced mode *.kml or *.kmz files are loaded and the model is placed
on the map in the defined position and size.

Reload: Reloads the model.

Clear Cache: Reloading the same model after the first time is immediate as the
model is cached on the GPU. Use the Clear Cache button to clear the model
from the GPU’s memory.

Info: Prints information about the model to the console.

See Also
Working with 3D Models

12.6.2 Working with 3D Models

This section will give you a quick introduction on how to add a 3D model to your
scene, and also how to place the model on a map or satellite imagery.

To add 3D models to a scene

1. Start Viz Artist
2. Add the 3D models plugin to an empty scene tree
3. Open the 3D models plugin editor and load a KMZ file

To add 3D models to a map
@ dan, '
v Colidel oL
I
LT

o)L .
£ |

Mevgeir s
2=~ B\, cooRef M
L =il % erenceMap

Start Viz Artist

Add the Navigator to an empty scene tree

Add the Atlas plugin to the GeoReferenceMap container

Open the Atlas editor and set it to use Mercator projection

Add a new group as a sub-container of the first container and name it position
Add the World Position plugin to the position group

Add a new group as a sub-container of the position group and name it model
Add the 3D models, Expert and NavFinder plugin to the model group

Open the 3D models plugin editor and load a KMZ file (e.g. Tower Bridge in
London)

10.Click Go To Model

© XN UhAWN =
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- This should bring the model into view

11.0pen the Navigator editor, select Advanced, and then enable(On) the Pan &
Tilt Animation option

12.0pen the 3D models plugin editor again and click Go To Model

13.0pen the transformation editor for the model container

14.0pen the NavFinder editor in order to adjust the distance, pan and tilt of the
map

Tip: Press Shift+CTRL while adjusting the Distance, and Shift while adjusting the Pan
and Tilt.

See Also

Viz Artist documentation for information on the Expert plugin

12.7

114

3D Region

. .
3D0Region

The plugin can be found in the following folders:
Viz Artist 2: Object -> Built in.

Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The 3DRegion plugin is used for applying a graphic design to the selected regions
in the map. The designs are defined in the scene and linked in the CWMClient
plugin, to create the regions received from the maps server.

Figure 57: 3D Region example

.

_—
T,
=

This section contains information on the following topics:
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Plugin Description

12.7.1  Plugin Description

The plugin has four different plugin editor views; General, Region, Sub Regions
and Advanced.
The General parameters editor includes quality and performance parameters.

The Region parameters editor includes the object’s graphic properties.

The Sub Regions parameters editor includes the object’s sub regions graphic
properties. This tab is enabled when the Sub Regions parameter, under the
Advanced tab’s Data settings, is enabled (On).

The Advanced parameters editor defines plugin behavior in special operation
scenarios.

This section contains information on the following topics:
- General

Region
Sub Regions
Advanced

General

Figure 58: General, 3D Region editor

3DRegion Plugin (12.1.0) i
IW Region | Sub Regions | Advanced |
LOD mode Ao | mManual
Polygon Quality IW High | Medium | Low | Lowest
Geo Reference ﬂ
Auto Rescale Off On
Center XY IW Map
Sensible Culling m
Culling Threshold Largest | Large IW Small Smallest
Use Cache m
el

LOD mode: Sets the level of details (LOD). When set to auto, the plugin will

manage the level of details according to the camera distance from the region

object. When set to manual, the level of details will not change when the

camera moves, and will remain fixed. When set to Manual, the Polygon Quality

parameter will be enabled.

Polygon Quality: Sets the quality of the generated region object.

- Highest: Sets the highest level of detail. This option will use more polygons
to build the region object but will have an effect on performance when many
regions are selected.
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- High: Sets a high level of detail.
- Medium: Sets a medium level of detail.
- Low: Sets a low level of detail.

- Lowest: Set the lowest level of detail. This option will enable better
performance when adding a lot of regions, but will look poor when moving
the camera closer to the region objects.

Geo Reference: When enabled (On), references the region object to the map
above 3DRegion container. If disabled (Off), the longitude and latitude
numbers will be transferred to the Viz Artist position X, Y values. The object
can still be geo referenced using for example the Locator Control or World
Position plugins.

Auto Rescale: Can be used when the region is not geographically referenced
(on screen normal) and you want all regions to be the same size (e.g. Isreal
uses the same screen real estate as a map of America) in Viz units.

Center X Y: Defines where the axis of the region object will be placed: if
Region is selected then the axis center will be the middle of the region object.
If Map is selected the axis will be placed in the middle of the reference map.

Sensible Culling: Defines whether to cut off areas that belong to the selected
region but are geographically remote. If set to Off, all marked regions will be
built. Use this feature to improve performance (usually set to On).

Culling Threshold: Defines the level of details displayed in the regions. The
higher the threshold value, the less details will be drawn (that is small islands,
small regions, and so on).

Use Cache: When enabled (On), saves the objects to a cache folder. When
using cache, the generated objects and parameters are saved in a cache folder
and when switching between parameters the regions are not rebuilt, but taken
from the cache (if they exist). If no (Off) cache is used, every change in the
plugin interface will trigger a rebuild of the region objects.

Region

Figure 59: Region fill, 3D Region editor

3DRegion Plugin (12.1.0) 1
General I Region Sub Regions | Advanced
Fill Border
Fill None I Extrude Flat
Include Bottom Off on
Center Z Bottom Center | Top |
Type Absolute Relative
Absolute Height “ilﬂ
Show Terrain off
el

Fill: Fill enables the user to add a region object to the map, and if fill is
applied, how regions are built on the map (either flat on the map (no width) or
extruded).

- None: No region object will be added to the map.
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- Extrude: Regions will be added and extruded over the map. When extrude is
used, additional parameters will be enabled.

- Flat: Adds a flat object (Extrude=0).

Include Bottom: builds the bottom of the region when extruded.

Center Z: Sets the Z axis location of the region object, with relation to the
map: bottom, center or top.

Type: Defines how the Height parameter will be calculated.

- Absolute Height: Defines the regions extrusion height value as Viz units.

- Relative Height: Defines the regions extrusion height value as a percentage
of the regions size.

Show Terrain: Enables 3DRegion to take into account any terrain data for a
selected region. Adjust the Terrain Height Scale parameter (see next). For this
to work you need to enable the Fetch Terrain Data option in the CWM Client.

Terrain Height Scale: Adjusts the terrain height.

Figure 60: Region border, 3D Region editor

3DRegion Plugin (12.1.0) 1
General I Region Sub Regions Advanced
Fill I Border
Borders Off I On
e with B
N B
il

The border parameters define if a border will be drawn around the region objects,
border color, width and the alpha. If the 3D Region object is in Controlled Mode
(On) the border properties parameters will be disabled.

- Borders: Defines if the object will be drawn with a border. When enabled (On),
the border will be drawn and the border properties parameters will be
enabled.

Line Width: Sets the number of GL lines for the border width.
Line Color: Uses the color pallet to set the border color.

Alpha: Sets the alpha value for the border

Note: The color palette is visible in all 3D Region editors but it will only affect the
border color.

Sub Regions

The Sub Regions parameters are identical to the ones described for Regions with
the exception for the terrain setting and parameter.
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Advanced

A common parameter in the Advanced tab is Freeze. This parameter enables the
designer to freeze the region object to Viz data folders (the region is saved as an
image containing the region’s information).

Figure 61: Advanced data, 3D Region editor

3DRegion Plugin (12.1.0) 1

General | Reqgion | Sub Regions | Advanced

Data Election | Alpha | Diraw |

Controlled Mode off

Render Mode OpenGL WIZ
Freeze off

Wireframe off

el

The Data tab defines how data will be processed.
- Sub Regions: Defines if the object will use the sub regions data in the drawn
object. When enabled (On), the sub regions data will be reflected in the
geometry and the Sub Regions tab will display the sub regions parameters.

Controlled Mode: Defines if the 3D Region object will be controlled by a 3D
Region Control plugin in the hierarchy or not.

Render Mode: Defines if the 3D Region object will be rendered by Viz or
directly in OpenGL.

Figure 62: Advanced election, 3D Region editor
3DReagion Plugin (12.1.0) 1

General | Region | Sub Regions | Advanced

Data I Election Alpha | Diraw |

Command I
Selection Data Local Global

Freeze off

Wireframe off

il

The Election tab has one parameter, Command, containing text with region
information used for elections. If Sub Regions is enabled (On), additional
parameters will be enabled.

- Print SubRegion Data: Prints the data in the Viz console.

Save Sub Regions Strings: Saves back the sub regions data to the file.

Save Sub Region: Saves the current specific sub region information back to the
file.

Rebuild: Rebuilds the region objects from the file.
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Figure 63: Advanced alpha, 3D Region editor
3DReagion Plugin (12.1.0) 1

General | Region | Sub Regions | Advanced

Data | Election | Alpha Draw

Freeze ﬂ
Wireframe ﬂ
el

The Alpha tab is an advanced tab used for elections mainly. Alpha tab parameters
will be enabled when the Sub Regions parameter is enabled (On). The parameters
will affect the object only when an Alpha plugin is added to the object and the 3D
Region plugin is in Controlled Mode. These parameters define what part of the
region data will be affected by the alpha plugin.

Draw: Defines what part of the object will be affected by the alpha settings.

- All: Both region and sub regions will be drawn in the object.

- Region: Draws only the region.

- Sub Region: Draws only the sub regions.

- None: Sets region and sub regions to be transparent.

Region Alpha Mode: Defines what part of the data will be affected by the alpha
plugin.

- Region: Affects only the region areas.

- Sub Regions: Affects only sub region areas.

- None: No data will be affected by the alpha plugin.

Border Alpha Mode: Defines what part of the border data will be affected by
the alpha plugin.

- Region: Affects only the region borders.

- Sub Regions: Affects only sub region borders.

- None: No data will be affected by the alpha plugin.

Figure 64: Advanced draw, 3D Region editor

3DRegion Plugin (12.1.0) i

General | Region | Sub Regions | Advanced

Data | Election | Alpha | Draw
International Date Line None United

Border Data M
Border Quality IT High
Freeze ﬂ

Wireframe ﬂ

el

The Draw tab defines advanced parameters for drawing the region objects.

Chapter 12: Geometry Plugins 119



Day Line Mode: Relates to countries that reside on the 180 and -180 longitude
line when using flat maps.

- United: Draws the regions together.

- None: Draws the regions on both sides of the map.

Border Data: Defines the source data of the borders.

- Polygon: Draws borders using polygon data.

- Border: Draws borders using border data (higher memory consumption).
Border Quality: Sets the required border quality.

Wireframe: Draws a wireframe of the object.

Note: The color palette is visible in all 3D Region editors but it will only affect the
border color.

12.8 3D Region Control

ionCTRL

SDR’.eginnCn
The plugin can be found in the following folders:

Viz Artist 2: Object —> Built in.
Viz Artist 3: Built Ins -=> Geom Plugins -> Maps-Adv.
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Figure 65: Region example, 3D Region Control

The 3D Region Control plugin is used to control one or more 3D Region objects
and changing and applying graphic properties to the objects.

Typical use of the 3D Region Control is when producing election graphics where it
is useful to distinguish regions by for example color.

This section contains information on the following topics:
Plugin Description

12.8.1  Plugin Description

Figure 66: Region, 3D Region Control editor

3DRegion Container: Container place holder for the container holding the
region objects.
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Control Mode: Defines the data segment of the object that will be controlled.
Select Region or Sub Region and then select what part of the region/sub-
region to control:

- Region/Fill: Enables control of the region’s properties as defined in the Fill
Mode parameter.

- Region/Border: Enables control of the region’s border properties as defined
in the Borders and Width parameter.

- Sub Region/Fill: Enables control of the sub region’s properties as defined in
the Fill Mode parameter.

- Region/Border: Enables control of the sub region’s border properties as
defined in the Borders and Width parameter.

Fill Mode: Defines the fill of the regions.

- Interpolation (3): Sets three colors that will define the regions color range.
The regions color will be derived from the range of colors and the number
of regions.

- Interpolation (2): Sets two colors that will define the regions color range.
The regions color will be derived from the range of colors and the number
of regions.

- Group: Controls the fill of all the 3DRegion objects under the defined
3DRegions Container (apply the material added to the 3DRegionControl
container).

- Selected Region: Controls the selected regions on the map only.

Apply Sender Matrix: Applies a matrix to the regions. Available options are

None, Multiply, Translate, Scale and Full.

- None: Uses the 3D Region matrix.

+ Multiply: Uses the 3D Region matrix multiplied by the 3D Region Control
matrix.

- Translate: Uses only the translated part (x, y and z position) of the 3D
Region Control matrix.

- Scale: Uses the scale part (x, y and z scaling) of the 3D Region Control
matrix.

+ Full: Uses the 3D Region Control matrix.

Apply On: Applies the sent matrix on all regions or only the selected sub

regions.

Sub Region Borders: Enables control of the sub region borders properties as

defined in the Sub Region Borders parameter.

- All: Controls all borders of the 3DRegion objects under the 3DRegion
Container.

- Selected: Controls the borders of the 3DRegion objects that are the selected
regions in the map.

Width: Defines the border width in pixels.

Note: The color palette is visible in all tabs but it will affect the last selected color
parameter in the UL
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12.9

12.9.1

3D Roads

The plugin can be found in the following folders:
Viz Artist 2: Object -> Built in.

Viz Artist 3: Built Ins -=> Geom Plugins -> Maps.

Figure 67: 3D Roads example

This section contains information on the following topics:
Plugin Description

Plugin Description
The plugin has three different plugin editor views; Data, Width and Outline.

The Data parameters editor defines what type of roads will be drawn by the
selected 3DRoads object. Select one or more types of roads to be displayed, using
the plugin graphic properties.

The Width parameters editor defines the width of the roads drawn by the plugin.

The Outline parameters editor defines the objects outline properties and
behavior.

This section contains information on the following topics:
Data

Width
Qutline
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Data

Figure 68: Data, 3D Roads editor

3DRoads Plugin (12.0.0) i

Data Width | Cutline Advanced

Freeways/Motorways
Primary Roads

Main Roads
Secondary Roads
Other Roads

Major Railways

g888888

Other Railways

2

Freeways/Motorways, Primary, Main, Secondary and Other Roads: When

enabled (On), the plugin will draw roads rated according to the selection in the
loaded roads data.

Major and Other Railways: When enabled (On), the plugin will draw railways
rated according to the selection in the loaded railways data.

Wireframe: Displays the road as wireframe.
Height Offset: Offsets the borders from the map (on the fly).

Width

Figure 69: Fixed width, 3D Roads editor

3DRoads Plugin (12.0.0) i
__ Data__ [ width | oOutine | Advanced |

Width | Fixed ( Pixels) Scaling | Fixed (mm) |

widh o B

Fade Edge (%) [ 00 =l

Height Offset [ 0o =R

J

Width: Selects how the road width will be calculated.

Fixed (Pixels): When set to Fixed the road will maintain a fixed width during

camera zoom movements. Available options are Width (pixels) and Fade Edge
(%).

- Width (Pixels): Sets the width of the roads in number of pixels.
- Fade Edge (%): Sets the percentage of softness applied to the road edges.
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Figure 70: Scaling width, 3D Roads editor

3DRoads Plugin (12.0.0) i
Data I Width Cutline | Advanced |
Width Fixed [ Pixels) I Scaling Fixed { mm )

Width (Meters)

Minimum Width (Pixels)
Maximum Width (Pixels)
Minimum Draw Width (Pixels)
Fade Edge (%:)

Height Offzet

2|

See Me Now

| em ol

Scaling: When set to Scaling the road width will vary according to the camera
zoom movements.

- Width (Meters): Sets the physical road width (in Meters). This value is

translated into drawn pixels according to the camera zoom position and the
size of the map.

- Minimum Width (Pixels): Sets the minimal size that the roads will be drawn.

If the calculated road size in pixels is lower than the minimum width, the
road will not be drawn.

- Maximum Width (Pixels): Sets the maximal size that the roads will be drawn.

If the calculated road size in pixels is higher than the maximum width, the
road width will be set to the maximum width.

- Minimum Draw Width (Pixels): Sets the minimal size that the roads will be

drawn. When zooming into an area, this will be the point where the roads
begin to fade in and be drawn over the map.

- Fade Edge (%): Sets the percentage of softness applied to the road edges.
- See Me Now: Calculates (when width is set to scaling) the width needed for

the line to be visible at a given distance.

Figure 71: Fixed width, 3D Roads editor

3DRoads Plugin (12.0.0)

i

M Cutline | Advanced |
width [ Fixed ( Pixels) Scaling |  Fixed (mm) |
wic 20 O
Fade Edge (%) [ 0o =R
Height Offset milﬂ
ﬂ

Fixed (mm): When set to Fixed (mm) the road will maintain a fixed width
during camera zoom movements. Available options are Width (millimeters)

and Fade Edge (%).

- Width: Sets the width of the roads in number of millimeters.
- Fade Edge (%): Sets the percentage of softness applied to the road edges.
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Outline

Figure 72: Outline, 3D Roads editor

3DRoads Plugin (12.0.0) i
Data | Width | Cutline Advanced
Outline None | Master | Slave I Stand Alone
Outline Width (%) [ 00 =R
Outline Fade (%) milﬂ
Outline Color |— ilﬂ
2

Outline: Selects one of the options for adding outline to the roads. Available
options are None, Master, Slave and Stand Alone.

None: No outline will be added to the roads drawn by the plugin.

Master: Sets the plugin as the master plugin for outline behavior. Other 3D

Roads plugins can be set as clients of this plugin. The same outline attributes

will be applied to roads drawn by the master plugin and by all other slave

plugins. When selected, available additional parameters are Outline Width (%),

Outline Fade (%) and Outline Color.

- Qutline Width (%): Sets the width of the outline, as a percentage of the road
width, where 0% is the road width.

- Qutline Fade (%): Sets the percentage of softness applied to the outline
edges.

- Qutline Color: Sets the color of the outline and the alpha value of the
outline.

Slave: Draws the outline according to the defined outline in the master plugin
above it in the scene hierarchy. All other parameters will be disabled,
displaying the master’s values.

Stand Alone: Defines the outline parameters for the roads drawn by this 3D
Roads plugin only. When selected, available additional parameters are Outline
Width (%), Outline Fade (%) and Outline Color.

- Outline Width (%): Sets the width of the outline, as a percentage of the road
width, where 0% is the road width.

- Qutline Fade (%): Sets the percentage of softness applied to the outline
edges.

- QOutline Color: Sets the color of the outline and the alpha value of the
outline.

Note: The hierarchy structure is important when using the master/slave outline
configuration. The master plugin should always reside as the first container in the
group of 3D Roads containers. An Expert plugin should be added to the map (above
the 3D Roads containers) and Z-Buffer Draw should be set to OFF.

Note: Road data should be loaded (using the CWM Client plugin) before working on
roads design.
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12.10 Atlas

atlas

The plugin can be found in the following folders:
Viz Artist 2: Object —> Built in.

Viz Artist 3: Built Ins -=> Geom Plugins -> Maps.

The Atlas plugin is used for displaying Microsoft satellite imagery. This object
plugin is used with a navigator plugin, enabling interactive navigation to any
location on Earth. The plugin can be used to display imagery for a Navigator
animation (Hops), while creating the required image tiles for a smooth and
complete camera movement. It can also be used with the Globe plugin.

This section contains information on the following topics:
Plugin Description

12.10.1 Plugin Description

The plugin has two plugin editor tabs; General and Advanced.

This section contains information on the following topics:
General

Advanced

General

Figure 73: Atlas plugin General tab

Atlas Plugin (12.1.0) i
General Advanced
Data Source Bing | CMR DG Blom Wms
Digital Globe Projection Mercator Unprojected
Use Basemap Off On
Map Size 1000.0 ﬂ
radeTime I -

Warmupl Clear Cache | Clear Memory Cache | ? |

The General tab is used to define imagery parameters.

- Data Source: Sets the data provider. Available providers are Microsoft Bing,
Vizrt’s CMR (Curious Multi Resolution), DG (Digital Globe), Blom, and WMS
(Web Map Service) geo server.

Data Type: Defines if the Atlas plugin will use data from Bing, DG, Blom or

display data from a CMR file.

- If Bing or Blom is selected, you can choose between satellite imagery, road
and border maps with labels or a combination of the two. If you combine
the two road and border maps with labels they will be imposed over the
satellite imagery.
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- If CMR is selected, set the path to the CMR file. The CMR Data Status field
will indicate if the file was loaded correctly or not.

- If DG is selected you can select between two different projections; Mercator
and Unprojected. Note that this feature requires a separate license.

- If WMS is selected you can connect to a Web Map Service geo server.

Note: Bing, Blom, DG and WMS require an internet connection. Bing and
Blom will not work without a license, DG will, but will show a watermark.

Url: Sets the Url of the WMS geo server. WMS only.

Layer list: Comma-separated list of one or more map layers. Values in list
correspond to the layer <Name> values by the geo server’s Capabilities file.
Layer list is optional if the Styled Layer Descriptor (SLD) parameter is present
in the request. WMS only.

Free text: Used to set optional parameters like transparency and background
color (e.g. TRANSPARENT=TRUE&BGCOLOR=#E98300&). For more information on
how to set optional parameters in the free text field, see the WMS specification

documentation. WMS only.
Version: Request version. Valid values are 1.0.0, 1.1.0, or 1.1.1. WMS only.

Use Base Map: This option is used when working with a base map above the
Atlas container, and the base map is projected. Note that Microsoft Bing
imagery is unprojected, so in order to have the images positioned correctly
over the map set this parameter to On. The same applies if you use the Globe
plugin.

Map Size: Defines the size of the Atlas image.

Fade Time: Defines the duration of the transition between tile resolutions
when zooming in/out of the image.

Warmup (button): Prepares all image tiles for a defined animation. Once tiles
are in the cache folder, the animation will play smoothly.

Advanced

Figure 74: Atlas plugin Advanced tab

Atlas Plugin (12.1.0) i
General I Advanced
Temp Folder SN Tempimapscache\WWC- 12\ At asC e
Mode Serial I Multithreaded

. EBF

Requests per Frame

L

Texture Compression ’T DXTi DXT5 |
Texture Quality ’T Miprmap

Quality Low Normal High
Memory Buffer Size Small Medium IT
Layer Type Opague Transparent

Stop Support Margins ﬂ

Use Proxy ﬂ

Limit Disk Read Time (ms) “ilﬂ

Warmup| Clear Cache | Clear Memory Cache | ? |

The Advaned tab is used for configuring connection and operation parameters.

Temp Folder: Defines a specific cache folder for the retreived imagery.
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Mode: Defines the mode of retreiving the tiles from Microsoft Bing server.
When set to Serial, and new image tiles are required, Atlas plugin will send a
request to the server and wait for a reply. Only after the reply another tile will
be requested, and so on. During the time that the plugin as waiting for a
replay the Ul is locked the user cannot perform other operations. When set to
Multithreaded, the images are requested by a thread of the plugin and the Ul
is not locked.

Requests per Frame: Defines the maximal image requests from the server in a
frame.

Layers: Defines the number of images (with different resolution) per one area.
Texture Compression: Select one of the required compression modes for the
images.

Quality: Defines the quality of the images requested from the server.

Memory Buffer Size: Option to control memory buffer used by Atlas. Useful for
scenes with multiple Atlas plugins.

Layer Type: Selecting a transparent layer type you will be able to maintain
transparency while stacking multiple layers on top of each other. Selecting
opaque you wil consequently block anything below it. WMS layers tend to be
transparent (e.g. power lines or flood area).

Stop Support Margins: When set to ON, additional image tiles surrounding the
displayed area will be retreived, to enable immediate display of high
resolution images when the user moves the image.

Use Proxy: When set to ON, proxy configuration parameters will be enabled.
Use this option when working an a network with proxy:

- IP: Proxy server IP number

- Socket: Proxy socket number

- Username/Password: Sets the username and password.
- Set Proxy: Applies the proxy settings.

Warmup: Prepares all image tiles for a defined animation. Once tiles are in the
cache folder, the animation will play smoothly.

12.11 Curious 3D Terrain

GiDTerrain
P

't

3 DTermain

The plugin can be found in the following folders:
Viz Artist 2: Function -> Shader (button) -> Maps.

Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The C3DTerrain plugin is used for displaying terrain objects. The terrain is
retrieved from the Viz World Server (WoS) when a CWM Client plugin is added to a
C3DTerrain object. When the CWM Client plugin is added to the C3DTerrain
plugin, terrain tessellation parameters will be enabled in the Miscellaneous tab of
the CWM Client plugin.

This section contains information on the following topics:
Plugin Description
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12.11.1
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Plugin Description

The plugin has three different plugin editor views; Terrain, Pyramid and

Advanced.

This section contains information on the following topics:

Terrain
Pyramid
Advanced

Terrain

Figure 75: Terrain, Curious 3D Terrain editor

Height Scale Mode

Freaze Terrain |

C3DTerrain Plugin (10.0.0) T
I Terrain Pyramid Advanced
Terrain Mode | File Image Memory
Terrain File Name R LI ) I

[ Manual Soft | Mormal | Exaggerate | Absolute |

Height Scale “ilﬂl
Sampling Resolution —ilﬂl
Use Base Map !un

Eage Container T |R]| group
oeta 2 o0 O
Terrain Status I Mot Built

Terrain Mode: Defines the data source for the terrain height:

- File: Load height from terrain file (*.c3d).
- Image: Use a Vizimage to create the terrain data.
- Memory: Terrain data may be accessible from three different sources: from

a terrain file on disk (file), from server by using the CWMClient (memory) or
from server using the CWMClient but then saved to the Viz Graphic Hub as
an image (Image).

Terrain File Name: Defines a path to the file to be loaded.

Note: The Terrain File Name parameter will be disabled when a CWM Client plugin
is attached to the Atlas container.

Height Scale Mode: Sets the height scaling option for the terrain:
- Manual: Sets the height scale manually by changing the Height Scale

parameter. When selected, additional parameters will be enabled:

- Height Scale: Sets the scaling value for the terrain elevation. Using a low

value will flatten the terrain surface.

- Soft: Sets the terrain surface to be softened by interpolating points over the

terrain. This option prevents the sharp edges over the terrain surface.

- Normal: Uses the same terrain elevation values received from the server.
- Exaggerate: Applies a large scaling factor to the terrain height differences,

exaggerating the terrain surface.
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- Absolute: The terrain height will not take into account the map size. Setting
Height Scale Mode to Absoulute may therefore be needed for the terrain
tiling, or else the tiles might not connect properly (due to height
differences).

Sampling Resolution: Defines the number of points that will be used to

calculate the terrain. The higher the sampling resolution, the less detail will be

shown. When Pyramid mode is enabled (On), this parameter will be disabled

Globe: When enabled (On), the terrain will be drawn as part of a globe and the

Globe Radius parameter will be enabled.

Globe Radius: Sets the size of the globe used for drawing the terrain.

Note: The Globe and the Globe Radius parameters will be disabled if Use Base Map is
enabled (On).

Use Base Map: Defines the geographical referencing of the terrain. If Use Base
Map is enabled (On), the terrain will move to its geographic location on the
base map, and the Base Container parameter will be enabled.

- Base Container: If empty and Use Base Map is enabled (On), the first map
above the C3Dterrain container in the hierarchy will be used as the base
map. To use a specific map as the base map, drag a map container to the
Base Container place holder. If Use Base Map is disabled (Off, the Globe
parameter will be enabled and the terrain will be drawn as part of a globe.
Set the Globe Radius to modify the terrain size and curve.

Delta Z: Sets the Z axis offset for the terrain (mainly used when using the base

map).

Freeze Terrain: Saves the terrain image and data as Viz images for faster

loading and for archiving.

Pyramid

Figure 76: Pyramid, Curious 3D Terrain editor

C30Terrain Plugin

Terrain | Pywramid ddvanced |
Pyramid on
Max Height : R
3D Levels _% R
Blend textures an
Blend Amount 100.0 % R
Terrain Status 0]4

Febuild Pyramid

A Pyramid in WoC is a set of map textures in different resolutions used for
zooming into a defined area. When the camera is far from the map, a low
resolution map texture is used (covering a wide area). As the camera zooms into
the map, it will zoom into an area with higher resolution texture, until the final
map, with the highest resolution, is used. In order to enable the Atlas’s Pyramid

Chapter 12: Geometry Plugins 131



132

parameters a CWM Client plugin must be attached to its container. Note that this
will disable Atlas’s Terrain File Name parameter. See the Terrain editor view.

Pyramid: This parameter defines if a pyramid of map textures will be created
for the terrain area. When enabled (On) the Max Height and 3D Levels
parameters will be enabled.

- Max Height: Defines the number of textures that will be created.
- 3D Levels: Defines the number of terrain objects that will be created.

Blend Textures: Defines if the edges of the maps will be soft, blending into the
larger map of the pyramid. When enabled (On), the edges will be softened and
the Blend Amount parameter will be enabled.

- Blend Amount: Defines the amount of softness added to the map edges.
Rebuild Pyramid: Builds the pyramid levels.

Note: The parameter Rebuid Pyramid is enabled only if Pyramid is enabled (On) and it
will be visible in all tabs.

Advanced

Figure 77: Advanced, Curious 3D Terrain editor

C3DTerrain Plugin (10.0.0) "
Terrain | Pyramid m

Wireframe a_ﬁl

Sides Smoothing [on

Sides Smoothing Factor mﬂ&]

Uniferm Smoothing a_ﬁ _

Left Smoothing off |

Right Smoothing EI

Top Smoaothing _off|

Bottom Smoothing _off |

Texture Compression IT DXT1 I DXT3 DXTS

Terrain Status | Not Built

Wireframe: Displays the terrain as wireframe.

Sides Smoothing: When enabled (On), the edges of the terrain will be drawn as
flat lines (height is zero). This option is useful when using the terrain object
over the base map. When enabled (On), additional parameters are enabled:

- Sides Smoothing Factor: Defines the width of the area, close to the edges,
that will be interpolated to create the smooth transition from terrain info to
a flat edge.

- Uniform Smoothing: Applies smoothing for all sides. Enabling Uniform
smoothing (On), will set smoothing for all sides, and hide the individual
parameters. Available individual parameters are; Left, Right, Top and
Bottom smoothing.

Texture Compression: Sets the compression level for the texture (DTX5 is the

highest compression level; hence, less texture quality).
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Terrain Status: Displays the terrain object status. If the terrain object was
rebuilt successfully, the indicator will dispaly OK, otherwise, the indicator will
be display Not Rebuilt.

12.12 Flat MR
FlatMR
bJ
il
FlatMR
The plugin can be found in the following folders:
Viz Artist 2: Object -> Built in.
Viz Artist 3: Built Ins -> Geom Plugins -> Maps-Obs.
The FlatMR plugin is used for displaying CMR (Curious Multi Resolution) files over
a flat object. The texture for the terrain is defined in the file or retrieved from the
Microsoft Bing Maps Platform (when licensed).
IMPORTANT! This plugin is included in Viz World Client package for compatibility
reasons, and is not maintained. It is recommended to use the Atlas and other
plugins for designing new scenes.
12.13 Geolmage
Geolmage
o S H'-_

i
e

ey

=
Gealmage

The plugin can be found in the following folders:
Viz Artist 2: Object -> Built in.

Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The Geolmage plugin is used as a base object with maps to enable geographic
referencing options. Geolmage is short for Geographical reference Image.

This section contains information on the following topics:
Plugin Description
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12.13.1 Plugin Description

Figure 78: Geolmage editor
Geolmage Plugin {10.1.00 @

lse Base Map aoff

T Map Size 100.0 ilﬂ

apply Fade Plugin | 7 |

Use Base Map: Defines the geographical referencing of the Geolmage. If Use
Base Map is enabled (On), the Geolmage will move to its geographic location
on the base map and resize accordingly.

- Enabling (On) Use Base Map enables the Base Container parameter.

- Disabling (Offf Use Base Map enables the Map Size parameter.

Map Size: Sets the size of the Geolmage geometry.

Figure 79: Use Base Map, Geolmage editor
Geolmage Plugin (10.1.0% (o

Tesselation “ilﬂ
Use Base Map I?

Base Container tE I|R| Geolmage

Delta Z 0.001 ilﬂ

Crop Mode | Mone Manual Base Map

apply Fade Plugin | 7 |

Base Container: If empty, the first geo-referenced map above the Geolmage
container in the hierarchy will be used as the base map. To use a specific map
as the base map, drag a map container to the Base Container place holder.

Delta Z: Sets a Z offset for the Geolmage geometry.
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Figure 80: Crop Lon/Lat, Geolmage editor

Geolrmage Plugin {10.1.0)

Tesselation

Use Base Map

Base Container

Delta 2
Crop Mode
e st

East

South
Morth

IECH < |

Fon

+G| R| Geolrmage

0.001 gl

Mone I Manual
=17
=R
[ 900 il

o Bl

apply Fade Plugin | 7 |

Base Map

Crop Mode: Defines if the Geolmage will be cropped:

- None: The map will not be cropped.

- Manual: Allows the user to manually set the crop values for the map: West
and East sets the Longitude value for the western and eastern edge of the

Geolmage map. North and South and sets the Latitude value for the
northern and southern edge of the Geolmage map.

- Base Map: Crops the Geolmage according to the base map, that is, if the
Geolmage exceeds the base map edges, it will be cropped accordingly.

Apply Fade Plugin: When clicked, a Fade Texture plugin will be applied to the

container.

12.14 Globe

Globe

o ]

Glaobe

The plugin can be found in the following folders:

Viz Artist 2: Object -> Built in.

Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The Globe plugin is used as a base object, with maps, to enable geographic

referencing options over a globe. The globe object will geographically reference
the map at the correct location over the globe.
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Figure 81: Globe example

This section contains information on the following topics:
Plugin Description

12.14.1 Plugin Description

Tessellation: Defines the number of polygons used to create the Globe
geometry.

Sub Tessellation: This parameter devides each of the Globe flat areas, to
increase texture coordinates and improove the way the teaxyres look on a
globe.

Radius: Defines the radius of the globe.

West: Sets the Longitude value for the western edge of the Globe. The globe
object will be cropped at that Longitude.

East: Sets the Longitude value for the eastern edge of the Globe. The globe
object will be cropped at that Longitude.

South: Sets the Latitude value for the southern edge of the Globe. The globe
object will be cropped at that Latitude.

North: Sets the Latitude value for the northern edge of the Globe. The globe
object will be cropped at that Latitude.

Enable Hole: Saves performance when building pyramids using globe objects.
When the globe objects for the pyramid layers are created, a hole is created
where the higher resolution maps are, to avoid rendering multiple pixel layers
(and to save performance). It can be used manually to create a hole in a globe
object by setting values which are in the area of the map in use. When enabled
(On) additional parameters will be enabled:
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- Hole West (From lon): Defines an inner Longitude in the map area where the
hole will begin (West side).

- Hole East (To lon): Defines an inner Longitude in the map area where the
hole will begin (East side).
- Hole South (From lat): Defines an inner Latitude in the map area where the
hole will begin (South side).

- Hole North (To lat): Defines an inner Latitude in the map area where the hole
will begin (North side).

Figure 82: Globe editor

Globe Plugin (10.1.0)

Tesselation

Sub Tesselation
Radius

e st

East

South

Morth

Enable Hole

Hole west (From lon)
Haole East (Ta lon)
Hole South (From lat)
Hole Marth (To lat)
Crop Globe

Texture Mapping
GeoRef Only

Map Status

3 B
I < |
I < R

EE0 I

Manual I.ﬁ.utu:umatic
.ﬁ.bsu:ulute| Relative | GeoRef

| Map has no GeaRef data

apply Fade Plugin | Face £ Axis |

7]

Crop Globe: Select an option for cropping the globe:

Manual: the globe object will be cropped according to the values set in the

West, East, South and North parameters.

Automatic: the globe object will be cropped according to the geographical
properties of the map applied to the Globe.

Texture Mapping: This parameter defines how the texture (map) will be

mapped over the Globe:
- Absolute: the globe object will be cropped according to the values set in the

West, East, South and North parameters.

- Relative: the globe object will be cropped according to the geographical
properties of the map applied to the Globe.

- GeoRef: The map will be mapped over the globe object according to its

geographical properties.
GeoRef Only: Defines if the Globe is used for geographical referencing only

(not drawn) or as an object (will be drawn).

Chapter 12: Geometry Plugins

137



- If set to Mo, the globe object will be drawn (with the attached map).

- If set to Yes, the globe object will be used for geographic referencing only
and will not be drawn.

- This mode is used when creating globe tiles. The reference map is not used,
since only the tiles are visible. If the reference globe is not drawn, it saves
performance.

Map Status: Reports if the map was loaded as expected (Ok), geographic

referencing of the map, and so on.

Apply Fade Plugin: When clicked, a Fade Texture plugin will be applied to the

container.

Face Z Axis: When clicked, the globe object will rotate and centre facing the Z-

axis. This button can be used when not a full globe is rendered (for example

only Asia). Do not use this feature with the Navigator plugin as it assumes no
rotation.

12.15

138

Pyramid Control

PyramidCtrl
_—
PyramidCon

The plugin can be found in the following folders:
Viz Artist 2: Object -> Built in.

Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The purpose of the Pyramid Control geometry plugin is to sort overlapped layers
of the pyramids in the scene such that tiles with higher resolution will not be
hidden by tiles with lower resolution

This section contains information on the following topics:
Plugin Description
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12.15.1 Plugin Description

Figure 83: Enabled, Pyramid Control editor

FyramidControl Plugin {10.1.00 IE
Color Correction Dizabled | Simple I Adyanced
Histogram Key Cut Made Mane Colar Alpha Calor And Alpha
Pendsr Key Jut Mads Mane Calar Alphz Calor And Alpha

G=a Colar . milﬂ
Key Color Threshold “ﬁﬂ
corcoraos RS

Refrash all Pyramids | ? |

Color Correction: Defines if and how the color correction will be applied to

pyramid layers.

- Disabled: No color correction is applied.

- Simple: An automatic color correction will be applied to pyramid layers.

- Advanced: Color correction will be applied according to user selection

Histogram Key Out Mode: To apply a proper color correction, the histograms

of the tiles should be calculated and the sea areas should be keyed out

(removed) from the calculation. This parameter defines the method to key out

the sea areas during color correction calculations:

- None: Nothing is keyed out

- Color: The keying is based on the key color selected in the Sea Color
control, Key Color Threshold and Key Color Attack parameters.

- Alpha: The keying is based on the alpha channel in the map image

- Color and Alpha: Both of the previous criteria are used during key
calculations.

Note: The sea area defined in the Histogram Key Out Mode is not removed from the
map image during rendering. It is only removed for color correction calculations.

- Render Key Out Mode: This parameter defines the method to key out the
sea areas from rendering. Modes are the same as in Histogram Key Out
Mode.

Sea Color: Sets the color of the sea usedfor keying and color correction

calculations.

Note: The alpha value in this case has no effect (it is only a standard property of the
color component).

Key Color Threshold: The range of colors around the selected Sea Color that

will be keyed out. threshold of the keying. The color values in the range

[Color_value - Threshold_value, Color_value + Threshold_value] will be keyed

out

Key Color Attack: This parameter defines the blending range of the key edges.

The heigher the Attack value is, the softer the key edge will be.

Refresh All Pyramids: Apply the new settings to all pyramid layers.
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12.16 Region Halo

- !

__o”

RegionHalo

The plugin can be found in the following folders:
Viz Artist 2: Object —> Built in.

Viz Artist 3: Built Ins -=> Geom Plugins -> Maps.
v =. Region-Designs
|
v =. Region
e
v =. . WE GeoReferenceMap
|
v =. Region-Holder
|
L
| o
o

The RegionHalo plugin is used to create a halo around 3D Region objects. The
plugin is used in the region design hierarchy with the 3D Region plugin. The
plugin and the 3D Region objects are placed under a group called ‘region’, while
the RegionHalo object is above the 3D Region object.

This section contains information on the following topics:
Plugin Description
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12.16.1 Plugin Description

Figure 84: RegionHalo editor, Simple

RegionHalo Plugin

(T

Relative Width

Refresh

Simple Advanced
[ <00 =2l

There are two Ul modes: simple and advanced. Simple displays the most common
parameters for manipulating the region’s halo. Advanced displays all parameters

for manipulating the region’s halo.

Relative Width: Defines the halo wid

Figure 85: RegionHalo editor, Advanced

RegionHalo Plugin

th, relative to the region object’s size.

(T

Relative Width
Stencil

Stencil Channel
Wireframe

Mumber Of Biggest Polygons To Show

Refresh

Simple I Adwvanced
| <00 2l
off |
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off]
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Stencil: Defines if the defined mask

channel will be used when drawing the

halo (ON), or if no masking will be used (OFF). When using a channel, the halo
shape will follow the object’s shape more accurately.

Stencil Channel: Defines which of the mask channels will be used for the halo

(Scene Settings->Global Settings).

WARNING! Default value is channel 6 (inverted), since Viz uses channels 7 and 8 for

shadows. This parameter is used in a scene
masks, and the mask channels may collide.

which makes intense use of object
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Wireframe: Draws a wireframe of the halo (for debug purposes).

Number of Biggest Polygons To Show: Defines the number of regoin areas that
the halo will be applied to. If the selected region consists of islands, then this
value will define which island and the number of islands that the halo will

apply to.

Refresh: Redraws the halo when changing the parameter values.
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12.17 Shadow Agent
A
Shadowigen
The plugin can be found in the following folders:
Viz Artist 2: Object —> Built in.
Viz Artist 3: Built Ins -=> Geom Plugins -> Maps.
Shadow Agent is an agent for the Shadows parameters covered by the scene
plugin Label Manager.
This section contains information on the following topics:
Plugin Description
12.17.1 Plugin Description
Figure 86: Shadow Agent editor
Shadowsgent Plugin (10.1.0) @
Render with Carmera all Label | Map | Shadaow |
Render With Camera - this parameter defines for which camera shadows will
apply:
All - shadows will be rendered on all cameras (Compatible with previous
versions).
Label - shadows are rendered only for the defined off screen labels camera.
Map - shadows are rendered only for the defined map camera.
Shadow - shadows are rendered only for the defined shadows camera, as
defined in the 3DLabelsManager plugin (Shadows tab).
12.18 Street Labels
StreetLabels
- _‘
L
X“&
The plugin can be found in the following folders:
Viz Artist 2: Object -> Built in.
Viz Artist 3: Built Ins -> Geom Plugins -> Maps.
The Street Labels plugin can be used for drawing street labels. Until now the
solution was to use Viz objects to draw street labels where the main drawback
was the number of labels required. Using Viz objects you are limited to 300 to
500 containers before Viz no longer is able to render in real time.
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The Street Labels plugin draws the street labels by itself and by doing so it can
holds over 100.000 labels.

Since it is not an object designed in Viz Artist the only freedom you have is the
font used and relative position and scale, the Street Labels plugin will only work
for Navigator scenes.

To enable the use of the plugin (as opposed to designing your own street labels)
you need to set under Label Manager’s Auto Labels tab the level of Road Labels to
be shown. The Road Labels option defines the level (number) of road labels that

will be displayed (zero (0) means no labels). You also need to set the label style to
be Internal (Open GL).

This section contains information on the following topics:
Plugin Description

12.18.1 Plugin Description

Figure 87: Street Labels editor
StreetLabels Plugin 1
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Debug Level [0 1|2|3]4]|5s]

Font: Defines the font used for drawing the labels.

Width: Defines the width of the label in relation to the width of the street.
Position: Defines the position of the label in relation to the center of the street.
Min Pixel drawing size: Defines the minimum number of pixels used to draw
the labels. If the number of pixels is smaller than the current labels (based on
parameters above and the width of the street) the label will not be drawn. The
number must be smaller than the maximum width numbers in the 3D Roads
plugin design.

Alpha Fade time: Defines the number of frames used to fade in or out when
label’s status changes.

Render: If controlled is enabled the plugin will draw the streets that belongs to
the 3D Roads plugin above it, if standalone is enabled the next seven (7)
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settings will apply (i.e. Primary Roads, Main Roads, Secondary Roads, Other
Roads, Major Railways and Other Railways).

Minimal size for same street name: Distance in screen percent for shown the
same street name twice.

Direction: Defines the direction of the label. Options are Left to Right (LTR) or
Right to Left (RTL)(not complex script).
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13 Container Plugins

The Viz World Client (WoC) installation includes a package of plugins used for
enhancing the geographic referencing ability in Viz Artist. The WoC plugins
includes geometry, container, shader and scene plugins.

This chapter describes all container plugins. The container plugins are found in
seven plugin folders:

Maps: Contains Standard plugins.
Maps-Adv: Contains Advanced plugins.

Maps-Lab: Contains experimental plugins. Since these plugins are
experimental they are not documented and supported.

Maps—-Man: Contains a set of Manager plugins used for batch creation of 3D
Objects such as regions, borders, and so on.

Maps-Obs: Contains Obsolete plugins, installed only for backward
compatibility. These plugins should not be used when designing new scenes.

Tools: Contains Tools plugins.
Weather: Containers Weather plugins.

See the following sections for more information:

Standard

3D Map Telestrator
Center Map

CWM Client

Focus On Map

Geo Text

Hop Sync

Label It

Locator Control
Map Layers

Map Layers Control
Map Pyramid

Map Tiler

NavFade

NavFinder
Navigator

NavScale

Place Finder

Trace It

World Position

Advanced

Label AddOn
NavCom
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NavSlave
Publish To Design

Manager

3D Border Manager
3D Line Manager
3D Region Manager
3D Road Manager
Hops Manager

KML Reader

Obsolete

Globe Zoom
Screen Scale

Tools
Mute

Weather
World Image Refresh

See Also

Geometry Plugins
Shader Plugins
Scene Plugins

13.1 3D Border Manager
3

N

Z0BorderMa

The plugin can be found in the following folders:
Viz Artist 2: Function -> Maps-Man.

Viz Artist 3: Built Ins —>Function-> Maps-Man.
The 3DBorderManager plugin is used for creating 3D Border objects based on
shape files. The plugin uses a 3D Border design to create borders according to the
defined settings.

This section contains information on the following topics:
Plugin Description
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13.1.1 Pl

ugin Description

Figure 88: Target set to Container, 3D Border Manager editor

3DBorderManager Plugin T

Design |
Target Me: | MNext [ Down I Container

Target Container

Shape File

Simplify Threshold (Deg/10,000)
Persistent Data Disabled | Enabled

Border Type __Country Region | Sub Region | Coasthne Adwvs
Border's Column

Browse...

Country ID

Region ID

Sub Region ID

Coastline 1D

Clear And Build | Clear Target Tree |

Design: Sets the 3D Border design container that is used for building lines.
The design container should be built with a 3D Border object and a material.
No special naming convention is required.

Target: Defines the container to be used as the parent container for the border

containers:

- Me: The 3D Border objects will be built under the current container (holding
the 3D Border Manager plugin).

- Next: The 3D Border Objects will be built under the next container (next
container in the tree and at the same level as the 3D Border Manager
container).

- Down: The 3D Border objects will be built under the first child container.

- Container: The 3D Border objects will be built under the container dragged
into the 7arget container place holder.

Target Container: Specifies the container that will hold all the 3DBorder

objects.

Shape File: Defines a path to the shape file (*.shp), containing the border

definitions. Shape files are bought from vendors specialized in Geographic

Information System (GIS) and holds the actual shape data; polygons, splines,

and others. Note that shape files must be stored in individual folders.

Simplify Threshold: Sets the detail reduction factor for the shape borders.

Persistent Data: Defines if the data will be removed from Viz memory when the

scene is closed or not. When enabled references are kept, and load time is

quicker.

Border Type: Defines which border type will be associated with the created

objects. If Advanced is selected, additional parameters will be enabled

allowing the configuration of border type according to the data associated
with the shape file.

- Border’s Type: Specifies the column name that holds each border type.
Country ID, Region ID, Sub Region ID and Coastline ID: Specifies the string
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in the database file (*.dbf) that matches to each type (e.g. Country, Region
and so on).

Clear and Build: Removes all child objects of the target container and re-
builds the obejcts, using the plugin settings.

Clear Target Tree: Removes all child objects of the target container.

13.2

13.2.1

148

3D Line Manager

LineMgr

30LineMana

The plugin can be found in the following folders:
Viz Artist 2: Function -> Maps-Man.

Viz Artist 3: Built Ins ->Function-> Maps-Man.

The 3DLineManager plugin is used for controlling and creating 3D Line objects.
The plugin uses a 3D Line design to create lines according to the defined settings.
The plugin allows you to build 3D Line in four different modes: Navigator,
Command, from WME and from a Shape file.

This section contains information on the following topics:
Plugin Description

Plugin Description

Design: Sets the 3DLine design container that is used for building lines. The
design container should be built with a 3D Line object and a material. No
special naming convention is required.

Target: Defines the container to be used as the parent container for the line

containers:

- Me: The 3D Line objects will be built under the current container (holding
the 3D Line Manager plugin).

- Next: The 3D Line Objects will be built under the next container (next
container in the tree and at the same level as the 3D Line Manager
container).

- Down: The 3D Line objects will be built under the first child container.

- Container: The 3D Line objects will be built under the container dragged
into the 7arget container place holder.
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Figure 89: Target set to Container, 3D Line Manager editor

3DLineManager Flugin (11.0.0) v
Design R| Shape-Line-Desigr
Target Me Mext | Down | Container |
Data Source Mavigator | Command | WME Labels Shape File
Spline Off Control Points | Curve Points | Controlled |
Set Navigator Hops Off On
Exclude Hops MNone I First Last | FirstiLast | Manual Shift |
Set Hops Height Off I On
o i o O
[

Data Source: Defines the source from which the 3D Line objects will be
created:

- Navigator: A 3D Line object will be created using the hop locations defined
in the Navigator plugin. The line will start at the first hop location and end
at the last hop location.

Note: When using the Navigator as the data source, the 3D Line Manager should
reside under the Navigator container.

- Command: The 3DLine object will be created from a list of Long/Lat pairs
defined by the user.

- WME labels: Allows you to build a line between locations chosen in Viz
World Map Editor (WME) as WME labels (no line will be built if WME labels are
not defined). Also, the WME source container must be specified and refresh
should be applied by clicking the Refresh button in CWMClient (Rebuild
button is disabled in this mode). The line between the labels starts and ends
in the order they where added (as seen in WME’s Map Details list). The first
label location is the label at the top of the list, and and the last is at the
bottom of the list. Rearrange the list to create a new order.

- Shape file: Uses a shape file as data source.

Note: In WME Labels option, the 3DLineManager should be attached to the CWM
Client plugin container. The Labels in the CWMClient plugin must be enabled.

Spline: Enables you to convert a line to a smooth curve in different modes:
- Off: no curve, straight line chunks between data points.

- Control Points: line is represented as smooth curve that passes between
data points.

- Curve Points: line is represented as smooth curve that passes through data
points.

- Controlled: same as Control Points, but smoothness (i.e. distance of the line
from original points) can be controlled.

Set Navigator Hops: Enables the scene to do a hop animation between the
labels.
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- The animation can be altered by using the Trace It plugin by setting and
enabling a different Trace Camera, Lock Pan, Lock Tilt and Lock Distance
mode/parameter (e.g. creating a flyby/flyover animation).

- In this case the Trace It plugin is added as a sub container of the
Default Design container (defines the 3D line’s default design) which is
resides under the Map Start (M-S) container. Once changes are made you
simply republish the design (see Publish To Design plugin).

Exclude Hops: Excludes the hop animation for the following labels; None,
First, Last or First&Last. Manual Shift allows you to define which destination
that should be your starting point (limited to a selection of 30 destinations).

Set Hops Height: Allows you to disable or enable the Hops Height setting.
Hops Height: Enables you to define the height of the hops in Viz units.

13.3 3D Map Telestrator

Telestrator
L. s |

‘k.

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps

Viz Artist 3: Built Ins -> Container Plugins -> Maps

3D Map Telestrator plugin enables you to draw strokes on maps (including
globes) and arbitrary flat objects using screen input interface like mouse or "touch
screen". The strokes, whether with geo or non-geo coordinates may be passed to
other scenes on distant computers through the mechanism of shared memory.

3D Map Telestrator uses 3D Line for strokes visualization and thus it benefits
from the rich design capabilities of this plugin.

The obtained strokes may be smoothed to an arbitrary degree to obtain better
looking final result of the drawing.

This section contains information on the following topics:

Plugin Description

Creating a 3D Map Telestrator Scene
Non Geo-Reference Telestration
Shared Memory Mechanism

Using Multitouch Interface

Using Perceptive Pixel Interface
Brush Design Using 3D Line

See Also

3D Map Telestrator Design
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13.3.1  Plugin Description

Figure 90: 3D Map Telestrator, General

3DMapTelestrator Plugin i

| General Shape Recognition

Line Pixel Resolution _i‘ﬂ

Designs Holder R

Design Name default_design

Target Me Mext | Crown | Container |
Active . of |  Aways on'p'

Spline Off | Control Points | Curve Foints IW
Smoothness Low Medium High

Close Stroke ﬂ

Control Mode Off On

Shared Memory M Distributed

Shared Memory Name

Input Interface [ Mouse 5DOF | PPI | multitouch
Animation Control ,T Auto Start

Clear | Ll | Fancies | ? |

Camera: Defines working camera to accept screen input (which is useful in a
scene with layers where more than one camera is used).

Line Pixel Resolution: Defines the required resolution of line during drawing,
such that for example if resolution of 5 is set strokes less than five pixel size
will be disregarded.

Designs Holder: Container beneath which the required design will be
searched.

Design Name: A couple of designs may be implemented in the scene and here
the desired one for current use will be set. If the required design does not
exist, the first one found will be used.

Target: Defines where to build line strokes. If the Container option is used the
desired container should be specified in "Target Container" section.

Active: Defines when the plugin will be active. It may be switched off, active
always or only be activated while pressing 'p' button on the keyboard. This is
useful when other interactive capabilities are used in the scene (for example
interactive navigation) and a care should be taken in order not to interfere
these modes.

Spline: By choosing one of these options the final result will be smoothed for
more pleasant look. The three spline types define three different methods for
smoothing.

- Control Points: Uses a spline that paths between the points of the original
curve. This will result in the smooth nice curve but may be not accurate
enough since the line doesn't actually path through original route but may
deviate from it.

- Curve Points: Makes the spline path through points of interest of the
original curves, but this method may also result in some artifacts causing
the route to deform between points of interest, and that is due to a
constraint that curve must be smooth.

- Combined: Is a kind of compromise between Control and Curve points (see
Examples)
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Smoothness: If spline is used in order to obtain smoothed result the
smoothness defines the threshold for such operation. The higher the
threshold the softer the curve will be (see the examples at the end of this
section).

Close Stroke: If enabled strokes will be automatically closed.

Control mode: While enabled evokes a shared memory mechanism to send
and receive strokes to and from other 3D Map Telestrator plugins.

Shared Memory: defines type of shared memory:

- Global: Shared within the region of computer.

- Scene: Shared within the region of current scene only.

- Distributed: Shared between all the scenes and computers in the network.

Shared Memory Name: Defines the name for connection, such that only
3DMapTelestrators with the same name will share data between them.

Input Interface: Selects interface type for line creation. See further remarks
about "PPI" and "Multitouch" use.

Animation Control: When enabled runs animation that is located on design
container after line is created (mouse button released).

Clear/Undo/Redo: Enables you to undo and redo last strokes or clear the
whole drawing instead.

Figure 91: 3D Map Telestrator, General

3DMapTelestrator Plugin i
General I Shape Recognition
Recognize Ellipse Nane Try | Try Harder |
Recognize Square Nane Try | Try Harder |
Recognize Triangle Nane Try | Try Harder |
Recognize Line Nane Try | Try Harder |
Clear | Linrien | LN | 7 |

Recognize Ellips, Square, Triangle and Line: Recognizes four shapes: ellipse
(including circle), square, triangle and line. When the plugin recognizes a
shape it rebuilds it to be of ideal shape (i.e. a hand-drawn circle will be
replaced by a perfect circle of the same size). The Try Harder option means
that there will be more probability to recognize the requested shape (for
example the circle may be less ideal and still be recognized) running the risk
that it might replace shapes that are not e.g. circles. When Try Harder is
enabled only one shape can be recognized as opposed to the Try option which
enables the plugin to recognize multiple shapes simultaneously.
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Examples

Figure 92: Original curves

Figure 95: Combined
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Figure 96: Influence of the smoothness parameter set to original, low, medium and high

2
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13.3.2 Creating a 3D Map Telestrator Scene

To create a 3D map telestrator scene

b4 %W LineDesigns
] S BS -
Bl 5 S
v %HE ; %Eﬁi‘: GeoReferenceMap

1. Prepare a blank workspace for the new scene, go to Geom Plugins —> Maps
and drag an Atlas plugin to the scene
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2. Open the Atlas plugin’s editor, and in under Data Source switch to CMR
(Curious Multi Resolution), and in the CMR File locator locate the CMR with the
desired map

- This will create a map to draw on

- If you have an Internet connection and license for Microsoft Bing maps you
will see the world map as soon as you drop Atlas and there will be no need
to load CMR

3. Go to Container Plugins —> Maps and drop the Navigator plugin onto the same
container as the Atlas plugin

- Remember to enable interactivity by pressing the E button (to the left of the
scene editor).

- Now navigation through the map is possible by pressing i button and using
mouse. If the map suddenly disappeared after dropping Navigator plugin
just click the Center Map button on the bottom of it.

Add a container above the one just prepared and name it LineDesigns

Add a new container as a child of LineDesigns and name it Red

Add the 3D Line plugin to the Red container

Open the 3D Line plugin’s editor and set the Width parameter to Fixed (Pixels)
Set the Width’s sliding parameter to 4

Switch to the Outline option on the topmost radio button row and set Outline
to On and give it a width of 50 (Outline Width (%) parameter)

10.Add material to the container and make it to be red color. This will create the
first design for the line.

© ® NV A

11.Add another container beneath the Red container and name it Green
12.Add the 3D Line plugin to the Green container
13.0pen the 3D Line plugin’s editor and set the Width parameter to Fixed (Pixels)
14.Add a material with a green color to the container
- This defines the second design for the line named "Green".

15.Add a new container as a child of the Atlas container and name it Telestrator
and add the 3D Map Telestrator plugin to it

16.0pen the 3D Map Telestrator plugin’s editor and drag the LineDesigns
container onto the Designs Holder placeholder

17.Set the Design Name parameter to Red (in order to choose red design)
18.Set the Active parameter to the On 'P position

19.Set Shared Memory parameter to Distributed

20.Save the scene
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13.3.3

13.3.4
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Now you should be able to draw on the map by pressing the P key on the
keyboard and while holding the left mouse button down. Moreover, if you open
the same scene on another computer in the network you should see the same
drawings appearing on it too.

Non Geo-Reference Telestration

In the procedure on how To create a 3D map telestrator scene the drawing was
done on the map, i.e. the path has geographic coordinates and as such it will be
placed on the same geographical route when it will be sent to other computers (by
using the Shared Memory Mechanism). The other map in the other scene may
have different style and projection. It may also have globe geometry, and the path
will still be geographically correct.

However, there is an option to use 3D Map Telestrator without map and
geographic coordinates. In order to use this option two conditions must be met:

The plugin must not be located under geo-reference (in the example scene
the Atlas was used as geo-reference), and

The flat geometry about to be drawn on must be placed on the same container
with 3D Map Telestrator plugin.

Shared Memory Mechanism

Shared Memory Global I Scene Distributed |

Shared Memory Name A

As explained in the 3D Map Telestrator Plugin Description section the plugin uses
a shared memory mechanism in order to send and receive strokes to and from
other 3D Map Telestrator plugins. In order for two plugins to interconnect they
should have the same name for the shared memory data they are "listening" to. It
must be mentioned that the given name will have a prefix of "Telestrator ",
such that when a user enters the name "alpha" for the group of 3D Map
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13.3.5

13.3.6
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Telestrator plugins, the actual name of the shared memory parameter will be:
"Telestrator alpha'.

The format of data consists of a unique id that each stroke receives, name of
required design and data path that comes as a sequence of pairs of numbers
representing longitude and latitude (when non-geo-reference mode is used the
flat geometry's bounding box is treated as if having the lat/lon coordinates of full
world). All components of the data including design name and unique id are
separated by commas.

Using Multitouch Interface

This interface uses touch screen of Multitouch type. In order for the plugin to
receive information from the screen the Input Interface button should be switched
to Multitouch mode and a container with the plugin should contain a geometry.
Screen touches outside of this geometry will be disregarded. So, if the plugin is
used in a non-georeference mode there is no problem since it already contains
geometry you are drawing on. If it is used in a georeference mode the best
practice would be to place the 3D Map Telestrator plugin on the container with
the map.

See Also

Using Perceptive Pixel Interface

Using Perceptive Pixel Interface

In a case of using a Perceptive Pixel Interface (PPI) screen the setup requires a
couple of additional things to be done. A special plugin named Mt2dControl, that
is a part of the PPI plugin package, will accept and process the inputs from the
touch screen and the processed data will be sent to the 3D Map Telestrator plugin
through a shared memory mechanism.

Continuing the procedure above on how To create a 3D map telestrator scene,

you can add multi-touch capabilities to your graphics scene. Hence, the below
procedure and example scene tree expands the aforementioned procedure.
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1. Open the 3D Map Telestrator plugin editor and set Input Interface to PPl (see
Plugin Description) and chose a name for a shared memory connection with
the PPl interface (i.e. a PPl variable name). Note that this must differ from
shared memory connections with other 3D Map Telestrator plugins

Add the container somewhere in the scene which will not be a part of any
hierarchy

Add a rectangle to the container and scale it to the maximum possible size
Add a Mute plugin on the container in order to avoid rendering it

Add a Multi-touch 2D control (Mt2dControl) plugin on the container

Open the Mt2dControl plugin editor and set the following parameters:

- Lock Rotation to On

- Lock Scale to On

- Shared Memory to On

- Shared Memory Type to Scene

- Shared Memory Prefix should be the same as the PPl variable name in the
3DMapTelestrator plugin

- Hit Coordinate Type to World

N
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7. Save the scene
- Now you should be able to draw lines by touching the screen

See Also

Using Multitouch Interface

13.3.7 Brush Design Using 3D Line

The 3D Line plugin is used by the 3D Map Telestrator to visualize the strokes. The
desired look of the line is set by various parameters in the design (inside the 3D
Line plugin) and it is therefore important to understand these parameters in order
to get the desired look and behavior for the line.

The following are the most important parameters:
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Width

The options for the Width tab defines the width behavior of the line. Three options
may be used to define width behavior:
Fixed (pixels): Defines constant width of line measured in pixels

- Scaling: line width may vary according to zoom and the minimum-
maximum parameters could be set

- Fixed (mm): Sets a fixed width in geographic units

- Fade Edge (%): Applies a fade effect to the side-edges

Outline

By using these options an outline of arbitrary width, fade amount and color can be
set to a line.

Effect

Note that by default when a line comes to a 3D Map Telestrator plugin it plays an
animation running from single point to a full path. The attributes of such an
animation can be set beneath this tab. The length of animation in time is
controlled by the Animation Length parameter and if it is set to '0' no animation
will be played at all. Moreover, a nice fade effect to a running edge of the line
could be set by the Fade parameter.

Advanced

A couple of options are available for this tab, the most important of which are:
- Cap edges: Defines shape for the beginning and end edge of the curve

Height Offset: Defines an offset line from surface it is put on

Update Texture Mapping: Note that a texture may be applied to a line. During
zooms, line width is updated according to the setting we made in Width tab,
while line length remains unchanged, thus texture mapped on the line may
deform. In order to keep same aspect ratio for the texture this option must be
enabled.

13.4
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3D Map Telestrator Design

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps-Adv

Viz Artist 3: Built Ins —> Container Plugins -> Maps-Adv

3D Map Telestrator Design plugin controls 3D Map Telestrator options through
design setup. When this plugin is added to the design its setup is imposed on the
3D Map Telestrator (i.e. parameters set in 3D Map Telestrator Design plugin will
override parameters set for the 3D Map Telestrator), and thus it is possible to
control spline type and smoothness, close option and shape recognition setup
from a design persepective.
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This section contains information on the following topics:

Plugin Description

See Also

3D Map Telestrator

Creating a 3D Map Telestrator Scene
Non Geo-Reference Telestration
Shared Memory Mechanism

Using Multitouch Interface

Using Perceptive Pixel Interface
Brush Design Using 3D Line

13.4.1  Plugin Description
Figure 97: 3D Map Telestrator Design
3DMapTelestratorDesign Plugin i

Spline | Control Points | Curve Points w

Smoothness —,W High

Close Stroke ﬂ

Recognize Ellipse M Try Harder

Recognize Square M Try Harder

Recognize Triangle M Try Harder

Recognize Line M Try Harder
Smoothness: If spline is used in order to obtain smooth results the
smoothness defines the threshold for such an operation. The higher the
threshold the softer the curve will be (see the examples at the 3D Map
Telestrator’s Plugin Description).
Close Stroke: If enabled strokes will be automatically closed.
Recognize Ellips, Square, Triangle and Line: Recognizes four shapes: ellipse
(including circle), square, triangle and line. When the plugin recognizes a
shape it rebuilds it to be of ideal shape (i.e. a hand-drawn circle will be
replaced by a perfect circle of the same size). The Try Harder option means
that there will be more probability to recognize the requested shape (for
example the circle may be less ideal and still be recognized) running the risk
that it might replace shapes that are not e.g. circles. When Try Harder is
enabled only one shape can be recognized as opposed to the Try option which
enables the plugin to recognize multiple shapes simultaneously.

13.5 3D Region Manager

g
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The plugin can be found in the following folders:

Viz Artist 2: Function -> Container (button) -> Maps-Man.
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13.5.1
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Viz Artist 3: Built Ins -> Container Plugins -> Maps-Man.

The 3DRegionManager plugin is used to create sub regions of a selected region
on the map, using a 3D Region design. The plugin receives the region name and
gets all the sub regions of that region from the server or a shape file. The 3D
Region design is duplicated for each sub region and displayed on the map.

Figure 98: Regions and sub regions, 3D Region Manager

This section contains information on the following topics:
Plugin Description

Plugin Description

Figure 99: Target set to Me, 3D Region Manager editor

3DRegionManager Plugin m
Target | Me MNext Down Container
Build Region Local Selection Shape File | Command Region Id |
Border Visible Filter Country Region Nome
Scan Selected Recursive
Select Region |
Clear And Build | Add To Existing |  Clear Targat Tree |

Design: Sets the region design container that is used for building sub -

regions. The design container should be built with a 3D Region object and a

material. No special naming convention is required.

Target: Defines the container to be used as the parent container for the sub

regions containers:

- Me: Builds the 3DRegion objects under the current container (holding the
3DRegionManager plugin).

- Next: Builds the 3DRegion objects under the next container (next container
in the tree and at the same level as the 3D Region Manager container).

- Down: Builds the 3DRegion objects under the first child container.

- Container: Builds the 3DRegion objects under the container dragged into
the “Target” container place holder.
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Figure 100: Target set to Container, 3D Region Manager editor

3DRegionManager Plugin El

Design ]
Target Me | Mext Down I Containar
Targat L]
Build Region Local Salection Shape File | Command | Region Id
Border Visible Filter Country Region | None
Scan Selected Recursive

Select Ragion |

Clear And Build ] Add To Existing | Clear Target Tree |

Build Region: Defines the source for which the 3DRegion objects will be
created.

- Local: Builds the 3DRegion objects for the container that the 3D Region
Manager is applied to. The container must be a 3D Region object for the sub
regions to be built for the defined region.

- Selection: Builds the sub-regions or regions for selected regions. Press the
Select Region button to select the regions to be built.

Border Visible Filter: Sets which borders should be cropped to map. Any
border lower or equal to the selection will be cropped to the map. Available
options are Country, Region and None.

Scan: Defines what regions to display.

- Selected: Displays only the selected regions, selected by pressing the Select
Region button.

- Recursive: Displays all selected regions and their sub regions.

Select Region: Opens the Viz World Map Editor (WME), enabling the selection
of regions to be used in Selection mode.

Figure 101: Shaped Regions set to Merge, 3D Region Manager editor

3DRegionManager Plugin El
Design Rl
Target | Mea Meaxt Downi Container

Build Region Local I Selection I Shape File = Command I Region Id
Shape Regions | Merge Spiit Advanced |

Shape Fila Jplugin/data/maps/

Preapare Cache Files |

Clear And Build ] Add To Existing | Clear Target Tree |

Shape Regions: Defines how the regions will be built. Available options are
Merge, Split and Advanced.

- Merge: Creates all regions in the file as one object.

- Split: Creates all regions in the file as separate objects.

Shape File: Defines a path to the shape file (*.shp), containing the region
definitions. Shape files are bought from vendors specialized in Geographic
Information System (GIS) and holds the actual shape data; polygons, splines,
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and others for the container that the 3D Region Manager is applied to. The
container must be a 3D Region object for the sub regions to be built for the
defined region. Note that shape files must be stored in individual folders.

Figure 102: Shaped Regions set to Advanced, 3D Region Manager editor

3DRegionManager Plugin El
Design @Mghn
Target IT Mext [ Down I Container I
Build Region Local | Selection Im Command I Region Id
Shape Regions Me || spiit [ Advanced
Shape File Hrnrwse...l

C:
Converson i I -

Parent Id Column
Parent Mame Column u
MWames' Column

Preapare Cache Files |

Clear And Build | Add To Existing | Clear Target Tree |

- Advanced: Enables the additional parameters Conversion File, State Column
and Name Column. Conversion File defines a file for converting regions
indexes into region names (*.txt file). Parent Id Column, Parent Name
Column and Names Column refer to columns in the database (*.dbf) file that
comes with the shape file. The database files describes what is attached on
the shape file. Note that database files can be opened with Microsoft Office
Excel.

Shape File: Defines a path to the shape file (*.shp), containing the region
definitions. Shape files are bought from vendors specialized in Geographic
Information System (GIS) and holds the actual shape data; polygons, splines,
and others. Note that shape files must be stored in individual folders.
Prepare Cache Files: Instead of building large amounts of regions from a
shape file (which may overload the system), pre-creation of the cache files and

then building the required regions only (directly from the cache files) will
minimize the memory usage.
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Figure 103: Build Region set to Command, 3D Region Manager editor
ADRagionManager Plugin T

Design
Target Me MNext | Down Container I
Build Region Lo-cal | Selection | Shape File I Command Region Id

Clear And Build | Add To Existing | Clear Target Tree I

Command: Builds a 3DRegion object from the specified command. The
command defines the region coordinates using pairs of longitude and latitude
values. The command format is as follows:

<3DRegionContainerName>: Longl,Latl Long2,Lat2...

Figure 104: Build Region set to Region Id, 3D Region Manager editor

3DRegionManager Plugin El
Design El
Target | Me MNext | Down | Container |

Build Region Local | Selection | Shape File | Command m
Shape Fila Jplugin/data/maps/ Browse...
Region 14 I

Clear And Build ] Add To Existing | Clear Target Tree |

Region ID: Enables the user to show a specific region by region ID after having
prepared the chache files.

- Region Id: Sets the region’s ID for the required region.

Clear and Build: Deletes all previously built objects and rebuilds the regions
according to the current settings.

Add To Existing: Builds the new objects without deleting the old 3D Region
objects from the hierarchy.

Clear Target Tree: Removes all objects built by the plugin from the Viz scene
hierarchy.

13.6

3D Road Manager

3 rllg

B

Z0BorderMa

The plugin can be found in the following folders:

Viz Artist 2: Function -> Maps-Man.
Viz Artist 3: Built Ins —>Function-> Maps-Man.
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13.6.1

166

The 3DRoadManager plugin is used for creating 3D Roads objects. The plugin
uses a shape file design to create roads according to the defined settings.

This section contains information on the following topics:

Plugin Description

Plugin Description

Roads Mode: Applies one set of road design for all roads (Global), or uses a
design per CWMClient (Design).

Design: Sets the doards design container that is usd for building border data
from a shape file. The design container should be built with a 3DBorder object
and a material. No special naming convention is required.

Target: Defines the container to be used as the parent container for the road
designes. Me builds the 3DRoads objects under the current container (holding
the 3DRoads Manager plugin). Next builds the 3DRoads objects under the
next container (next container in the tree and at the same level as the
3DBorderManager container). Down builds the 3DRoads objects under the first
child container. Container builds the 3DRoads objects under the container
dragged into the 7arget container place holder.

Target Container: Specifies the container that will hold all the 3DBorder
objects.

Source: Select street/road source. Available options are; Viz World Map Editor
(WME) using the CWM client plugin to connnect to the map server, or from a
shape file that contains street data.

- Select Streets: Opens Viz World Map Editor (WME).

Shape File: Defines a path to the shape file (*.shp), containing the border
definitions. Shape files are bought from vendors specialized in Geographic
Information System (GIS) and holds the actual shape data; polygons, splines,
and others. Note that shape files must be stored in individual folders.

- Sort Roads By: Sets the loaded roads from the shape file in a category.

- Category enables the user to select one predefined category of street data.
Available Road Types are Freeways, Primary, Main, Secondary and Other.

- Advanced splits the data into different categories using specific string
types. Road Type Column specifies a column name that holds each road
category. Freeways/Motorways, Primary Roads, Main Roads, Secondary
Roads and Other Roads specify what string in the database file (*.dbf) that
matches the road type.

Simplify Threshold: Sets the detail reduction factor for the shape of the roads.

Persistent Roads: Defines if the roads data is removed from Viz memory when
the scene is closed or not.

Sort Roads By: Defines which road type will be associated to the created
objects. If Advanced is selected, additional parameters will be enabled
allowing the configuration of road types according to the data associated to
the shape file.
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Figure 105: Category, 3D Road Manager editor
3DRoadeManager Plugin

Roads Mode Global I Design

Dasign Rl

Target Me | mext | Down Container

Target Contamner gl

Persistent Roads Disabled Enablad
Source CWM Shape File
Shape Fila Jplugin/data/maps/

smpiity Threshold (Meters)  [EIIES<
Sort Roads By Catagory Advanc&dl

Road Type Freeways I Primary Main |$ecundary| Other I

Rebuild All | Clean Al

- Category: Enables the selection of road types. Available options are:
Freeways, Primary Main, Secondary, Other.

Figure 106: Category, 3D Road Manager editor

3DRoadsManager Plugin EI

Roads Mode _Glcnba[ I Design
Design B.I
Target I Me | Next | Down m
Target Container ﬂ
Persistent Roads _Disahled [ Enabled
Source WM Shape File
Shape File Browse... |
Simplify Threshold (Meters)
Sort Roads By
Road Type Column

Freeways/Motorways

Pnmary Roads

Mainm Roads

Secondary Roads

Other Roads

Rebuild AIII Clean AJ||

- Advanced: Sets parameters according to the data in the files associated with
the shape file. Defines the road type column and the specific road type Id in
the file.

- Rebuild All: Rebuilds all data. If Roads mode is set to Design, 3DRoads objects
will be created from design. If Roads mdoe is set to Global, global 3DRoads
renderers will render built data.

- Clean All: Cleans 7arget container from sub containers.
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13.7

13.7.1

168

Curious 3D Terrain

CiDTerrain
T

4
!

Fis
i

3 DTermain

The plugin can be found in the following folders:
Viz Artist 2: Function -> Shader (button) -> Maps.

Viz Artist 3: Built Ins -=> Geom Plugins -> Maps.

The C3DTerrain plugin is used for displaying terrain objects. The terrain is
retrieved from the Viz World Server (WoS) when a CWM Client plugin is added to a
C3DTerrain object. When the CWM Client plugin is added to the C3DTerrain
plugin, terrain tessellation parameters will be enabled in the Miscellaneous tab of
the CWM Client plugin.

This section contains information on the following topics:
Plugin Description

Plugin Description

The plugin has three different plugin editor views; Terrain, Pyramid and
Advanced.

This section contains information on the following topics:
Terrain

Pyramid
Advanced

Terrain

Figure 107: Terrain, Curious 3D Terrain editor

C3DTerrain Plugin (10.0.0) A
I Terrain Pyramid Advanced
Terrain Mode | File Image Memory
Terrain File Name _I
Height Scale Mode mél_ Soft | Normal [ Exaggerate | Absolute |
Height Scale

Sampling Resolution B

Use Base Map n

[on
Base Container @ |
Detta 2 o001 Sl

Terrain Status I Not: Built
Freaze Terrain |

Terrain Mode: Defines the data source for the terrain height:
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- File: Load height from terrain file (*.c3d).

- Image: Use a Vizimage to create the terrain data.

- Memory: Terrain data may be accessible from three different sources: from
a terrain file on disk (file), from server by using the CWMClient (memory) or
from server using the CWMClient but then saved to the Viz Graphic Hub as
an image (Image).

Terrain File Name: Defines a path to the file to be loaded.

Note: The Terrain File Name parameter will be disabled when a CWM Client plugin
is attached to the Atlas container.

Height Scale Mode: Sets the height scaling option for the terrain:

- Manual: Sets the height scale manually by changing the Height Scale
parameter. When selected, additional parameters will be enabled:

- Height Scale: Sets the scaling value for the terrain elevation. Using a low
value will flatten the terrain surface.

- Soft: Sets the terrain surface to be softened by interpolating points over the
terrain. This option prevents the sharp edges over the terrain surface.

- Normal: Uses the same terrain elevation values received from the server.

- Exaggerate: Applies a large scaling factor to the terrain height differences,
exaggerating the terrain surface.

- Absolute: The terrain height will not take into account the map size. Setting
Height Scale Mode to Absoulute may therefore be needed for the terrain
tiling, or else the tiles might not connect properly (due to height
differences).

Sampling Resolution: Defines the number of points that will be used to

calculate the terrain. The higher the sampling resolution, the less detail will be

shown. When Pyramid mode is enabled (On), this parameter will be disabled

Globe: When enabled (On), the terrain will be drawn as part of a globe and the

Globe Radius parameter will be enabled.

Globe Radius: Sets the size of the globe used for drawing the terrain.

Note: The Globe and the Globe Radius parameters will be disabled if Use Base Map is
enabled (On).

Use Base Map: Defines the geographical referencing of the terrain. If Use Base

Map is enabled (On), the terrain will move to its geographic location on the

base map, and the Base Container parameter will be enabled.

- Base Container: If empty and Use Base Map is enabled (On), the first map
above the C3Dterrain container in the hierarchy will be used as the base
map. To use a specific map as the base map, drag a map container to the
Base Container place holder. If Use Base Map is disabled (Off, the Globe
parameter will be enabled and the terrain will be drawn as part of a globe.
Set the Globe Radius to modify the terrain size and curve.

Delta Z: Sets the Z axis offset for the terrain (mainly used when using the base

map).

Freeze Terrain: Saves the terrain image and data as Viz images for faster

loading and for archiving.
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Pyramid

Figure 108: Pyramid, Curious 3D Terrain editor

C30Terrain Plugin

Terrain | Pyramid Advanced |
Pyramid on
Max Height : R
a0 Levels _% R
Blend textures on
Blend Amount 100.0 % R
Terrain Status 4

Febuild Pyramid

A Pyramid in WoC is a set of map textures in different resolutions used for
zooming into a defined area. When the camera is far from the map, a low
resolution map texture is used (covering a wide area). As the camera zooms into
the map, it will zoom into an area with higher resolution texture, until the final
map, with the highest resolution, is used. In order to enable the Atlas’s Pyramid
parameters a CWM Client plugin must be attached to its container. Note that this
will disable Atlas’s Terrain File Name parameter. See the Terrain editor view.

Pyramid: This parameter defines if a pyramid of map textures will be created
for the terrain area. When enabled (On) the Max Height and 3D Levels
parameters will be enabled.

- Max Height: Defines the number of textures that will be created.

- 3D Levels: Defines the number of terrain objects that will be created.

Blend Textures: Defines if the edges of the maps will be soft, blending into the

larger map of the pyramid. When enabled (On), the edges will be softened and
the Blend Amount parameter will be enabled.

- Blend Amount: Defines the amount of softness added to the map edges.
Rebuild Pyramid: Builds the pyramid levels.

Note: The parameter Rebuid Pyramid is enabled only if Pyramid is enabled (On) and it
will be visible in all tabs.
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Advanced

Figure 109: Advanced, Curious 3D Terrain editor

C3DTerrain Plugin (10.0.0) "
Terrain | Pyramid | Advanced

Wireframe al’fl

Sides Smoothing | on

Sides Smoothing Factor ﬂﬁj

Uniform Smoothing off |

Left Sroothing off |

Right Smoothing al’fl

Top Smoothing off |

Bottom Smoothing off |

Texture Compression I None DXT1 I DXT3 DXTS

Terrain Status m

Wireframe: Displays the terrain as wireframe.

Sides Smoothing: When enabled (On), the edges of the terrain will be drawn as

flat lines (height is zero). This option is useful when using the terrain object

over the base map. When enabled (On), additional parameters are enabled:

- Sides Smoothing Factor: Defines the width of the area, close to the edges,
that will be interpolated to create the smooth transition from terrain info to
a flat edge.

- Uniform Smoothing: Applies smoothing for all sides. Enabling Uniform
smoothing (On), will set smoothing for all sides, and hide the individual
parameters. Available individual parameters are; Left, Right, Top and
Bottom smoothing.

Texture Compression: Sets the compression level for the texture (DTX5 is the
highest compression level; hence, less texture quality).

Terrain Status: Displays the terrain object status. If the terrain object was
rebuilt successfully, the indicator will dispaly OK, otherwise, the indicator will
be display Not Rebuilt.

Center Map

en‘terl'u'lap
The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps.

Viz Artist 3: Built Ins —> Container Plugins -> Maps.

The Center Map plugin is used, with map objects, for keeping a point on the map
in the center of the map object. The map is moved while the defined point
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remains centered. With a Flat map, the map is moved, but with a Globe map the
globe is rotated. See also Map Tiler for more information on Flat and Globe maps.

This section contains information on the following topics:
Plugin Description

13.8.1  Plugin Description

Figure 110: User, Center Map editor
CenterMap Plugin

Position I Usar WPaosition [ Mavigator WPaint Map

wop onter Loiuce [T
o -

Map Center Latitude il

Local Scale =R F

] I~

Position: Defines how the map will be centered:

- User: Enables the user to manually define a center point by setting Map
Center Longitude and Map Center Latitude values.

Figure 111: WPosition, Center Map editor
CenterMap Plugn

Position Usear I WPosition Mavigator WPoint Map
Remote Container 5]

Local Scale 005 el

-, =

WPosition: Centers the map at the location of a WPosition container dragged
into the Remote Container place holder.

- Navigator: Centers the map at the location of a Mavigator container dragged
into the Remote Container place holder.

- WPoint: Centers the map at the location of a WPoint container dragged into
the Remote Container place holder.

- Map: Centers the map at the center of a dragged map into the Remote
Container map.

Local Scale: Sets the scale parameter for the map.
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13.9 CWM Client

CWMClient

CWmMClient

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps.

Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The CWMClient plugin is the main plugin in Viz World Client (WoC). The
CWMClient plugin launches the Viz World Map Editor (WME) and retrieves the map
from the Viz World Server (WoS) after the user applied the changes to the map in
WME.

Note: The plugin uses the VizMapsManager.dl/ to connect to the Viz World Server
machine configured in Viz Config page.

This section contains information on the following topics:
Plugin Description

13.9.1  Plugin Description

The CWM Client plugin has five different plugin editor views; Texture, Labels, 3D
Objects, Miscellaneous and CMR. In addition it has two default buttons that
applles to the plugin as a whole.
Viz World Map Editor (WME): Opens the WME. WME connects to Viz World
Server that is defined in Viz Config, and retrieves the current map or opens the
defined default project if no map exists (fresh plugin instance).

Refresh Map: Re-draws the map and refreshes the related Viz objects using
Viz World Client (WoC)plugins in the scene hierarchy. For example if a label
design has been changed in Viz Artist, clicking Refresh Map will redraw the
map with the new label design without opening WME.

Refresh Map (Force New): Re-creates the map on the server and saves it to the
cache. This operation will force the map creation, even if the map exists in the
cache folder.

This section contains information on the following topics:
- Texture

Labels

3D Objects
Miscellaneous
CMR
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Texture

Figure 112: Texture, CWM Client editor

cwMClient Plugin (11.0.0) o

Viz World Map Editor{WME) | Refresh Map | Refresh Map (Force New) |

Texture Labels | 30 Objects | Mizcellaneous | CMR |

Lock Aspect Ratio l?
Texture Size [ Manual  sp4:3 | sSpie:s | HD720 | HD1oao |
Texture Width | s Sl
Texture Height m% R

Texture Compression [ mNone  pxmt | pxtz | pxis |

Texture Quality M

2

The texture section defines the geo map image parameters:

Lock Aspect Ratio: Effects texture height and texture width parameters. When
enabled (On) any change in the texture height or width will affect both
parameters. When disabled (Offj, each parameter is controlled separately.

- Texture Size: Presets for texture sizes.

- Auto Adjust To Globe - If texture size is other than manual, this parameter
defines if the texture size will be modified when mapped on a globe. This
option is used when displaying maps that are close to Earth’s poles.

- Texture Width: Defines the number of pixels in the map width. When aspect
ratio is locked, changing the texture width will automatically change the
Texture Height parameter.

- Texture Height: Defines the number of pixels in the map height. When

aspect ratio is locked, changing the texture width will automatically change
the Texture Width parameter.

Texture Compression: Sets the compression level for the texture (DTX5 is the
highest compression level, i.e. less texture quality).

Texture Quality: If set to Linear it will use the same image resolution in the
entire zoom range, or when set to Mipmap it will change resolution according
to the distance from the image (managed automatically in Viz Artist).
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Labels

Figure 113: Image labels, CWM Client editor

cwMClient Plugin (11.0.0) o

Viz World Map Editor{WME) | Refresh Map | Refresh Map (Force New) |

Texture I Labels 30 Objects | Mizcellaneous CMR |
3D Designs & Holder Disabled Local | Global |

2|

3D Designs & Holder: Defines the labels usage and behavior over the map, and
has three available options; Image, Viz and Compatibility.

- Disabled: Labels produced by the Viz World Server will be displayed as part
of the map texture.

- Local: Requires you to manually define the 3D Designs & Holder path (e.qg.
On Map Designs: Vizrt/VizCuriousMapsClient /MapBuilder/Regions/)

- Global: Enables you to use a global design defined by the 3D Map Setting
scene plugin.

IMPORTANT! Global labels will not work with on screen labels so you will still need to
configure them (if needed).

Figure 114: Viz Labels, CWM Client editor

CwmClient Plugin (11.0.0) (e

iz World Map Editor{WME) | Refresh Map | Refresh Map (Force New) |

Texture I Labels 3D Objects | Miscellaneous CMR |

3D Designs & Holder M Global

Create Labels IW All

Allow New Line (Backslash) lw Enabled

Labels Type IW Static
IW Scene

On-Map Designs

I

On-Screen Designs |
|
Rl

On-Map Holder

On-Screen Holder

2|

Create Labels: Select A//to build all labels defined in WoC. Select Visib/e to
build only labels that are shown on the selected map.

Labels Type: Defines the source of the label designs. Available options are

Dynamic and Scene. Selecting Viz-DB or Scene defines where the label designs

are stored.

- Dynamic: Dynamically creates new labels based on label designs created in
the scene itself or fetched from the Viz Graphic Hub (Viz DB). All designs are
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referenced by the On-Map Designs placeholder. When selecting labels in the
Viz World Map Editor (WME) all your labels will be dynamically added
underneath the CWMClient’s container and receive the correct label type
(provided it is defined by your label design). Note that this approach does
not allow you to use control plugins. As the number of labels are dynamic
this approach does not allow you to use control plugins.

- Static: Unlike the Dynamic label type, Static will not create new labels
underneath the CWMClient’s container, but will instead use the number of
labels already defined by the designer (achieved by by adding copies of the
label designs as sub containers of the CWMClient’s container). As the
number of labels and label types are static this approach allows you to use
control plugins.

- Viz-DB: Label source is a merged object from the Viz objects library,
containing the label designs.

- Scene: Label source is a group container in the scene hierarchy, containing
the label designs.

On Map Designs: Defines the source of the labels that are displayed on the

map. When Viz DB (Viz Graphic Hub) is selected, define the path to a merged

object, containing the label designs, in Viz object library. When Scene is
selected, drag a group container with the label designs to the container place
holder.

On Screen Designs: Defines the source of the labels that are displayed on a

plane in front of the screen. When Viz DB is selected, define the path to a

merged object, containing the label designs, in Viz object library. When Scene

is selected, drag a group container with the label designs to the container
place holder.

On Map Holder: This parameter is a container used for grouping all the

generated labels on the map. When a map with labels is selected, the plugin

will duplicate the label designs and create the labels. The duplicated labels will
be placed under the On Map Holder container.

On Screen Holder: This parameter is a container used for grouping all the on

screen labels (labels that are not geo-referenced) used in the map. When a

map with on screen labels is used and Viz is selected, the on screen label

designs will be copied to the holder container and the label information will be
sent to the copied designs.

3D Objects

The 3D Objects section defines 3D properties of objects on the map, other than
labels (regions, roads and so on).
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Figure 115: 3D Objects and Regions, CWM Client editor

CWMClient Plugin {10.2.0% T
Wiz World Map Editor{ WME] | Refrash Map | Refresh Map (Force Maw) | |
Texture | Labels | 3D ohjects  Miscellaneous | CHA |
[ Regions Borders | Shapes | Roads | Advanced |
5D Designs & Halder Dizabled I Loca Glabal
Viz-DB I Scene
On Map Designs @' ﬂ Reqion-Dasigns
On Screen Designs ﬂ
On Map Holder @' ﬂ Region-Holdar
On Screen Holder &
2 |

3D Designs & Holder: Defines if the regions will be part of the received texture
or 3D objects. When set to Disabled, regions will be displayed as part of the
texture. When set to Loca/the Viz-DB and Scene parameters are made
available. When set to Global, the global region designs and holder will be
used to create the O Map 3D region objects. On Screen parameters will be
enabled to define the on screen region designs and holder.

Source: Sets the source for region designs. Available options are Viz-DB and
Scene.

- Viz-DB: Sets region source to be a merged object from the Viz objects
library, containing the region designs.

- Scene: Sets region source to be a group container in the scene hierarchy,
containing the region designs.

On Map Designs: Defines the source of the 3D Region objects that are

displayed on the map. When Viz DB is selected, define the path to a merged

object, containing the region designs, in Viz object library. When Scene is

selected, drag a group container with the region designs to the container

place holder.

On Screen Designs: Defines the source of the 3D Region objects that are
displayed on a plane in front of the screen. When Viz DBis selected, define the
path to a merged object, containing the region designs, in Viz object library.
When Scene is selected, drag a group container with the region designs to the
container place holder.

On Map Holder: This parameter is a container used for grouping all the
generated 3DRegion objects on the map. When a map with regions is selected,
the plugin will duplicate the region designs and create the 3D Region objects.
The duplicated regions will be placed under the On Map Holder container.

On Screen Holder: This parameter is a container used for grouping all the on
screen regions (regions that are not geo-referenced) used in the map. When a
map with on screen regions is used and Vizis selected, the on screen region
designs will be copied to the holder container and the region information will
be sent to the copied designs.
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Figure 116: 3D Objects and Borders, CWM Client editor

CWMClient Plugin (10,2.00 AT

Wiz Warld Map Editor{#ME) | Refresh Map | Refresh Map (Force New) |

on Map Designs

Cn Map Holder RI

j

Testure | Lahels | 30 Thymcks Mimellanc-:lus| CHR |
Regions I Borders Shapas | Foads | Advanced |

30 Designs & Holder Cisabled I Local Global
Vizible Filter Country | Region None
| Viz-DB Scens

Map 3D Borders: Defines if the border line will be part of the received texture
or drawn as a 3D object. When set to Disabled, borders will be displayed as
part of the map texture. When set to Loca/the Viz-DB and Scene parameters
are made available and the shapes added in the WME will be drawn as a 3D
object by Viz. When set to Global, the global border designs and holder will
be used to create the 3D border objects.

Visible Filter: set the filter level for border details. If None is selected, all
border data is drawn. If Region is selected, Sub Region data will not be drawn.
If Country is selected, region and sub-region borders will not be drawn.

Source: Sets the source for the border designs.

- Viz-DB: Sets the border source to be a merged object from Viz objects
library, containing the border designs.
- Scene: Sets the border source to be a group container in the scene
hierarchy, containing the border designs.
On Map Designs: Defines the source of the 3D Line objects that are displayed
on the map. When Viz DB is selected, define the path to a merged object,
containing the border designs, in Viz object library. When Scene is selected,
drag a group container with the border designs to the container place holder.
On Map Holder: This parameter is a container used for grouping all the
generated 3DBorder objects on the map. When a map with borders is selected,
the plugin will duplicate the border designs and create the 3D Line objects.
The duplicated borders will be placed under the On Map Holder container.
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Figure 117: 3D Objects and Shapes, CWM Client editor
CWMClient Plugin (10,2.0) i

Wiz Warld Map Editor(¥ME) | Refrazh Map | Refresh Map (Force Mew) |
Texture | Lahels | 30 Objects | Miscallaneaus | MR, |
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|

Map 3D Shapes: Defines if the shapes will be part of the received texture or
drawn as a 3D object. When set to Disabl/ed, shapes will be displayed as part of
the map texture. When set to £nabled the Viz-DB and Scene parameters are
made available and the shapes added in the WME will be drawn as a 3D object
by Viz.When set to Global, the global shape designs and holder will be used
to create the 3D shape objects.

Source: Sets the source for the shape designs.

- Viz-DB: Sets the shape source to be a merged object from Viz objects
library, containing the shape designs.

- Scene: Sets the shape source to be a group container in the scene hierarchy,
containing the shape designs.

On Map Line Designs: Enables the user to add vector line data to the map.

Either by using the draw option in the WME (Add Shape), or from selecting an

existing line data (e.g. street).

On Map Area Designs: Vector area designs. This option has support for the

area draw option in the WME.

On Map Designs: Defines the source of the 3D Region objects that are

displayed on the map. When Viz DB is selected, define the path to a merged

object, containing the shape designs, in Viz object library. When Sceneis

selected, drag a group container with the shape designs to the container place

holder.

On Map Holder: This parameter is a container used for grouping all the

generated 3DShape objects on the map. When a map with shapes is selected,

the plugin will duplicate the shape designs and create the 3D Region objects.

The duplicated shapes will be placed under the On Map Holder container.
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Figure 118: 3D Objects and Roads, CWM Client editor
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3D Roads: Defines if the road data will be drawn on the map and the way the

roads will be drawn. Available options are None, Crop To Map and All.

- None: The roads data will not be available to be drawn on the map.

- Crop To Map: Enables the Visibility Filter and Visibility Factor (%) settings,
limiting the roads data.

- All: Loads the selected road data.

- Labels Only: only the road labels will be drawn.

Visibility Filter: Sets the highest level of road type that will be cropped.

Available options are Freeway, Primary, Main, Secondary and Other.

- Freeway: Crops all roads rated as freeways and lower (that is all roads) using
the Visibility Factor.

- Primary: Crops all roads rated as primary roads and lower (that is primary,
main, secondary and other) using the Visibility Factor.

- Main: Crops all roads rated as main roads and lower (that is main, secondary
and other) using the Visibility Factor.

- Secondary: Crops all roads rated as secondary roads and lower (that is
secondary and other) using the Visibility Factor.

- Other: Crops all roads rated as other roads (that is none of the above) using
the Visibility Factor.

Visibility Factor (%): Defines the cropping area of the roads on the map. 100%

means the roads will be cropped at the map edges and cover the entire map

area. A lower value will cause the selected road types in the Visibility Filter to

be cropped (evenly from the map edges).

Simplify Threshold (Meters): Applies a simplifying algorithm on road data. The

number represents the buggest allowed error.

Ignore Filter: Disables creation of roads that are lower or equal to the

selection.

Roads Mode: Applies one set of road design for all roads (Global), or uses a

design per CWMClient (Design).

Source: Sets the source for road designs. Available options are Viz-DB and

Scene.

- Viz-DB: Sets road source to be a merged object from Viz objects library,
containing the road designs.
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- Scene: Sets road source to be a group container in the scene hierarchy,
containing the road designs.

On-Map Designs: Defines the source of the 3D Roads objects that are

displayed on the map. When Viz-DB s selected, define the path to a merged

object, containing the road designs, in Viz object library. When Sceneis

selected, drag a group container with the road designs to the container place

holder.

On-Screen Designs: Defines the source of the 3D Roads objects that are
displayed on a plane in front of the screen. When Viz-DB s selected, define
the path to a merged object, containing the road designs, in Viz object library.
When Sceneis selected, drag a group container with the road designs to the
container place holder.

On Map Holder: This parameter is a container used for grouping all the
generated 3D Roads objects on the map. When a map with roads is selected,
the plugin will duplicate the road designs and create the 3D Roads objects.
The duplicated roads will be placed under the On Map Holder container.

On Screen Holder: This parameter is a container used for grouping all the on
screen roads (roads that are not geo-referenced) used in the map. When a
map with on screen roads is used and Viz-DB is selected, the on screen road
designs will be copied to the holder container and the road information will be
sent to the copied designs.

Figure 119: 3D Objects and Advanced, CWM Client editor
CWHChent Plugin (10,1.0% @

Wiz Curious Maps Editar {ZME) | Refresh Map | Refrash Map (Farce New) |

Texture | Labels I a0 Objecks Mizcellaneous | CHR
Ragions | Bordars | Shapes | Roads I Advancad

Create Regions Wisible All

Sort Regions Mo | azcanding m

Copy Map To Region | Mo Yes

Auto Borders IT Highest | Intermediate Lowesk

2|

'\-\.I |

Create Regions: Defines if all the selected regions will be created (when using

3D regions) or only the regions that are visible on the selected map.

Sort Regions: Defines how the labels and 3D Objects will be duplicated in the

scene tree.

- No: Creates the duplicated labels and 3D objects in the scene tree grouped
by geographic levels that is for each country, first the country, then the
regions, then the sub regions, and so on.

- Ascending: Creates the duplicated labels and 3D objects created in the
scene tree sorted by ascending geographic levels, that is first the sub
regions, then the regions, then the country container.

- Descending: Creates the duplicated labels and 3D objects in the scene tree
sorted by descending geographic levels, that is first the sub regions, then
the regions, then the country container.

Copy Map To Region: Sets if a map of the region will be applied to the 3D

Region object.
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Auto Borders: Defines if borders will be added automatically to the map and
the level of the borders:

- Off: No borders will be added.

- Highest: Draws country borders for the selected area (or region borders if
only a region was selected).

- Intermediate: Draws region borders (or sub-regions if only a region was
selected).

- Lowest: Draws sub-region borders.
Miscellaneous

Figure 120: Miscellaneous, CWM Client editor.
CWHChent Plugin (10.,1.0%
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The Miscellaneous section includes additional general parameters of the map.
WME Aspect- Defines the aspect of the map in the WME window:

- Image: When enabled, the aspect is set by the texture size defined in the
texture screen of the CWM Client plugin.

- User: When enabled, the user can manually set the aspect. When selected,
the Aspect parameter will be enabled. The aspect is modified by changing
the aspect value.

- Camera: Sets the aspect to be the same as the current camera in use.
Selecting this option will therefore open the WME in the same aspect as the
current camera.

- Auto: When enabled, the plugin will look for a Navigator plugin in the
hierarchy, above the CWM Client plugin. If a Navigator is found the camera
aspect will be used. If the Navigator plugin was not found, the image aspect
will be used.
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Figure 121: Freeze enabled for Miscellaneous, CWM Client editor.
CWMChent Plugin
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Freeze: When enabled (On), the map retrieved from the server will be saved as
an image in the Viz image library and used as a static geo-referenced image.
All map dynamic parameters will be hidden.

Trio Mode: When set to Off, the plugin will request the map from the server or
cache when the scene is loading. If Trio mode is set ON, the scene will load
without requesting a map since Viz Trio (or other external application) will
send the parameters for a map to use. This option saves time during
initialization of scenes using a dynamic map.

Is Linked: When the Is Linked parameter is set, a CWMClient (slave) is

controlled by another CWMClient (master). To control another CWMClient,

drag and drop a container with a CWMClient (slave) plugin onto the CWMClient

(master) plugins’ Linked Map placeholder (see next parameter).

Linked Map: When set, this parameter is a container placeholder that defines

the map that will be linked to the current map. The linked map is another CWM

Client container that will receive the same map as the map selected from the

WME.

Linked Map Size: Defines the size of the linked map as a percentage from the

main map, that is if 50% is defined the linked map will show half of the area

defined in the main map.

Terrain Tessellation Locked: Appears when a C3DTerrain plugin is combined

with the CWMClient plugin.

- Tessellation is the terrain resolution, which is the number of polygons used
to build the terrain object. The higher the tessellation, the more detailed the
terrain will be. Use the Width Tessellation and Height Tessellation
parameters to fine tune the quality versus the performance of the scene.

- When set to On, only the Width Tessellation parameter can be changed;
hence, the setting will apply for both Width and Height.

- When set to Off, the parameters can be set individually.
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Figure 122: CMR, CWM Client editor.
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The CMR (Curious Multi Resolution) section includes Curious Maps Terrain
configuration options.

Use CMR: Defines if the map will be generated from a CMR file or from the
server. When enabled (On) additional parameters are made available, and the
Viz World Map Editor (WME) button is disabled.

CMR: Defines a CMR file to be used as a source for the map.

Lon: Sets the map longitude.

Lat: Sets the map Latitude.

Width (deg): Sets the area width in degrees, kilometers, miles or nautical
miles.

Status: Displays the current CMR operation status.

Get CMR: Retrieves the defined CMR data (of the area defined by Lon, Lat and
Width parameters).

Center Longitude Latitude: When clicked, the CMR will be created with the
longitude and latitude values as the center of the CMR.

Note: The longitude and latitude values must be within the CMR area. If the values
are not within the CMR area no map will be created.

13.10 Focus On Map

FocusCnMa

The plugin can be found in the following folders:

184 Chapter 13: Container Plugins



13.10.1

Viz Artist 2: Function -> Container (button) -> Maps-Adv.
Viz Artist 3: Built Ins -> Container Plugins -> Maps-Adv.

The FocusOnMap plugin is used to create a single “hop” (high resolution map over
a large referencing map) without using a navigator plugin and with no animation.
This plugin is used when creating a large map (reference map) with 3DObjects
over it (roads, shapes, and so on). It enables the user to display a high resolution
area of the large map without recreating the 3DObjects when changing the
displayed area.

This section contains information on the following topics:
Plugin Description

Plugin Description

The FocusOnMap plugin has three different tabs; Position, Camera and Labels.
Position: Enables the parameters for the requested map area where the
Position Source defines the source of the viewed area.

Camera: Defines the camera parameters such as camera number and minimal
and maximum distance of the camera fromthe map.

Labels: Defines label parameters for how labels should be displayed.

This section contains information on the following topics:
Position
Camera
Labels

Position

Figure 123: Position, Focus On Map Editor
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Map: Fits the selected map in the FocusOnMap container to the screen

according to the Fit To Screen By selection.

- Fit To Screen By: Sets the map attribute that will be used to fit the map to
the screen: Width, Height, Min (the minimal value of the map’s width and
height), Max (the maximal value of the map’s width and height), Average
(the average of the map’s width and height).

- Longitude Offset: Sets a longitude offset from the center of the selected
map

- Latitude Offset: Sets a latitude offset from the center of the selected map

- Distance Offset: Sets a distance offset from the center of the selected map
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- Pan: Sets a pan value for the camera.
- Tilt: Sets a tilt value for the camera.

Absolute: Enables the user to manually set the parameters for the viewed area:
- Longitude: Sets the Longitude of the viewed area (center).

- Latitude: Sets the Latitude of the viewed area (center).

- Distance offset: Sets a fixed distance offset from the selected map.

- Distance: Sets a distance from the map.
- Pan: Sets a pan value for the camera.
- Tilt: Sets a tilt value for the camera.

3D Region: The selected map in the FocusOnMap container will be fitted to the

screen according to the Fit To Screen By selection.

- Fit To Screen By: Select the 3DRegion attribute that will be used to fit the
map to the screen: Width, Height, Min (the minimal value of the map’s width
and height), Max (the maximal value of the map’s width and height),
Average (the average of the map’s width and height).

- Longitude Offset: Sets a longitude offset from the center of the selected

3DRegion.

. Latitude Offset: Sets a latitude offset from the center of the selected

3DRegion.

- Distance Offset: Sets a distance offset from the center of the selected

3DRegion.
- Pan: Sets a pan value for the camera.
- Tilt: Sets a tilt value for the camera.

Note: Pan and Tilt parameters will be disabled unless the Pan & Tilt Animation
parameter in the Navigator plugin is enabled (On).

Camera

Figure 124: Camera, Focus On Map Editor
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Camera: Defines the camera number that will be affected by the position

parameters.

Navigation Method: Allows you to select whether the camera or the container
should be moved when a map changes position. If you select camera, the
camera will move when you reposition the map, potentially moving other
objects out of frame. If you select container, you will move the container
instead of the camera keeping other objects in view as the camera will be still.
In other words you are moving the base map instead of the camera in order to
see other parts of the map. Setting it to container also means you do not have
to use the front layer using two cameras in order to achieve the same effect as
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when moving the container. Also you will not have to reload borders and other

elements on the map as it can be preloaded once for the base map. Note that

you can only do this with a flat map (not a globe).

Clipping Plane Control: Defines the selected camera’s clipping plane. Static

(Viz) draws the objects within the clipping plane values defined in Viz. For Viz

2.x see Setup->Camera->Camera Clipping Plane. For Viz 3.x see Scene

Settings->Renderer->Camera Clipping Plane. FocusOnMap adjusts the

clipping plane values according to the camera position. This is automatically

done by the Focus On Map plugin based on the Near Distance and Far Distance

parameters.

- Near distance (%): Defines the minimal distance of the camera from the
map.

- Far Distance (%): Defines the maximal distance of the camera from the map.

Labels

Figure 125: Labels, Focus On Map Editor
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Labels: Defines how the labels will be displayed:

- Overlay: Labels are displayed as a layer on the screen not affected by the
camera movement when a new area is selected.

- On Map: Labels are displayed on the map, moving with the map as the
selected area is changed.

Label Camera: Defines the camera number used for displaying the on screen
labels.

Get Map: When clicked, the camera will jump to the defined area.

13.11 Geo Text

GeoText

4
L3 ) AN

GeoText
The plugin can be found in the following folders:

Viz Artist 2: Function -> Container (button) -> Maps.
Viz Artist 3: Built Ins -> Container Plugins -> Maps.
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Figure 126: GeoText example.
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The GeoText plugin is used to display the longitude and latitude values received
from a variety of sources. The geographic data is displayed in two text objects (or
one) defined by the longitude and latitude containers.

This section contains information on the following topics:
Plugin Description

Plugin Description

The Source defines the source of the geographic data that will be displayed in the
definedcontainers under the Containers tab.

- User: Sets the value manually in the Compass, Longitue and Latitude
parameters for the position and range values. The Compass, Longitude and
Latitude parameters will be enabled only when Position is set to User.
WPosition: The defined Containers display the values recieved from the World
Position plugin on the same container as the GeoText plugin.

Navigator: The GeoText plugin receives the geographic data from the
Navigator plugin in the scene. The received data from the Navigator plugin is
the location of the center of the Navigator point of view and the differance
between the edges of the current Navigator map. The GeoText plugin also has
placeholders (all requiring a running Viz World server) for defining the
administration levels:

- Country: Gets the current Country

- Admin 1: Gets the current administration level 1 (e.g. Region)

- Admin 2: Gets the current administration level 2 (e.g. Town)

+ Location: Gets the lowest administration level (e.g. Place)

WPoint: The defined Containers display the value recieved from the WPoint
plugin on the same container as the GeoText plugin.
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- Map: When placed on a map container, the GeoText plugin will send the center
of the map data to the Longitude and Latitude containers and the differance
between the edges of the map to the range containers.Line: When placed on a
3DLine container, the GeoText plugin will send the center of the line data to
the defined containers in the Containers tab.

There are three parameter tabs for each option in the position pareameter:

Figure 127: Source set to User and Position, Focus On Map editor
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- Position: Defines the position text format. Select the required format from the
Degrees Format list.

Figure 128: Source set to User and Range, Focus On Map editor
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- Range: Defines the range text format. Select the units for the displayed values
and select the required format from the Degrees Format list. If Kilometers,
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Miles or Nautical Miles are selected, Dot or Comma can be selected as a
separator with a fixed decimal point.

Figure 129: Source set to User and Containers, Focus On Map editor
GeoText Plugin (10.1.0)

Source User WP osition Navigator | WFoink | IMap I Line  |[]
Pasition Range Containers

-

ﬂ Long

R Lat

ﬂ Compass

Longitude Position
Latitude Position
Zampass

Longitude Range ﬂ LongRange

DT | e

Latitude Ranos F| Latrange
Legend ﬂ Legand
Length ﬂ L=ngth —

-

Containers: defines the font objects that will display the longitude and latitude

values of the position and range:

- Longitude Position: When set, this parameter is linked to the text object
displaying the longitude position data received from the GeoText plugin.

- Latitude Position: When set, this parameter is linked to the text object
displaying the latitude position data received from the GeoText plugin.

- Compass: When set, this parameter is linked to an object that will be rotated
to show the North (based on navigator direction).

- Longitude Range: When set, this parameter is linked to the text object
displaying the longitude range data received from the GeoText plugin.

- Latitude Position: When set, this parameter is linked to the text object
displaying the latitude range data received from the GeoText plugin.

- Legend: When set, view width and view height values will be scales based on
the object used for the legend.

- Length: When set, this parameter is linked to the text object displaying the
length of the line object as received from the GeoText plugin.

13.12 Globe Zoom
Globefoom
T —
A
2 3
wEF:-beZ-:u:-m
The plugin can be found in the following folders:

Viz Artist 2: Function -> Container (button) -> Maps.
Viz Artist 3: Built Ins -> Container Plugins -> Maps.
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IMPORTANT! This plugin is included in Viz World Client package for compatibility
reasons, and is not maintained. It is recommended to use the Navigator and
NavFinder plugins for designing new scenes.

13.13 Hop Sync
_'!'!'19{&

ﬁ_
Hop Sync

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps.

Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The HopSync plugin is used to coordinate between labels and other 3D objects
with built-in animations and hop animations. The HopSync plugin is applied to
the same container as the Label It plugin, or to a container above the label design
containers but below the top design container which will be used to create the
label merged object. To use HopSync plugin, the label designs must include a
merged object containing the design. The plugin defines a point in the label
animation that will be matched with the hop point in the Navigator animation.

This section contains information on the following topics:
Plugin Description

13.13.1 Plugin Description

Figure 130: Hop Sync editor
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Director: Defines to which director the label animation will be copied to.

- Navigator: Copies the label animation to the Navigator director. This option
is used when the label animation should end before or at the time the
Navigator animation has reached a hop point. When the navigator director
reaches a hop point and Continue is pressed (or pause time will end) the
label animation will also continue, causing the label to disappear.

- Hop Director: Copies the label animation to a new director. This option is
used when the label animation should end after the hops animation has
stopped (or paused). If the label animation will be copied to the Navigator
director, the label animation will stop before the entire label was revealed.

- Separate: Copies the label animation to a new director (not the Hop or
Navigator director) in order to give you more options. Note that it will not
perform animation offsets.
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Animation Start Time: Defines the point in the label animation that will be
matched to the hop point in the Navigator animation. The value is set by
typing in a number (in seconds), or clicking and sliding the mouse over the
parameter until the animation point is reached. Another option is to use the
Set Highlight Time button. Play the animation and when reaching the
requested point in the label animation, stop and click the Set Highlight Time.
The current label animation value will be copied to the Animation Start Time
field.

Order Offset: Enable/disable an offset between the animation of the objects.

- Animation Order Offset Time: How much time to offset the animation, e.g
when setting this value to 1.2, the 3rd detail animation will start after 2.4
seconds after the animation has reached the destination.

13.14 Hops Manager
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The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps-Adv.

Viz Artist 3: Built Ins -> Container Plugins —-> Maps-Adv.

The Hops Manager plugin is used to control from one interface multiple instances
of several plugins. The plugin should only be used if all parameters for the control
plugins should be the same. If for any reason different values are needed the
plugin should not be used.

The plugin controls the CWM Client plugin, Map Pyramid plugin and NavFinder
plugin; however, only instances which are part of a hop will be controlled. The
plugin has two main options; global values and hops.

This section contains information on the following topic:
Plugin Description
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13.14.1 Plugin Description
HepsManager Plugin i
Global Values Hops
CWM Client Map Pyramid | Nawv Finder |

Texture Labels | 30 Objects | 3D Roads | Miscellaneous |
Texture Size Manual sp4:3 | =spis:s | Hp7o | HDioso |

Adjust For Globe Wigith | Aerace |
Adjust For Zoom
Width
Height 10
Compression [ Nene DXTL | DXT3 DXTS
Quality M

Refresh All Maps | Add Destination | Remove Destination |

Global values are used in order to update values globally on all control plugins.

Under the global values tab all parameters are the same as those found in the
actual plugins you want to control. For more information see:

CWM Client
Map Pyramid
NavFinder

Hops are used to jump to a specific hop. From this tab you can select and refresh
a map and fine tune NavFinder’s pan values.

13.15 KML Reader
ﬂ“ﬂidﬂ[

X

e |
EMLReader

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps-Man.

Viz Artist 3: Built Ins —> Container Plugins -> Maps-Man.

The KMLReader plugin is used to add objects from KML files to the scene. KML
files are XML formatted files containing information about geografic objects:
labels, shapes, lines. The KML Reader plugin reads the files and generates objects
according to the file’s content.

This section contains information on the following topics:
Plugin Description
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Plugin Description

Figure 131: KMLReader editor, General

KMLReader Plugin {10.2.0) o

kML File
Label Designs & Holder

Shape Designs & Holder
Shape Split
Zhape Designs

Shape Designs

Shape Holder

Line Designs & Holder

Gearef Images

Read File

| General Advanced |

s TempAKML_Samples.lkml

Disabled | Local | Global

Cnisabled I Local Global
off )

_off | on
|

R
&

Cisabled Local | Global
Cisabled Enabled

KML File: Defines the path to the KML file.
Label Designs & Holder: Defines the graphic designs for labels.

- Disabled: No label designs are used. Labels found in the file will not be

drawn.

- Local: Specific label design containers and holder will be used. When

selected additional parameters will be enabled: Label Designs and Label
Holder. Assign the required designs and holder to the plugin.

- Global: The global label designs and holder container will be used. The

global designs and holder are defined in the 3D Map Setting plugin.

Shape Designs & Holder: Defines the graphic designs for shapes.
- Disabled: No shape designs are used. Shapes found in the file will not be

drawn.

- Local: Specific shape design containers and holder will be used. When

selected, additional parameters will be enabled: Shape Designs and Shape
Holder. Assign the required designs and holder to the plugin.

- Global: The global Shape designs and holder container will be used. The

global designs and holder are defined in the 3D Map Setting plugin.

Line Designs & Holder: Defines the graphic designs for lines.
- Disabled: No line designs are used. Lines found in the file will not be drawn.
- Local: Specific line design containers and holder will be used. When selected

additional parameters will be enabled: Line Designs and Line Holder. Assign
the required designs and holder to the plugin.

- Global: The global line designs and holder container will be used. The global

designs and holder are defined in the 3D Map Setting plugin.

Georef Images: Defines if georef images found in the KML file will be used.
- Disabled: Images found in the file will not be drawn.
- Enabled: Images defined in the file will be drawn and geographically

referenced. When selected an additional parameter will be enabled: Georef
Images Holder. Assign the required holder to the plugin.
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Figure 132: KMLReader editor, Advanced
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Use Proxy: Defines the network uses a proxy server. If set ON, additional
parameters will be enabled:

- IP: Sets the IP address of the proxy server.
- Port: Sets the port number to be used.
- Username, Password: Sets the login credentials.

Debug Printing: When set to ON, debug messages will be printed to the Viz
console.

Read File: Triggers the plugin to read the files and re-draw the objects.

13.16 Label AddOn

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps-Adv

Viz Artist 3: Built Ins —> Container Plugins -> Maps-Adv

The Label AddOn plugin can be used to assign images, geometries and text based
on label parameters. Labels can have up to 4 extra parameters.

Label parents: Country, Admin1, Admin2 (see also Place Finder plugin)
Label type: Type

Based on the container name (case sensitive) the CWM Client plugin will update
the Value field in the plugin with the correct value.

So if for example you have selected London and you have a Label AddOn plugin
on a container named “Country” it will receive the value of United Kingdom and if
you have another Label AddOn plugin on a container named “Type” It will receive
the value of “Capital”.

A use case for this plugin is whenever you want to have flags for all countries in
the world in a folder and use the right flag based on the country.
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Another use case is having different images for different types and using the
correct image based on the type.

This section contains information on the following topics:

Plugin Description

13.16.1 Plugin Description

LabelAddOn Flugin (11.1.0)

Type Image Geometry | Text |

Walue

[

Prefix
Suffi

Hide If Empty Off I on
Update

Type: Options are Image, Geometry and Text

- Images can be applied from the database on a local container

- Geometries can be applied from the database on a local container
- Text can be changed on the local container

Value: Values used to seraph the object or set the text. Can be edited for
testing.

Prefix: Prefix used for searching the database. For example MyImages/Flags/
Suffix or small

Hide If Empty: Hides (Off) the container if an object/image is not found
Update: Tests the prefix and suffix

13.17 Label It

Labellt

%

“Labellt

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps.

Viz Artist 3: Built Ins -> Container Plugins -> Maps.
The Labellt plugin is used for managing 3D labels and place indicators. The plugin
creates a hierarchy under its container for adding a caption, body and pointer
objects.

This section contains information on the following topics:
Plugin Description
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13.17.1 Plugin Description

The plugin has four plugin editor views; Caption, Overlay, OnMap Scale and Fade.

In addition this section also explains some Practical Use aspects of the plugin.

This section contains information on the following topics:

Caption
Overlay

OnMap Scale

Fade

Practical Use

Caption

Caption defines the relation between the label components (text and pointer).

Figure 133: Caption disabled, Label It editor

Labellt Plugin {12.0.0)

Caption

Rotate Labels

2

Caption Owverlay On Map Scale Fade

Disabled Enabled
off an

Caption: When disabled, duplicated labels will use the label design exactly.

When enabled the labels will use the following options:

Figure 134: Caption enabled, Label It editor

Labellt Plugin (12.0.0)

Caption

Number Of Presets
Current Preset
Direction (deg)
Distance (cm)

Caption Pivot
Callision Mode

Rotate Labels

2

,W Cwverlay | On Map Scale Fade
[ Presets WME
i |2 | 3 | &
1 2 | 3 | s |
<50 Sl
200 Sl
[ Fxed . Edge
’T Bounding Box
[ off _on |

Presets: The Labelit object is controlled by the Label Manager plugin.

WME: The default pointer direction (angle) and default distance between the
pointer and the label is set by the map label parameters and used by the Viz
World Map Editor (WME). If the direction and distance are changed while using

the WME the Default Direction and Default Distance values will be ignored.

- Number of Presets: Defines the number of label position presets avalible to

the user (one to four presets). This parameter will be enabled only when

Caption Mode is set to Controlled.
- Direction: Sets the angle of the label in relation to its geographical position.

- Distance: Sets the distance of the label from its geographical position.

Chapter 13: Container Plugins

197



- Caption Pivot: When caption is moved (rotated along the tip) the two
options, Fixed and Edge, define the connection point between the caption
and the body. Fixed sets the connection point to be the center of the
caption. Edge sets the connection point to depend on the correct rotation. If
the caption is above the tip, the connection point will be the middle lower
side of the caption. If the caption is on the right side of the tip it will be on
the left side of the caption. For example: A line moving from the tip to the
center of the caption and where it crosses the caption bounding box is the
connection point.

- Collision Mode: Defines how the labels will be placed when an overlap or
collison between two labels occur. With Tip, the pointers of overlapping
labels can cross or touch, but no overlap of label bodies are allowed. With
Bounding Box, a bounding box is calculated around the entire label (label
body and pointer). An overlap between labels bounding boxes is not
allowed.

- Rotate Labels: Defines if labels, created in Viz (3D labels), will be rotated
like the labels in Viz World Map Editor (WME). If set to Disabl/ed, all labels
will be displayed horizontally. If set to Enabled, labels that were rotated in
Viz World Map Editor will be rotated in Viz.

- WME Offsets Distance: When WME is enabled, this parameter enables the
WME to offset the distance (default OA). When disabled (OFF) only the
direction offsets from WME is used and the distance ignored.

Overlay

Navigator Overlay defines how the label will be displayed over the map. Available
options are Disabled, Fixed, Scaling, Near Scale and Far Scale.

Figure 135: Overlay, Label It editor

Labellt Plugin (12.0.0) i
Caption I Cwverlay On Map Scale | Fade
Mavigator Overlay Disabled | Fixed | Scaling
Near Scale ilﬂ
Far Scle o Bl
2]

Disabled: Places the label on the map using its geographical referencing.

Fixed: Places the label by keeping its geographical referencing but using a

different camera (either with dynamic image or with a front layer). The label

size will remain fixed.

Scaling: Places the label by keeping its geographical referencing but using a

different camera (either with dynamic image or with a front layer). The Label

will scale trying to imitate the camera movement.

- Near Scale: Defines the maximal size of the label on the screen (that is when
zooming in what will be the final size of the label).

- Far Scale: Defines the minimal size of the label on the screen (that is when
zooming out what will be the final size of the label).
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OnMap Scale

Figure 136: OnMap Scale, Label It editor

LabelIt Flugin (12.0.0)

1

Caption | Overlay | On Map Scale Fade
Static Map Scale Off I On
Scale =
2

Static Map Scale: Defines a scaling factor for the duplicated labels on a static
map without camera movement. When disabled (Offj, no scaling will be used.

Fade

Figure 137: StandAlone fade, Label It editor

LabelIt Flugin (12.0.0)

1

,m Controlled
Fade On Time M
Time To Hop(%) mi‘ﬂ
Fade On Distance ’W Enabled
Fade On Latf/Long M
Lat/Long mi‘ﬂ
2]

Caption | Overlay | On Map Scale | Fade

Fade: Defines the fade effect parameters to be used with the duplicated labels.
Available options are Stand Alone and Controlled. Stand Alone enables the
user to define the fade parameters of the labels, while Controlled can be
enabled to define the fade parameters when working with the Label Manager

plugin.

Fade On Time: Defines a label fade effect, beginning at a relative point to the
defined hop duration. An additional parameter will be enabled, 7ime To Hop,

defining when the fade will occur.

Fade On Distance: Defines a label fade effect, beginning at a relative distance

from the hop final location.

Fade On Lat/Long: Defines a label fade effect, beginning at a Longitude and
Latitude offset from the hop final location. An additional parameter will be

enabled, Lat/Long, defining the offset from in degrees.
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Figure 138: Controlled fade, Label It editor

LabelIt Plugin (12.0.0) i
Caption | Owverlay | On Map Scale | Fade
Stand Alone I Controlled
Step Auto On Hop | Paoint 1 Paint 2 Hop And Abowve
Selected Label Timings At End I Close To End Ahead Well Ahead
Label Priority Auto Naormal | High Always
w2
]

Step: Controls when the label will fade in and out in relation to an animation.
In general the fade can be based on the camera distance (for example; captials
are in view when disctance is below 1000KM) or on timing in relation to the
hop:

- Auto: When a label is of type point (added by the user) it will fade in and out
based on distance to hop. If the label is of type place/region it will be faded
in and out based on the distance set in Label Manager plugin. If the hop is
not close enough for the label to show and the label was added by the user
it will be faded in based on hop timing and not distance.

- On Hop: Links the fade to the hop timing.

- Point 1/Point 2: These are reserved for labels where the distance is
configured by the Label Manager plugin.

- Hop and Above: Turns on at the hop and stays on thereafter.

Selected Label Timings: Sets one of the timing options for the fade to occur:

- At End: the label will fade after the animation stops and before it continues.

- Close To End: Fades the label just before the animation stops and just after
the animation continues.

- Ahead: Fades the label before the animation stops and after the animation
continues.

- Well Ahead: Fades the label long before the animation stops and long after
the animation continues.

Label Priority: Sets the duplicated labels priority. This parameter is used when

the number of labels on the screen is high and not all of the labels can be

displayed. The priority levels define which labels will be displayed and which
labels will be hidden:

- Auto: Priorities are set by the Label Manager plugin.

- Normal, High: Priorities are set to normal and high.

- Always: Labels will always be displayed.

Practical Use

When adding a Labellt plugin, three containers will be added under the Labellt
container: CAPTION, BODY and TIP. Drag a text object under the CAPTION
container. The BODY container is the pointer’s body and the TIP is the pointer’s
end.

IMPORTANT! A text object under the label design must be named “label” to receive

the name of the object from the CWMClient plugin.
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13.18

13.18.1

Locator Control
LocatorCtl

5

LocatorCtl

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps.

Viz Artist 3: Built Ins —> Container Plugins -> Maps.
The LocatorCtl plugin is used to link an object positioned on one map to another
map, showing its position. The object marking the point on the linked map must
reside under a geographically referenced map. The linked object will show the
position of the linked map or object on the map its parent map.

This section contains information on the following topics:
Plugin Description

Plugin Description

Figure 139: Position type Map, Locator Control editor

LocatorCH Plugin [
Position Type map Mavigator | WPosition WPoint Usar |
Remote Container IEI
Control Size on
Basic Size 10:0.0) R

Position Type defines the link between the object and the map. Available options

are Map, Navigator, WPosition, WPoint and User.

Map links the object to a map, showing its entire area over theparent map.
- Remote Container: Defines the linked map container.

Control Size: When disabled (Off, the entire area of the linked map will be
marked on the parent map. When enabled (On), the size of the marked area
can be controlled.

Basic Size: Defines the percentage of the linked map area to be marked.
Min Size: Defines the minimal size of the linked map area to be marked.
Max Size: Defines the maximal size of the linked map area to be marked.
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Figure 140: Position type Navigator, Locator Control editor

LocatorCH Plugin

Position Type Map Mavigator WPosition | WPoint User |

Control Size [F

Basic Size
Min Size milil
Max Size milil

Navigator links the object to a Navigator plugin, showing its position on the
parent map. The plugin will locate the navigator container above it in the scene

tree.

Control Size: When disabled (Off, the entire area of the linked map will be

marked on the parent map. When enabled (On), the size of the marked area

can be controlled.

Basic Size: Defines the percentage of the linked map area to be marked.
Min Size: Defines the minimal size of the linked map area to be marked.
Max Size: Defines the maximal size of the linked map area to be marked.

Figure 141: Position type WPosition, Locator Control editor

LocatorCtl Plugin

Remote Container i

Position Type Map | Mavigator | WPosition WPoint User

WPosition: links the object to a WPosition plugin, showing its position on the

parent map.

Remote Container: Defines the WPosition container.

WPoint links the object to a WPoint plugin, showing its
(The WPoint plugin is used in Viz Weather).

Remote Container: Defines the WPoint container.
Figure 142: Position type user, Locator Control editor.

LocatorCH Plugin

position on the parent map

Position Type map | Mavigator | WPositien WPoint Usar

Map Center Longitude milil
Map Center Latitude milil

User enables the user to position the object on the map.
- Map Center Longitude: Defines a Longitude value for the object.

Map Center Latitude: Defines a Latitude value for the object.
Tangent To Globe: When enabled (On), the controlled object will be rotated to

match the globe surface.
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13.19 Map Layers

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps.

Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The MapLayers plugin is used to expose map layers to an external application.
Map layers are labels, regions, and so on.

This section contains information on the following topics:
Plugin Description

13.19.1 Plugin Description

Figure 143: Mode dynamic, Map Layers editor.
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—
i
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o

Mode: Defines the layer maps mode Static and Dynamic.
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- Static: Enables maps to be imported to Viz Artist’s image library and saved
with the scene.

- Dynamic: Enables pyramid maps to be loaded from the cache and temporary
folder. When the CWM Client plugin receives a new map, all layers will be
updated.

Texture Compression: Sets the compression level for the texture (DTX5 is the

highest compression level, which is less texture quality).

Texture Quality: Sets linear for using the same image resolution in the entire

zoom range, or Mipmap to change resolution according to the distance from

the image (managed automatically in Viz Artist).

Edited Layer: Sets the layer number for editing. Each layer is then assigned

map properties to display.

Active: Activates or disables the selected layer.

Container: Assigns the container for holding the created layer map.

Flags: Enables (On) the requested property to expose the map property or

feature in the selected layer. Flags refer to all the settings from Base Map to

Overlay Data.

Build Tiles: Builds the map layers.

13.20

204

Map Layers Control

MapLayersic

The plugin can be found in the following folders:

Viz Artist 2: Function -> Container (button) -> Maps-Adv.
Viz Artist 3: Built Ins -> Container Plugins —-> Maps-Adv.

The MaplayersControl plugin is used to control map layers in an individual map
and in map tiles (Pyramid or MapTiler tiles). The plugin should reside on the CWM
Client container which generates the maps and tiles.

This section contains information on the following topics:

Plugin Description
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13.20.1 Plugin Description

Figure 144: Map control enabled Map Layers Control editor
MapLayersControl Plugin {(10.1.0% (‘i

Map Tiles
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fon
]
off]

Refresh Map | ¥ |

Select an option to configure: Map or Tiles. Each can be enabled and configured
separately. When Control is enabled, the layer parameters will be enabled. See
Map Layers plugin for the layers description.

13.21 Map Pyramid

Mageyrami
-

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps.

Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The MapPyramid plugin is used to build a set of map layers for displaying an area
in high resolution when zooming into a specific area. The maps are created as
Geolmage (flat map) or Globe objects and placed under a low resolution map of
the entire area for geographical referencing. The Map Tiler plugin is also used for
managing Pyramid object maps when used in a scene.

This section contains information on the following topics:
Plugin Description
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13.21.1
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Plugin Description

Figure 145: Mode dynamic, Map Pyramid editor

MapPyramid Plugin (10.1.0) (T
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Mode: Defines the maps mode. Available modes are Static and Dynamic.

- Static: Enables the maps to be imported to Viz Artist’s image library and
saved with the scene.

- Dynamic: Enables the pyramid maps to be loaded from the cache and
temporary folder. When the CWM Client receives a new map, the pyramid
will be generated.

Map Style: Defines the map style to be used for the pyramid maps:

- Source: Uses the top CWM Client container (Map Tiler) style selection when
creating the pyramid maps.

- Target: Uses the hop CWM Client style selection when creating the pyramid
maps.

Satellite (Split): Splits the pyramid layers style, based on image latitude and

longitude size. If the image size is smaller then the threshold the target style

will be used, if larger then then source style will be used. Additionally, it is

possible to turn on the color correction option in Pyramid Control which will

color correct the target image to match the source images.

Max Pyramid Height: Defines the maximal number of maps that will be created

in the pyramid. The optimal number of pyramid maps is calculated by the

MapPyramid plugin. If the optimal number exceeds the Max Pyramid Height

value, then the plugin will generate the maximal number defined.

Pyramid Factor: Calculates the number of maps required defining the size

factor between the maps of the pyramid.

Auto Hide Local Texture: Defines if the map created by the CWM Client plugin,

located on the MapPyramid container, will be turned off when the texture

resolution of that map is lower than the Globe or Geolmage map tiles

resolution. If it is enabled (On), the maps with lower resolution will be turned

off automatically by the MapPyramid plugin. If it is disabled (Offj, the

MapPyramid will not turn off the low resolution maps.

Apply Fade: Defines if the maps used in the pyramid will use soft edges.

Available options are Off, Target and Pyramid.

- Off: No soft edges will be used. The transition between the maps will be
visible (the maps will have sharp edges).

- Target: Sets the last map (target) to have soft edges only.

- Pyramid: Sets all maps in the pyramid to have soft edges.
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Fade Range: When Apply Fade parameter is used, the Fade Range is used to
set the fade level (the area of the image that the fade will be applied to).

Build Tiles: Triggers a rebuild of the pyramid maps.

13.22 Map Tiler

____!ip'l'ller
-

L%
hap Tiler

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps.

Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The Map Tiler plugin is used to build a set of map tiles for displaying an area in
high resolution. The maps are created as Geolmage (flat map) or Globe objects
and placed under a low resolution map of the entire area for geographical
referencing. The Map Tiler plugin is also used for managing Pyramid object maps
when used in a scene (see the Map Pyramid plugin for more information).

This section contains information on the following topics:
Plugin Description

See Also

Geolmage
Globe
Map Pyramid

13.22.1 Plugin Description

The plugin has five tabs; Tiling, Texture, Terrain,Destination and Advanced. Each
tab relates to differnet tile parameters.

This section contains information on the following topics:
- Tiling
Texture
Terrain
Destination
Common Buttons
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Tiling

Figure 146: Tiling tab, Map Tiler editor
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Selected Region: Defines the area of the map for which the tiles will be
created.

- World: Creates tiles for the entire world.

- Selected Map: Creates tiles for the area of the selected map in the
CWMClient plugin attached to the MapTiler container.

- Region List: When Region List is selected, a list of regions will be displayed.
An item from the list can be selected to create map tiles for the selected
area.

- Long Lat: Sets the Longitude and Latitude minimum and maximum values.
The map tiles will be created for the defined area. When Long Lat option is
selected, additional fields will be enabled:

- West: Sets the Longitude value for the western edge of the map.
- East: Sets the Longitude value for the eastern edge of the map.

- South: Sets the Latitude value for the southern edge of the map.
- North: Sets the Latitude value for the northern edge of the map.

View: Defines the point of view (Outer Space, Space, World, Continent,
Country, Large Region,Region, Manual and Total) of the area (that is the
amount of zoom to be used). The higher the point of view, the lower the
number of tiles will be and lower resolution.

- When set to Manual, the Pixels Per Degree parameter will be enabled.
- When set to 7otal, the Total Pixels parameter will be enabled.

Pixels Per Deg: Defines the resolution of the map. Resolution is determined by
the number of pixels per degree. The higher the number is the higher the
resolution is.

Total Pixels: Defines the total number of pixels for all the tiles combined.
Geometry Type: Selects the object type of the created tiles.

- Globe: Creates the tiles using the Globe plugin.

- Flat: Creates the tiles the Geolmage plugin.

Radios/Map Size: Sets the size (in Viz units) of the globe or map tiles (all
together).
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Tessellation: The number of polygons used in the object. The higher the
number is, the smoother the object is drawn.

Apply Fade: Uses soft edges for the tiles. When fade is applied it will be
applied to the outer edges of the selected area which are the outer tile edges.
The inner edges of the tiles will not be soft. This option is used when trying to
apply a very large area of the world, in high resolution, over a world map with
low resolution.

Fade Range: Defines the fade (softness) size.

Pyramid Offset: Defines the offset between the pyramid map layers, defined to
avoid z-drawing problems. Increase the default value if the layers are not
drawn correctly. Units are 1/10000 cm.

Texture

Figure 147: Texture tab, Map Tiler editor

MapTiler Plugin {10,1.0) i
Tiling I Texhure Terrain I Diestinstions | Advanced |
Texture Compression Mome DAT1 DHT3 | DTS |
Texzture Quality Linear Mipmap

Map Status 2 tiles will be required (sach 2045x2048 pixels)
Build Tiles | Change All Maps | Build Tiles (Forcs Hew) | Change All Maps (Forca Hew) |
Caleulate Tiles Tnfio | ¥ |

Texture Compression: Sets the compression level for the texture (DTX5 is the
highest compression level which is less texture quality).

Texture Quality: When set to Linear the same image resolution will be used in
the entire zoom range. When set to Mipmap the resolution is changed
according to the distance from the image (managed automatically in Viz
Artist).

Terrain

Figure 148: Terrain tab, Map Tiler editor

MapTiler Plugin {10.1.0) e
Tiling | Texhurs Terrain Deshinations Advanced |
Build Terrain ot | Om
Smocth Terrain E on
Terrain Smocthing Factor m% ]
Terrain Height Scale BE = -
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Map Status 2 tiles will be reguired (sach 20482048 pizels)
Build Tiles | Change all Maps | Build Tiles (Force Mew) | Change All Maps (Force New) |
Calculate Tiles Tnfio | i |

 Build Terrain: Builds terrain data for the created tiles

Smooth Terrain: Smoothens terrain edges so they blend with the base map
surface. When enabled (On) the Terrain Smoothing Factor will be enabled.
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Terrain Smoothing Factor: Sets the precentage of the smoothed area.

Terrain Height Scale: Sets the scaling factor for terrain height. The higher the
factor is, the more extreme the terrain will be.

Terrain Resolution: Sets the total terrain reolution for all tiles. A high
resolution value will result in a more detailed terrain (effecting performance).

Destination

Figure 149: Destination tab, Map Tiler editor

MapTiler Plugin (10.1.0) (o
Tiling | Techure | Terrain Diestinations fdvanced
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Texbure Width 512 - | F
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Map Status 2 tiles will be required (aach 20482048 pixels)
Euild Tiles | Changs &ll Maps | Build Tiles {Farce Hew) | Change All Maps (Force New) |
Calculate Tiles Info | i |

Texture Size: Sets the base size for the CWMClients in the scene. Select one of
the preset sizes or Manual.

Texture Width: Sets the base texture width (in pixels).
Texture Height: Sets the base texture height (in pixels).

Sub Tesseleation - When building Globe objects, this parameter will determine
the sub tesselation value in the Globe objects.

Advanced

Figure 150: Advanced tab, Map Tiler editor

MapTiler Plugin (10,10} [
Tiling | Techure | Terrain ] Diestinations I fdvanced
Map Only | Off on

Map Status 2 tiles will be raguired (sach 20d48x2048 pixels)
Build Tiles | Change &ll Maps | Build Tiles {Faorce Mew) | Change All Maps (Force Mew)
Calculate Tiles Tnfio | fi |

Map Only: Builds only the map tiles, without adding other Viz Curious Client
plugins (Navigator, etc.).

Common Buttons

Map Status: Displays plugin status messages. When configuring the tiles, the
Map Status field will display the number of tiles required and tile size
according to the current plugin setup.

Build Tiles: Build the geo-reference map and tiles.
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Change All Maps: Builds the geographical reference map, tiles and applies
style changes made in the CWM Client plugin to all child containers
(recursively) under the MapTiler container.

Build Maps (Force New): Builds the geographical reference map and tiles
without checking the cache for existing maps (from the server).

Change All Maps (Force New): Builds the geographical reference map, tiles and
applies style changes made in the CWM Client plugin to all child containers
(recursively) under the Map Tiler container, without checking the cache for
existing maps (from the server).

Calculate Tiles Info: Calculates the tiles information, without building the tiles,
and displays it in the Map Status field.

13.23 Mute

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) —->Tools.

Viz Artist 3: Built Ins —> Container Plugins -> Tools.

The Mute plugin is used to determine if a container will be drawn or not. The
difference between using the Mute plugin and setting the visibility off is that when
using the plugin only containers with the plugin will not be drawn, but all child
objects will be drawn and the geometry properties will be used in the hierarchy
(geographical reference, and so on). When setting the visibility off the entire
container and its child containers will be set off and not be used in any way.

This section contains information on the following topics:
Plugin Description

13.23.1 Plugin Description

Figure 151: Mute editor
Mute Plugin

Draw Geometry Off] On

f

|-

Draw Geometry: When enabled (On), the geometry will be drawn. When
disabled (Offj, the geometry will not be drawn but its child containers will be
drawn.
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13.24.1
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MavCam

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps_Adv.

Viz Artist 3: Built Ins -> Container Plugins —-> Maps-Adv.

The NavCom plugin is used for controlling the Navigator plugin. The plugin is an
example showing how to externally control the Navigator plugin when special
applications should be used to control the scene. An example for a special case
where external control of the Navigator plugin is required is Elections. When using
Viz 3.x scripting, complicated logics and commands can be used with the
NavCom plugin.

This section contains information on the following topics:
Plugin Description

See Also
NavCom Scripting

Plugin Description
The NavCom plugin has three tabs; Commands, Control and Advanced.

This section contains information on the following topics:
Commands

Control
Advanced
NavCom Scripting

Commands

The Commands tab is used for communicating with the Navigator plugin in means
of sending formated commands and receiving formated responses from the
Navigator plugin:
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Figure 152: Commands tab, NavCom editor

NavCom Plugin (11.1.0) i
Commands Caontraol | Advanced |
Command I

Immediate Response Disabled I Enabled

Execute Command| Initialize |

The Command text field is where you enter the command. The NavCom plugin
receives predefined, fixed syntax, commands and returns a reply from the
Navigator plugin.

The Response field contains the reply returned from the Navigator plugin. The
format of the reply is defined in the Advanced tab.

The Immediate Response option defines if the command will be sent while typing
(every change to the command field will sent the command to Navigator), or only
after pressing the Execute Command button.

The following is a list of commands, example commands and return values:

Mouse To Lon Lat: Converts screen coordinates to Long/Lat values from the map.
This needs the Navigator plugin.
Command: MTLL x y

Response: lon lat
MTLL 360 288
-116.998 38.088

Mouse To Region: Returns the region name in which the given screen coordinates
reside. This command requires the Navigator plugin.
Command: MTR x y

Response: CountryID "Country Name" RegionID "Region Name"
SubRegionID "Sub Region Name"

MTR 360 288

1000000000003600 "United States of America" 1000000000038901 "Texas"
1000000000111302 "Atascosa County"

All Fly To commands require the Navigator and the NavFinder plugin. Also set the
Navigator plugin’s Interactive Anim setting to On (see Miscellaneous).

Fly To Region ID: Triggers a Navigator animation from the current location to the
sent region (RegionlID).

Command: FTRID RegionID
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FTRID 81000000000F8285

Fly To Country: Triggers a Navigator animation from the current location to the
sent country (country name).

- Command: FTC "country name"

FTC "united states of America"

Fly To Region: Triggers a Navigator animation from the current location to the
sent region (Region name).

- Command: FTR "country" "Region"

FTR "united states of America" "Texas"

Fly To Sub Region: Triggers a Navigator animation from the current location to the
sent sub region (by name).

- Command: FTSR "country" "Region" "Sub Region"

FTSR "united states of America" "Texas" "young county"
Fly To Lon Lat Level: Triggers a Navigator animation from the current location to
the sent level area (country, region, or sub region) that the long/lat data resides
in.
. Command: FTLLL lon lat level

FTLLL -116.998 38.088 1

Search database: Searches the map database and as a response generates an XML.
This command requires a running Viz World server.

- Command: SMDB <query>

Search web: Searches the web and as a response generates an XML. This
command requires a running Viz World server.

- Command: SWEB <query>

Search All: Searches both resources (map database and web) and as a response
generates an XML. This command requires a running Viz World server.

- Command: SALL <query>
- Shared memory reply: WS _REPLY

Nearby: Searches locations in the vicinity of the coordinates of your “mouse” and
as a response generates an XML. This command requires a running Viz World
server. This command requires the Navigator plugin.

- Command: NEARBY [mouse-x] [mouse-y]
- Shared memory reply: NAV_NEARBY REPLY
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Shared Navigation memory of the Navigator plugin can be activated by setting
Publish Geo Data to Bounding box or Location. If Bounding box is selected you
will, in addition to Bounding box data, get Center and Distance data. If Location is
selected you will, in addition to the Location data, get all the others. If None is
selected no data is shared.

All can be used with scripting to define e.g. the administration levels the script
should fetch from the shared data and consequently display it on screen. For
interactive scenes such as touch screens this can be used for adding graphics to
maps based on your selection (thereby avoiding to overpopulate the map with
information).

For testing you can enable the interactive mode by clicking the E button in Viz
Artist’s Scene Editor.

Navigation location: Shared data holding the current geographic location(s) of the
Navigator plugin. To enable it, select Publish Geo Data’s Location option. The data
is updated when the camera is not moving. Navigation location aslo generates an
XML with the current geographic location(s) (in the same format as SMDB, SWEB,
SALL and NEARBY). This requires a running Viz World Server.

Name: NAV_LOCATION DATA
Navigation bounding box: Shared memory data holding the current (frame by
frame) geographic bounding box (lat lon) of the Navigator plugin. To enable it,
select Publish Geo Data’s Bounding box or Location option.

Reply: NAV_BB DATA
Navigation center: Shared memory data holding the current (frame by frame)
geographic center of the Navigator plugin. To enable it, select Publish Geo Data’s
Bounding box or Location option.

Reply: NAV_CENTER DATA
Navigation distance: Shared memory with the current distance to world of the
Navigator plugin. To enable it, select Publish Geo Data’s Bounding box or
Location option.

Reply: NAV DISTANCE DATA
Navigation direction: Shared memory with the current pan and tilt direction of the
Navigator plugin. To enable it, select Publish Geo Data’s Bounding box or
Location option.

Reply: NAV DIRECTION DATA
Control

The Control tab is used to directly control the Navigator plugin by changing the
values of the parameters
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Figure 153: Control tab, NavCom editor

NavCom Plugin (11.1.0)

Lon

Lat

Execute Command |

Initialize | ? |

Commands I Control Adwanced

5722 Gl
| 25547 el

Distance ilﬂ

Pan

Tilt

Interactive Mode Editor | On-Air ITEI\!’S
Input MultiTouch Mouse

Minimal Distance milﬂ

Momentum Mode ’T Linear

Lon: Sets the longitude value for the Navigator plugin. The Navigator camera
will move to the specified longitude value.

Lat: Sets the latitude value for the Navigator plugin. The Navigator camera will
move to the specified latitude value.

Distance: Sets the Navigator distance from the map. The Navigator camera will
move to the specified distance value.

Pan: Sets the pan value of the Navigator camera.
Tilt: Sets the tilt value of the Navigator camera.
Interactive Mode: Defines the interactive behavior of Viz. Available modes are

None, Editor, On-Air, Always.

- None: Disables interactive mode.
Editor: Enables interactive mode during scene editing.

- On-Air: Enables interactive mode when Viz Engine is in On Air mode.

- Always: Enables interactive mode during scene editing and when Viz Engine
is in On Air mode.

Minimal Distance: Sets the minimal distance from the map in Viz units.

Momentum Mode: When set to Linear you can set how much friction should be
applied to the momentum.

Advanced

The Advanced tab is used for defining the NavCom plugin’s general behavior

patterns.

216

Chapter 13: Container Plugins



Figure 154: Advanced, NavCom editor

NavCom Plugin (11.1.0) i
Commands | Caontrol Im
Shape File Support ’W Limited Only |
Limit Picking | Disabled | Enabled
Shared Memory M Distributeﬂ
Shared Memory Prefix ’W A B_ C_ | D_ |
Protocol Mode ,T Name 1d
Protocol Separator 'Spﬁ Tab Comma Semicolon | Colon |
Use Quotes ’E
Suffix FIPS off]
Publish Geo Data ’? Bounding box Location |
Execute Command | Initialize |

Shape File Support: Defines if the NavCom plugin will include shape objects
information in the respond. The Shape objects must reside under the NavCom
container. When the Shape File Support is Limited, the plugin will scan the
shape files below the container. When a command is recieved, the NavCom
plugin will return, in the response string, information about the shapes that
overlap the requested data in the command. When the Shape File Support is
Only, the plugin will scan the shape files below the container. When a
command is recieved, the NavCom plugin will return, in the response string,
only the information about the shapes that overlap the requested data in the
command.

Limit Picking: Limits the geographical area that the NavCom plugin will
perform any of the commands on. When Limit Picking is enabled the Limit to
Country parameter will be enabled.

- Limit to Country: Sets the country name. If the requested data in the
command does not exist for the defined country area, the command will not
be executed. Only commands relating to points within the country area will
be executed.

Shared Memory Prefix: This parameter should be used when using more than

one NavCom plugin in the scene, and when using scripting to send and receive

information from these plugins. In each NavCom plugin, set the Shared

Memory Prefix to a different prefix (up to four) to distinguish between the data

sent to each plugin.

Protocol Mode: Defines the data displayed in the Response field.

+ Full: Includes data on names and IDs for countries, regions and sub-
regions.

- Name: Includes data on names for the countries, regions and sub-regions.

- ID: Includes only ID data (as defined in the Viz World Server) for the
countries, regions and sub-regions.

Protocol Separator: Defines the separating character between the Response

data. The defined separator will be used between country and region, region

and sub-region, and so on.

Use Quotes: Defines if the response string will be quoted or not.

Suffix FIPS: Used for USA regions and sub-regions.

Publish Geo Date: Allows you to publish navigation data to shared memory

based on your interaction with the graphics scene (e.g. touchscreen or

mouse). Shared Navigation memory can be activated by setting Publish Geo

Data to Bounding box or Location. If Bounding box is selected you will, in

addition to Bounding box data, get Center and Distance data. If Location is

selected you will, in addition to the Location data, get all the others. If None is
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selected no data is shared. See the available Navigation data under the
Commands section.

- Execute Command: When pressed, the defined command will be executed.

- Initialize: This button is used when using shape file support. If the shape
objects under the NavCom container is changed, press the initialize button to
re-scan the shape objects.

NavCom Scripting

Viz 3.X scripting ability is a powerful tool for implementing complex logic into a
scene. In a Navigator scene, NavCom can be used in the scripts to enable such
advanced Navigator operations. The folowing script example demonstrates how
to send and receive data from the Navigator plugin through to the NavCom

plugin.

dim level as Integer

dim ignore as Integer

dim CurCountry as string
dim CurCountryId as string
dim CurState as string
dim CurStateId as string
dim CurCounty as string
dim CurCountyId as string

Sub UpdateCurrent (temp As String)

dim position as Integer

dim temp2 as String

println temp

CurCountryId = temp.left (16)

position = temp.Find("\"")

temp = temp.GetSubstring(position+l,temp.Length- (position+l) )
temp2 = temp

position = temp2.Find("\"")

CurCountry = temp2.Left (position)

println "<" & CurCountryId & "><" & CurCountry & ">"

position = temp.Find("\"")

temp = temp.GetSubstring(position+2,temp.Length- (position+2) )
CurStateId = temp.left(16)

position = temp.Find("\"")

temp = temp.GetSubstring(position+l,temp.Length- (position+l) )
temp2 = temp

position = temp2.Find ("\"")

CurState = temp2.Left (position)

println "<" & CurStateId & "><" & CurState & ">"

position = temp.Find("\"")

temp = temp.GetSubstring(position+2,temp.Length- (position+2) )
CurCountyId = temp.left (16)

position = temp.Find("\"")

temp = temp.GetSubstring(position+1l, temp.Length- (position+1l) )
temp2 = temp

position = temp2.Find("\"")

CurCounty = temp2.Left (position)

println "<" & CurCountyId & "><" & CurCounty & ">"

End Sub
Sub OnInit ()

ignore = 0
level = 1
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if Scene.Map.ContainsKey ("MTR") false Then

Scene.Map.CreateKey ("MTR")

End If

if Scene.Map.ContainsKey ("FTRID") = false Then
Scene.Map.CreateKey ("FTRID")

End If

if Scene.Map.ContainsKey ("FTC") false Then
Scene.Map.CreateKey ("FTC")

End If

if Scene.Map.ContainsKey ("FTR")

Scene.Map.CreateKey ("FTR")

false Then

End If

if Scene.Map.ContainsKey ("FTSR") = false Then
Scene.Map.CreateKey ("FTSR")

End If

if Scene.Map.ContainsKey ("FTLLL") = false Then
Scene.Map.CreateKey ("FTLLL")

End If

if Scene.Map.ContainsKey ("MTR REPLY") = false Then
Scene.Map.CreateKey ("MTR_REPLY")

End If

if Scene.Map.ContainsKey ("FTRID REPLY") = false Then
Scene.Map.CreateKey ("FTRID REPLY")

End If

Scene.Map.RegisterChangedCallback ("MTR_REPLY")
System.Map.RegisterChangedCallback ("REGION_ L")
End Sub

Sub OnSharedMemoryVariableChanged (map As SharedMemory, mapKey As
String)

println mapKey

dim temp as String

If mapKey = "REGION_L" Then
println "ignore pre"
ignore =1

else If mapKey = "MTR REPLY" Then
temp = Scene.Map ["MTR_REPLY"]
UpdateCurrent (temp)
println System.Map["REGION L"]

if System.Map["REGION L"] = "1" then
Scene.Map ["FTRID"] = CurCountryId

elseif System.Map["REGION L"] = "2" then
Scene.Map ["FTRID"] = CurStateld

elseif System.Map["REGION L"] = "3" then
Scene.Map ["FTRID"] = CurCountyId

End If

End If

If mapKey = "MTLL REPLY" Then
println Scene.Map ["MTLL REPLY"]

End If

End Sub

sub OnLButtonDown ()
dim temp as String
if System.MouseX < (System.RenderWindowWidth: 120 ) then

Scene.Map ["MTR"] = (String) System.MouseX & " " & (String)
System.MouseY

end if

end sub
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NavFade

NavFad

MavFade

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps.

Viz Artist 3: Built Ins —> Container Plugins -> Maps.

The NavFade plugin is used for defining the visibility of an object that the NavFade
is attached to in a Navigator scene. The Navigator point of view (distance from the
map) will determine when the object will become visible. The NavFade uses an
Alpha plugin to control the object’s appearance. The Alpha plugin will be added
automatically when adding NavFade to the container.

This section contains information on the following topics:
Plugin Description

Plugin Description
The NavFade plugin has four fade modes; Height,Hops, Distance and Angle.

This section contains information on the following topics:
- Height
Hops
Distance
Angle

Height
The object will fade in or out depending on camera height (above the map).

Figure 155: Visibility range set to Below, NavFade editor
MavFade Plugin {12.1.0) i

Fade Mode ITght Hops | Dist | Angle Mowement
Fade Invert IT On

Fade Time (Fields) [ Eil2]R

Visibility Range IW Above | Range |

Height 0.0 pald

Set Height |

2|

Fade Time: Defines the fade transition duration in fields.
Visibility Range: Defines how the fade point is calculated. Available options are
Below, Above and Range.
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- Below: The object will be visible when the defined height is heigher than the
current Navigator distance from the map.

- Above: The object will be visible when the defined height is lower than the
current Navigator distance from the map.

- Range: The object will be visible between the defined low and high values.

Set Height: When clicked, the current camera height will be inserted to the
height field.

Set Range High: When clicked, the current camera height will be inserted to
the High range field.

Set Range Low: When clicked, the current camera height will be inserted to the
Low range field.

Hops

The object will fade in or out depending on the defined hop point and the
animation time to/from the selected hop point.

Figure 156: Hops, NavFade editor
MawvFade Plugin (12.1.0) i

Fade Mode Height Hops Dist | Angle Mowement
Fade Invert Off on
Fade Time (Fields) [ iR

Time To Hop(%) milﬂ
Hop Mode Manual Auto

Hop To Link |
Mone

PMap-Start |l
Hop To Link Destination-1

Destination-2

Destination-3

Mestinatinn-4 |

Hop And Abowve Dizabled Enabled Constant Mumber I Related

2|

[ L

Fade Time (Fields): Defines the fade transition duration in fields.

Hop Mode: defines if the NavFade plugin will effect the manually selected hop
or if the hop will be auto selected when the designs copied by CWM client.

Hop To Link: Sets the number of the hop points that NavFade will use as a
reference. When animating to and from the selected hop, the object will
appear/disappear.

Hop and Above: When enabled, all hops which number is higher than the
selected hop will be considered as the selected hop. Defines if the NavFade
plugin will affect the manually selected hop or if the hop will be selected by
the NavFade plugin. The Constant option will cause the object to fade on at
Hop to Link and stay on from that point onwards. The Related option allows
you to relate hops to a set of containers. You can for example use the
NavFinder plugin to define three hops, and then add three Text containers as
sub-containers of a container holding the NavFade plugin. Setting NavFade to
Related will allow the NavFinder hops to relate to the Text containers found
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under the NavFade container and fade them in and out as part of the hop
animation.

Time to Hop (%): Sets the point in which the object will appear/disappear. The
time is set as a percentage of the hop duration.

Height

The object will fade in or out depending on the height of the camera above the
map.

Figure 157: Visibility range set to Below, NavFade editor
MavFade Plugin (12.1.0) i

Fade Mode l?ght Hops | Dist | Angle Mowement
Fade Invert IT On

rade Time (Fields) [ 2R

Visibility Range IW Above | Range |

Height 10.0 ilﬂ

Set Height |

2

Fade Time: Defines the fade transition duration in fields.

Visibility Range: Defines how the fade point is calculated. Available options are
Below, Above and Range.

- Below: The object will be visible when the defined height is heigher than the
current Navigator height above the map.

- Above: The object will be visible when the defined height is lower than the
current Navigator height above the map.

- Range: The object will be visible between the defined low and high values.

Height: Defines the height value that the NavFade plugin will use as the show/
hide point of the object when Visibility Range parameter is set to Below or
Above.

Figure 158: Visibility range set to Range, NavFade editor
MawvFade Plugin {12.1.0) i

Fade Mode l?ght Hops | Diist | Angle Mowement
Fade Inwvert IT On

Fade Time (Fields) [ SR

Visibility Range Below | Abowve I Range

Low 10.0  gald

T -

Set Range High | Set Range Low |

2

Low: Sets the lower value of the height range that the object will be visible in.
If the current Navigator height is higher than the low value, the object will be
visible.
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High: Sets the higher value of the height range that the object will be visible
in. If the current Navigator height is lower than the high value, the object will
be visible.

Set Range High: The current Navigator height value will be copied to the High
parameter. This button will only affect the plugin when Visbility Range is set to
Range.

Set Range Low: The current Navigator height value will be copied to the Low
parameter. This button will only affect the plugin when Visibility Range is set
to Range.

Distance

The object will fade in or out depending on the distance from the map.

Figure 159: Visibility range set to Below, NavFade editor
MavFade Plugin {12.1.0) i

Fade Mode Height | Hops IT Angle Mowement
Fade Invert IT On

Fade Time (Fields) [ iR

Visibility Range IW Above | Range |

Distance 0.0 pld

Set Distance |

2|

Fade Time: Defines the fade transition duration in fields.

Visibility Range: Defines how the fade point is calculated. Available options are
Below, Above and Range.

- Below: The object will be visible when the defined distance is heigher than
the current Navigator distance from the map.

- Above: The object will be visible when the defined distance is lower than the
current Navigator distance from the map.

- Range: The object will be visible between the defined low and high values.

Distance: Defines the distance value that the NavFade plugin will use as the
show/hide point of the object when Visibility Range parameter is set to Below
or Above.
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Figure 160: Visibility range set to Range, NavFade editor

MawvFade Flugin (12.1.0) i

Fade Mode Height | Hops I Diist Angle Mowvement
Fade Invert Off On

rade Time (Fields) [ 2R
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Set Range High | Set Range Low |

2

Low: Sets the lower value of the distance range that the object will be visible
in. If the current Navigator distance is higher than the low value, the object will
be visible.

High: Sets the higher value of the distance range that the object will be visible
in. If the current Navigator distance is lower than the high value, the object will
be visible.

Set Distance: The current Navigator distance value will be copied to the
Distance parameter. This button will only affect the plugin when Visibility
Range is set to Below or Above.

Set Range High: The current Navigator distance value will be copied to the
High parameter. This button will only affect the plugin when Visibility Range is
set to Range.

Set Range Low: The current Navigator distance value will be copied to the Low
parameter. This button will only affect the plugin when Visibility Range is set
to Range.

Angle

The object will fade in or out depending on the angle between the camera and the
map.

Figure 161: Visibility range set to Below, NavFade editor
MNawvFade Plugin {12.1.0) i

Fade Mode Height | Hops | Dist ITEHE‘. Mowement
Fade Invert IT On

Fade Time (Fields) [ EECER

Visibility Range IW Above | Range |

angle o B

Set Angle |

2

Fade Time: Defines the fade transition duration in fields.

Visibility Range: Defines how the fade point is calculated. Available options are

Below, Above and Range.

- Below: The object will be visible when the defined angle is heigher than the
current Navigator angle between the camera and the map.
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- Above: The object will be visible when the defined angle is lower than the
current Navigator angle between the camera and the map.
- Range: The object will be visible between the defined low and high values.

Angle: Defines the angle value that the NavFade plugin will use as the show/
hide point of the object when Visibility Range parameter is set to Below or
Above.

Figure 162: Visibility range set to Range, NavFade editor
MNawvFade Plugin (12.1.0) i

Fade Mode Height | Hops | Diist I Angle Mowement

Fade Invert Off on

Fade Time (Fields) [ iR
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2

Low: Sets the lower value of the angle range that the object will be visible in. If
the current Navigator angle is higher than the low value, the object will be
visible.

High: Sets the higher value of the angle range that the object will be visible in.
If the current Navigator angle is lower than the high value, the object will be
visible.

Set Angle: The current Navigator angle value will be copied to the angle
parameter. This button will only affect the plugin when Visibility Range is set
to Below or Above.

Set Range High: The current Navigator angle value will be copied to the High
parameter. This button will only affect the plugin when Visibility Range is set
to Range.

Set Range Low: The current Navigator angle value will be copied to the Low
parameter. This button will only affect the plugin when Visibility Range is set
to Range.

Movement

Figure 163: Fade Invert set to Off, NavFade editor
MavFade Plugin (12.1.0) i

Fade Mode Height | Hops | Dist | Angle I Mowement
Fade Invert off On
rade Time (Fields) [ ERCEIR

2

Alpha values will fade on/off based on if Navigator is currently moving or
stationary.

225




13.26

13.26.1

226

NavFinder

NavFinder
— ol
e

i

MawFinder

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps.

Viz Artist 3: Built Ins —> Container Plugins -> Maps.

The NavFinder plugin is used for setting hop points over a given map. The
NavFinder must reside under a Navigator plugin container and a map.

This section contains information on the following topics:
Plugin Description

Plugin Description

Hop Point: Sets the hop point in the hop sequence. Note that the animation
will be built in the same sequential order as the list of Hop Points (Map-Start,

Destination-1, Destination-2, and so on). If two hops use the same Hop Point,

the animation will not work properly.

Position Source: This parameter defines how the hop location will be set.
Available options are Map, Absolute, 3D Region and Link.

Goto Map: Jumps to the defined hop point on the map.

Take Current Values: Takes the current position and uses that as the hop
position. This option is normally used with interactive mode in the Navigator
plugin. The user moves the object to the required position and sets the values
for the NavFinder.

Fly To Map: Creates an instant animation and run from the current map

location to the current hop point defined by the NavFinder plugin. This feature

is active only if the /nteractive Anim parameter in the Navigator plugin is
enabled (On).

Get Map: The user can navigate manually to any destination and by pressing
the Get Map button, the currently viewed map will be used. CWMclinet must be
on the same container and if a pyramid plugin is used, the pyramid layers will
be built.

Add Linked Hop: Adds a hop (container with NavFinder set to Link) under the

current NavFinder container. See Link tab description for more information.

Tip: Take Current Values can be used in interactive mode. The user can position
itself using the mouse and then tell NavFinder to use the current values.

This section contains information on the following topics:
Map
Absolute
3D Region
Link
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Figure 164: Map, NavFinder editor

MNavFinder Plugin {11.1.0) i
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Add Linked Hop | 7 |

The Position Source Map uses the current location from the map (center of the
screen values) and adds offsets for fine tuning.

- Fit To Screen By: Defines what the end frame of the animation (hop) will be.
When the hop is defined as a 3D Region object on the map, the animation will
end when the bounding box of the object fills the frame. Available parameters
for defining how the bounding box will be calculated are Width, Height, Min,
Max and Average.

- Width: Uses the width of the object’s bounding box to calculate the last
frame of the hop animation.

- Height: Uses the height of the object’s bounding box to calculate the last
frame of the hop animation.

- Min: Uses the minimal value between the width and the height of the object
to calculate the last frame of the hop animation.

- Max: Uses the maximal value between the width and the height of the object
to calculate the last frame of the hop animation.

- Average: Uses the average value between the width and the height of the
object to calculate the last frame of the hop animation.

Longitude offset: Defines Longitude offset based on the current position.

Latitude offset: Defines Latitude offset based on the current position.

Distance offset (%): Changes the distance zoom from the map (zoom in or
out).

Pan: Sets a pan value for the camera.
Tilt: Sets a tilt value for the camera.

Note: Pan and Tilt parameters will be disabled unless the Pan & Tilt Animation
parameter in the Navigator plugin is enabled (On).
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Absolute

Figure 165: Absolute, NavFinder editor

NavFinder Plugin {11.1.0)
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Goto Map | Take Current Values | Fly To Map | Get Map

Add Linked Hop | 7 |

Absolute sets the Longitude and Latitude values of the hop point location.

Changes the Distance and Distance Zoom parameters:

- Longitude: Defines the Longitude for the hop position.

- Latitude: Defines the Latitude for the hop position.

- Distance: Changes the distance from the map.
- Pan: Sets a pan value for the camera.
- Tilt: Sets a tilt value for the camera.

Note: Pan and Tilt parameters will be disabled unless the Pan & Tilt Animation
parameter in the Navigator plugin is enabled (On).
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3D Region

Figure 166: 3DRegion, NavFinder editor

MNavFinder Plugin {11.1.0) i
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Position Source Map | Absolute | 3D Region Link

Fit To Screen By Width | Height | Min Max | Average

Longitude offset ﬂ

Latitude offset mi‘ﬂ

Distance offset (%) i‘ﬂ

Tit oo |
Goto Map | Take Current Values | Fly To Map | Get Map
Add Linked Hop | ? |

3D Region uses the current location from the 3D Region plugin (center of the
region values). Add offsets for fine tuning.

See the Map section for references to the Position Bounding Box, Offset, Distance,
Pan and Tilt parameters.

Note: Pan and Tilt parameters will be disabled unless the Pan & Tilt Animation
parameter in the Navigator plugin is enabled (On).

Link

Figure 167: Link, NavFinder editor

MNavFinder Plugin {11.1.0) i
Hop Point
: Map-Start
Hop Point Destination-1
Destination-2
Destination-3
MNestinatinn-4 ]
Position Source Map | Absolute | 3D Region I Link
Frame By Country Region | Level Up | Interpolation | Offset |
Fit To Screen By Width Height | Min | Max | Average |
Distance offset (%) i‘ﬂ

Tit offset o0 |

Goto Map | Take Current Values | Fly To Map | Get Map
Add Linked Hop | 2 |

The Link mode is used when one hop resides as a child of another hop. the child
hop is set to link. When changing the top hop, the child hop will change
accordingly, maintaining the same animation that was created during the design.
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Frame By Country Region | Level Up | Interpolation | Offset |

Fit To Screen By ’T Height | Min | Max | Average |
Distance offset (%) [ w00 SR

Pan offset [ 00 |

Tilt offset _

In Country and Region mode the navigator position will be based on the country
or region where the destination (link source) is, whereas in Level up mode the
navigator position will be one administration level (e.g. Place is leveled up to
Town) above the destination (link source). In Country, Region and Level Up mode
you have the following settings:
- Distance Offset: Sets an offset from the calculated distance after the top hop
was changed.

Pan Offset: Sets an offset from the calculated pan after the top hop was
changed.

Tilt Offset: Sets an offset from the calculated tilt after the top hop was
changed.

Frame By Country | Region | Level Up I Interpolation Offset
Interpolation mi‘ﬂ
In Interpolation mode you have the following setting:
Interpolation: Navigator position will interpolate between the gap above and
below (useful for a drill down with a pause in the middle)

Frame By Country | Region | Level Up | Interpolation IT

Longitude offset ﬂ

Latitude offset mi‘ﬂ

Distance offset (%) i‘ﬂ
:

Pan offset

Tilt offset
Min Distance

Max Distance

In Offset mode you will have the following settings:

- Longitude Offset: Sets an offset from the calculated hop longitude location
after the top hop was changed.
Latitude Offset: Sets an offset from the calculated hop latitude location after
the top hop was changed.
Min Distance/Max Distance: Sets the minimum and maximum distance from
the map. Using the same parameters for both settings gives you a fixed
distance.

See the Map section for references to the Position Bounding Box, Offset, Distance,

Pan and Tilt parameters.

13.27

230

Navigator

MNawigator

The plugin can be found in the following folders:
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Viz Artist 2: Function -> Container (button) -> Maps.
Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The Navigator plugin enables the user to create realistic animations from one
point to another on the map (for example fly over a flat map or globe). It is also
used for navigating on a map (moving the camera) to a defined location using pan
and tilt values.

This section contains information on the following topics:
Plugin Description

13.27.1 Plugin Description

The plugin has four main plugin editor views; Camera, Animation, Miscellaneous
and Advanced. In addition the plugin has two common features that applies for all
editor views.

This section contains information on the following topics:
- Camera

Animation
Miscellaneous
Advanced
Common Buttons
Known issue(s)

Camera

Figure 168: Camera (Position), Navigator editor

Navigator Plugin (12.1.0) i

Camera Animation Miscellaneous Advanced
Position Advanced

Camera ilﬂ
Longitude milﬂ
Latitude ilﬂ
I = ¢
I - ¢
it I - ¢

Calculate Animation | Center Map| Refresh All Maps | 7 |

The Position button displays the camera position parameters.
- Camera: Defines the camera that will be affected by the position parameters.

Longitude: Defines the Longitude camera position on the map/globe.
Latitude: Defines the Latitude camera position on the map/globe.
View: Defines the Camera’s view distance from the map.

Pan: Defines the Camera’s pan value.

Tilt: Defines the Camera’s tilt value
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Figure 169: Camera (Advanced), Navigator editor

Navigator Plugin (12.1.0) i

View Units Distance Visible view

Clipping Plane Control Static (Viz) I Navigator

Navigation Method

Camera Animation | Miscellaneous Advanced
Position I Advanced

MNear Distance (%)
Far Distance (%)

. Container

Calculate Animation | Center Map| Refresh All Maps | 7 |

The Advanced button displays the advanced camera parameters.

Roll: Sets the roll value of the camera. This parameter is enabled only if the
Keep The Horizen Horizontal parameter is set OFF.

Keep The Horizen Horizontal: When set on the horizon will always be
horizontal and roll movement will allow animation.

View Units: Sets the way the number entered in the View field (see Camera

(Position), Navigator editor) will be treated. Distance defines the number of Viz

units from the camera to the map. Visible Viewis based on the view (i.e. how

many km/miles and so on) you see in units defined by the 3D Map Setting

plugin.

Clipping Plane Control: Defines the distance range that will be drawn by the

camera. Objects located closer to the camera than the Near parameter and

objects located farther that the Far parameter will not be drawn.

- Static (Viz): Draws the objects within the clipping plane values defined in
Viz. For Viz 2.x see Setup->Camera->Camera Clipping Plane. For Viz 3.x
see Scene Settings->Renderer->Camera Clipping Plane.

- Navigator: Adjusts the clipping plane values according to the camera
position. This is automatically done by the Navigator plugin based on the
Near Distance and Far Distance parameters.

Near Distance (%): Defines the percentage of the camera distance from the
map, which will be used as the Near distance of the clipping plane.

Far Distance (%): Defines the percentage of the camera distance from the map,
which will be used as the Far distance of the clipping plane.

Navigation Method: Allows you to select whether the camera or the container
should be moved when a map changes position. If you select camera, the
camera will move when you reposition the map, potentially moving other
objects out of frame. If you select container, you will move the container
instead of the camera keeping other objects in view as the camera will be still.
In other words you are moving the base map instead of the camera in order to
see other parts of the map. Setting it to container also means you do not have
to use the front layer using two cameras in order to achieve the same effect as
when moving the container. Also you will not have to reload borders and other
elements on the map as it can be preloaded once for the base map. Note that
you can only do this with a flat map (not a globe).
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Animation

Figure 170: Animation,Basic (Pause Points), Navigator editor

Navigator Plugin (12.1.0) i
Camera I Animation Miscellaneous | Advanced
Basic Advanced
Number of Hop Points nilﬂ
Hop Duration Mode Fixed I Auto Per Hop
o B
Hop Min Duration (%) milﬂ
Stop Type Disabled | Stop Points I Pause Points Flyowver Per Hop
Pause Duration (sec) “ilﬂ
Pause At First Hop Disabled Enable
Pan & Tilt Animation Off on
Progress Profile Linear | Smooth I L-Smooth R-Smooth
Calculate Animation | Center Map | Refresh All Maps | 7 |

The Animation button displays the camera animation parameters. There are two
parameter tabs: Basic and Advanced.

The Basic tab:

Number of Hop Points: Sets the number of key frames (hops) used in the
animation.

Hop Duration Mode: Defines the time gap between two key frames.

- Fixed: Uses the same duration as set in the Hop Duration parameter for all
hops.

- Auto: Automatically calculates the duration of the animation between hops.
Minimal hop duration will be based on the Hop Duration parameter and the
Hop Min Time parameter.

- Manual: Disables the Hop Duration parameter. Enables the user to set hop
duration manually in the stage editor.

Hop Duration: Sets the animation length, between one hop to another, in
seconds.

Hop Min Time (%): Sets a minimal time for each hop when Hop Time Mode is
set to Auto.

Stop Type: Defines the animation behavior at each hop.

- Disabled: Enables the animation to only use stage properties.

- Stop Points: Enables the animation to stop at each hop point and wait for a
continue command.

- Pause Points: Adds a pause point to each hop. An additional parameter,
Pause Time, will be added to define the pause length in seconds.

- Flyover: Simulates a flight pass over the hop points in a spline path, using
the Flyover Minimal Height parameter. When selected, additional
parameters will be enabled.

- Per Hop: The user will set the hop stop type in the navFinder pluing.
different stop types can be set per different hops.
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Figure 171: Animation, Basic (Flyover), Navigator editor

Stop Type

Flyowver Path Profile
Lag on Point

Exclude From Flyover
Flyowver Minimal Height
Pan & Tilt Animation

Progress Profile

Calculate Animation | Center Map |

Navigator Plugin (12.1.0) i
M Miscellaneous Advanced
Basic Advanced
Number of Hop Points nilﬂ
Hop Duration Mode Fixed I Auto Per Hop
o B
Hop Min Duration (%) milﬂ

Disabled | Stop Points | Pause Points I Flyowver Per Hop

Stright | small Curve | Medium Curve Large Curve
| Linear Fast Pass Slow Pass | Pause Points
[ mNone _ First | tast | Firstalast |
300 Sl

off _on |
Linear | Smooth IW R-Smooth

Refresh All Maps | 7 |

- Flyover Path Profile (Stop Type is set to Flyover): Defines flying curve profile

(curvature) of animation path.

Lag On Point: Similar to "Flyover Path Profile" button, but defines timing profile
of the flyover animation.

Flyover Minimal Height: Sets the minimum flyover height in centimeters.

Stop At First Hop: Defines whether a stop point will be added to the first hop
(the beginning of the animation). The parameter is enabled only when using
Stop Points or Pause Points as the Stop Type value.

Pan & Tilt Animation: Enables or disables the pan and tilt values of the camera
of each hop in the animation. When enabled (On) this setting will enable the
Pan and Tilt values for the NavFinder plugin.

- Progress Profile: Defines timing profile between stop points of animation.
Smooth option causes the animation to ease in and out of hop points.

Figure 172: Animation, Advanced, Navigator editor

Navigator Plugin (12.1.0) i

Calculate Animation | Center Map |

Preferred Flight Height Low Normal High
Preferred Flight Style Zoom Auto IW
Preferred Landing Helicopter Auto Airplane

Pan Drifting (Deg) miﬂ

Tilt Drifting (Deg) BEEE < iR

Drifting Pan Time (Frames) “iﬂ

Drifting Tilt Time (Frames) “iﬂ

Drift Phaze Shift (%) BEEE < iR

Stop Drifting ’W_ On Stops On Start
Flight Direction [ shortest East West

Advanced

Camera I Animation Miscellaneous
Basic I Advanced

Refresh All Maps | 7 |

The Advanced tab:

- Preferred Flight Height: Defines the camera height that will be used in the

animation between the hops.
Preferred Flight Style: Defines the camera movement between the hops.

- Zoom: Enables linear movement from hop point to the high point and back
into the next hop point.
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- Auto: Calculates the movement according to distance, height, and so on.
Flyover: Enables a smooth movement from one hop to another.

Preferred Landing: Defines the animation behavior when approaching the hop

points.

- Helicopter: Uses a steeper approach to the hop point.

- Auto: Calculates the approach according to distance, height, and so on.

- Airplane: Uses a flatter approach to the hop point.

Note: The drifting options allow camera pan and tilt drifting during the animation.
This option is used to give the animation movement a kind of satiate feeling.

Drifting Pan Time (Frames): Defines the time to complete a full turn of the pan.
Drifting Tilt Time (Frames): Defines the time to complete a full turn of the tilt.

Drift Phase Shift (%): Defines the offset between the pan movement and the tilt
movement.

Stop Drifting: Defines if the drifting should stop at the start point or during
stop points. If Never is selected drifting will not stop.

Flight Direction: force the direction of the flight. Default is the shortest route
to the next hop. If East or West is selected, flight route will be set according to
the selected option.

Miscellaneous

Figure 173: Miscellaneous (Interactive), Navigator editor

Navigator Plugin (12.1.0)

Camera | Animation I Miscellanecus Advanced
Interactive Labels

Interactive Mode None | Editor | On-Air Always I Fly To ]

Sensitive Area Container EJ

Interactive Anim Off I on

Interactive Factor ilﬂ

Mouse Left Button Lat/Long Pan/Tilt | Distance |

Fly To Country I Region Sub Region | Home

Extra Zoom Country milﬂ

Extra Zoom Region milﬂ

Extra Zoom Sub Region milﬂ

Home Lon T - <

Home Lat I - <

Home Distance I =

Calculate Animation | Center Map | Refresh All Maps | 7 |

The Miscellaneous button displays the editor view for setting interactivity and
label related parameters.
Interactive Mode: Defines the interactive behavior of Viz. Available modes are
None, Editor, On-Air, Always Fly To and On “i".

- None: Disables interactive mode.
- Editor: Enables interactive mode during scene editing.
- On-Air: Enables interactive mode when Viz Engine is in On Air mode.

- Always: Enables interactive mode during scene editing and when Viz Engine
is in On Air mode.

Chapter 13: Container Plugins 235



236

- Fly To: Defines destination properties. Available F/y To options in Interactive
mode are Country, Region, Sub Region and Home. Country makes the
camera animate to the country in which the mouse was clicked. Animation
will stop when the camera reaches a distance from the country as defined by
the Extra Zoom Country parameter. Region makes the camera animate to
the region in which the mouse was clicked. Animation will stop when the
camera reaches a distance from the region as defined by the Extra Zoom
Region parameter. Sub Region makes the camera animate to the sub region
in which the mouse was clicked. Animation will stop when the camera
reaches a distance from the sub region as defined by the Extra Zoom Sub
Region parameter. Home makes the camera animate to the position defined
by the Home Lan, Home Lat and Home Distance parameters.

- On “I”: Enables interactive mode during scene editing and when Viz Engine

is in On Air mode, when pressing the “i” key while using the mouse to
navigate.

Interactive Anim: When enabled (On), user activated animation from the
current map position to the current selected hop is enabled. This animation is
triggered by the user in the NavFinder plugin, by pressing the Fly To Map
button. The Fly To option will enable the user to select a point on the map, by
clicking the mouse, and the animation will run from the current camera
position to the selected point.

Extra Zoom Country: Defines the extra zoom value added to the camera
animation when animation destination is a country. The camera will zoom in
to the selected country until the bounding box of the country will fill the
render window. The extra zoom will define an additional zoom value to the
final camera position calculations.

Extra Zoom Region: Defines the extra zoom value added to the camera
animation when animation destination is a region. The camera will zoom in to
the selected region until the bounding box of the region will fill the render
window. The extra zoom will define an additional zoom value to the final
camera position calculations.

Extra Zoom Sub Region: Defines the extra zoom value added to the camera
animation when animation destination is a sub region. The camera will zoom
in to the selected region until the bounding box of the sub region will fill the
render window. The extra zoom will define an additional zoom value to the
final camera position calculations.

Home Lon: Defines a longitude value for a home point.

Home Lat: Defines a latitude value for a home point.

Home Distance: this parameter defines a distance from a home point.

Figure 174: Miscellaneous (Labels), Navigator editor

Navigator Plugin (12.1.0) i

Interactive I Labels
Labels Owverlay on Map
Label Camera - <

Camera | Animation I Miscellanecus Advanced

Calculate Animation | Center Map | Refresh All Maps | 7 |

Labels: Defines the label behavior. The Labels setting will override all labels (in
all levels of the hierarchy) under the navigator container.
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- Overlay: Places labels on a plane in front of the map (see Label It for
description). When this mode is selected an additional parameter will
enabled, Label Camera, which defines the camera to be used for the labels.

- On Map: Places labels on the map.
Advanced

Figure 175: Advanced, Navigator editor

Navigator Plugin (12.1.0) i

Camera | Animation Miscellaneous IW

Helicopter Lift Duration ilﬂ
Helicopter Smooth Level Hard Normal Soft
Ajrplane Smooth Level Hard [ wormal Soft
Distance Mode Regular | Fixed Minimal Im
Min Distance 100.0 iﬂ
Max Distance I = ﬂ
Face North ’W on
Update Stage In OnAir Off on
World Center Mode E on
World Center Longitude miﬂ
World Center Latitude miﬂ

Update World Center | Use Current Values |

Calculate Animation | Center Map | Refresh All Maps | 7 |

The Advanced button displays additional animation parameters.

Helicopter Lift Duration: Sets the time, in seconds, for the helicopter to go out

from a hop point to the high point in the middle.

Helicopter Smooth Level: Sets the animation smoothness between one hop to

another. This parameter will affect the animation path when a helicopter flight

is simulated.

Airplane Smooth Level: Sets the animation smoothness between one hop to

another. This parameter will affect the animation path when a Airplane flight is

simulated.

Tilt Smoothing: This parameter is enabled when the Pan & Tilt parameter in

the animation tab is enabled. When set to On, an additional parameter, Tilt

Smoothing Rate, is enabled. Set the required smoothing value for the tilt

animation,

Distance Mode: Defines how the camera distance from the map during the

animation and at the hop points will be calculated:

- Regular: Sets the distance that is calculated by the Navigator plugin based
on the hop locations and distance from map as set by the user.

- Fixed: Sets a fixed distance for the camera while animating between the
hops and at the hop point. When set to fixed, User selected distance at the
hop point is ignored.

- Minimal: Sets the minimal distance to which the camera will descend at the
hop points and during the animation. If the calculated distance is larger
than the minimal value, the camera will use the calculated distance.

- Boundaries: Enables you to define a minimal and maximum distance.

Min Distance: Sets the minimal distance value.

Max Distance: Sets the maximum distance value.

Update Stage in OnAir: Defines if the stage will jump to the hop position when

updating a map in OnAir mode.
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Common Buttons

Calculate Animation: Re-builds the animation between the hops using the
parameters defined in the plugin.
Center Map: Aligns the center of the map with the center of the screen.

Refresh All Maps: The Navigator plugin will search its sub-tree for containers
with CWMClient and NavFinder and refresh the CWMClients maps.

Known issue(s)

Rotation, scaling and translation above the Navigator container might affect
the plugin behavior. Do not apply any rotations above the container in the
hierarchy and use only the pan/tilt parameters of the plugin to control the
orientation of the camera.

13.28 NavScale

Navcale

./ﬁ\

MavScale

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps.

Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The NavScale plugin maintains the scale of an object,related to the screen, during
the Navigator animation. The plugin is placed on a child container under the
Navigator plugin, and it will maintain the its defined scaling throughout the
animation.

This section contains information on the following topics:
Plugin Description

13.28.1 Plugin Description

Figure 176: NavScale editor
MavScale Plugin

Scale On Distance Factor 100.0 % R

Scale On Distance Factor: Sets the value of the Scale On Distance Factor
parameter to the required number by modifying the scale factor and checking
the result in the renderer.

Note: This factor does not use any measurment units, but it calculates the object’s
scaling using a number of parameters from the Navigator plugin.
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13.29 NavSlave

MavSlawe

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps-Adv.

Viz Artist 3: Built Ins -> Container Plugins —-> Maps-Adv.

The NavSlave plugin creates a relation between its container and a Navigator
plugin container in the scene. This plugin will lock the NavSlave container to the
longitude and latitude values of the Navigator plugin. The plugin will search the
hierarchy above it for the navigator container.

This section contains information on the following topics:
Plugin Description
13.29.1 Plugin Description
Figure 177: NavSlave editor

MavSlave Plugin

Altitude 0,01 R|
Tangent To Globe on

Altitude: Defines the altitude of the object in relation to the Navigator
container.

Tangent To Globe- When enabled (On) sets the object to move over the globe
surface.

13.30 Place Finder

Finder

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps-Adv.

Viz Artist 3: Built Ins -> Container Plugins -> Maps-Adv.
The PlaceFinder plugin is used to generate a map or map animation without

having to actually select the map, but using “rules” in order to define what map
you will get.
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There are two ways of selecting a map location. The first is simply by entering
longitude and latitude values, whereas the second is based on searching the map
database for the location and using the first value (that was ranked the highest).
Since you as a user cannot select the final location out of a list it is important to
enter more information in order to make sure the correct location is found.

If you are looking for Paris, Texas in USA, and you are simply entering “Paris” you
will end up in Paris, France because the capital of France is ranked the highest.
Searching for “Paris USA” will give you a town named Paris in the USA; however,
searching for “Paris TX USA” or “Paris Texas” will give the result you are looking
for.

This section contains information on the following topics:
Plugin Description

Plugin Description

Location
PlaceFinder Plugin (12.1.0) i
Location Labels | Regions
Lattuce T -
Long/Lat (+/-dd:mm:ssood) [ N
Search |
Frame by Search Result off On
Zoom Level Country I Adminl Adminz | Default Size
Map Center | Point Frame |
Default Map Size (Deg) milﬂ
exira Zoam (%) o B
Take ?

Longitude: Map center Longitude. Changing the value will not affect the map
until you hit “Take”.
Latitude: Map center Latitude. Changing the value will not affect the map until
you hit “Take”.
Longitude/ Latitude: Map center Longitude and Latitude in one field (very
useful for external control). Changing the value will not affect the map unless
the last character is ‘;’.
Search: Map location to search for. Click the Take button to perform the
search.
Frame by Search Result: If enabled (On) the result of the search is used to
frame the the location.
Zoom level: How the map should be framed. This option is relevant if the map
center is based on longitude and latitude values (and not a search location), or
if the “Frame by Search Result” is not used.
Default size is based on Default Map Size.
Country, Adminl, Admin2 is first trying to find the relevant information
(e.g. country and so on) and will fail for example if map center is in the sea.
Next it will use the bounding box of the user selection (please read about
the Texas example in the Place Finder introduction section).
- If the user selects Admin2 the map’s frames will be based on Lamer County
which is Admin2 in that specific Longitude and Latitude.
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- If user selects Admin] the map’s frames will be based on Texas which is
Admin1 in that specific Longitude and Latitude.

- If user selects Countryl the map’s frames will be based on USA which is the
country for that specific Longitude and Latitude

Map Center: Allows you to center the map based on a point or a frame. If you
search for Beijing, China your map can be centered around the point identified
as Beijing. This may, depending on your zoom level, leave parts of Beijing out
of the frame. Alternatively, you can center your map based on the frame that
captures the entire Beijing area in view.

Default Map Size (Deg): Defines a default map size for those areas that cannot
be framed using predefined administration levels (e.g. international waters).

Extra Zoom: Adds an extra zoom to the map in percentage (0.001-100%).

Labels
PlaceFinder Plugin (12.1.0) i
Location I Labels Regions
Add Search Result Label off Short Long
Add Region Label off Short Long
Add Event Label |
Label Designs ﬂ
Label Holder ﬂ
Take ?

Add Search Result Label: Adds a label based on the search result.
Add Region Label: Adds a region label based on the Zoom level you selected.

Note: Short will only add the location name, while Long will add more information
(e.g. country and so on).

Add Event Label: Adds event based labels (e.g. floods, fire, festival). In order to
use different designs you can use a pipe symbol ( | ) as separator, e.g.
“Fire|Fire in LA” will use a design named Fire and the text will be Fire in LA.
Changing the value will not affect the map unless the last character is ‘;’.
Label Designs: Location for Label designs. Normally the plugin resides next to
CWM client plugin and it will use its designs, or the global designs.

Label Holder: Location for Label holder. Normally the plugin resides next to
CWM client plugin and it will use its holders, or the global holders.
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Regions

PlaceFinder Plugin (12.1.0) i
Location | Labels I Regions
3DRegions Disabled I Frame Only Frame And Below Full
3DRegion Designs H
3DRegion Holder E
Take ? T

3DRegions: Should 3D regions be added? Relevant only when “Zoom level” is
set to one of the region types (i.e. Region/Country/Admin1/Admin2/
Sub_region).

3DRegion Designs: Location for 3D region designs. Normally the plugin
resides next to CWM client plugin and it will use its designs, or the global
designs.

3DRegions Holder: Location for 3D region holder. Normally the plugin resides
next to CWM client plugin and it will use its holders, or the global holders.

13.31

242

Publish To Design
E‘gﬁ“ﬂ

A

publishTeDe

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps-Adv.

Viz Artist 3: Built Ins -> Container Plugins -> Maps-Adv.

Enables updated parameters to be set directly to the design they came from
(either container hierarchy or object pool) by pressing Publish To Design or create
a new design out of modified data by assigning a new name under the New
Design tab.

This section contains information on the following topics:
Plugin Description
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13.31.1

Plugin Description

Figure 178: New Design, Publish To Design editor

PublishToCesign Plugin {10.1.0% @

Publishing Target Criginal Design I Mew Design
Design Name I

Designs j

_ Tawn_1m

Designs Tawn_100k

Town_10k

Town_1k

Defanlt Trwn |

Fublish And Refresh | 7 |

Publishing Target: Publish using the original design or create a new design.
Design Name: Sets the new name for the new design or select a design from
the Designs list.

Publish And Refresh: Sends the label back to where i came from and refreshes
the scene.

13.32

Screen Scale

—
ﬁ{%
5 A

screanScale

The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps-Obs.

Viz Artist 3: Built Ins -> Container Plugins —-> Maps-Obs.

CAUTION! The ScreenScale plugin is no longer supported (discontinued) and should
not be used. The plugin is installed for compatebility reasons only. The NavScale
plugin should be used instead of the ScreenScale plugin.

The ScreenScale plugin is used in order to keep an object in the same size
regardless of the camera movement.

This section contains information on the following topics:
Plugin Description
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13.32.1 Plugin Description

Figure 179: Screen Lock (Off), Screen Scale editor

screenScale Plugin

Screen Lock | Off Size Lock |

Pixel Lock |

Camera | Current

I i

Other |

Use Camera

Screen Lock: Defines the way the screen and the ScreenScale object interact:

Off: Scales the object holding the ScreenScale plugin normally with camera
movement. When enabled (On) the Camera parameter is made available.

Camera: Defines the camera for which the object will keep its scale when the

camera is moved.

Figure 180: Screen Lock (Size Lock), Screen Scale editor

screenScale Plugin

Screen Lock Off | Size Lock

Pixel Lock |

Scale Factor

100.0 %ﬂ

Size Lock: Locks the object scaling, and sets the Scale Factor to resize the

object while keeping the scale fixed.
- Scale Factor: Sets the scale factor.

Figure 181: Screen Lock (Pixel Lock), Screen Scale editor

screenScale Plugin

Off | Size Lock
width | Height

40.0 %ﬂ

Screen Lock
Lock By
Lock Size (px)

Pixel Lock

Pixel Lock: Locks the object according to the defined number of pixels by the

Lock Size (px) parameter, by Width or by Height.

- Lock Size (px): Sets the number of pixels for the Pixel Lock.

CAUTION! The ScreenScale plugin is no longer supported (discontiued) and should
not be used. The plugin is installed for compatebility reasons only. The NavScale

plugin should be used instead of the ScreenScale plugin.
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13.33 Trace It

Trace

»

=y
1‘_ -

Tracelt

The plugin can be found in the following folders:
Viz Artist 2: Function -> Maps.

Viz Artist 3: Built Ins —> Container Plugins -> Maps.

The Tracelt plugin is used to place the 3D object it is attached too over a line,
created with the 3D Line plugin, and follows the line’s end point. The object will
follow the line animation as the object with the Tracelt plugin move with the 3D
Line end point.

This section contains information on the following topics:
Plugin Description

13.33.1 Plugin Description

The Tracelt plugin has three options; General, Camera and Advanced.

This section contains information on the following topics:
General

Camera
Advanced

General

Figure 182: General tab, Trace It editor
Tracelt Plugin (10.1.00 i

IW Camera | advanced |
Progress “ilﬂ
T -
Srnooth Direction { %) ilﬂ
Quality IT Mediurm | Lo |
iC Line Source Im Abowve | Container |
Progress Control IW Mawigator | Slave | Master

]

Progress: Indicates the animation position of the 3D Line object. This field is
disabled and cannot be modified.

Height: Defines the 3D object’s height in relation to the 3D Line object.

Smooth Direction (%): Defines the object’s motion behavior when changing
direction. When set to a low value the direction will change faster.
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Quality: Tells the plugin which resolution to track when tracing a border that
by default has 3 levels of detail (LOD). Available options are High, Medium and
Low.

3DLine: Defines the 3D Line container that the Trace It plugin will follow.

- Previous: Follows the animation of the 3D Line plugin in the previous
container.

- Above: Follows the animation of the 3D Line plugin in the above container.

- Container: Follows the animation of the 3D Line plugin in the container
dragged to its container place holder.

Progress Control: Defines how the object’s progress will be controlled:

- None: The progress id manually created by the user (stage animation).

- Navigator: Follows the animation of the Navigator plugin.

- Slave: Slave to the 3Dline plugin which is the source of the trace.

- Master: control the 3D line plugin progress which is the source of the trace.

Camera

Figure 183: General tab, Trace It editor

Tracelt Plugin (10.1.0% (L0

M Advanced
Progress ﬂ
Trace Camera Off Mavigator Standalone
Iw Locks
Srmooth Camera Position {%) milﬂ
Srmooth Camera Direction (%) milﬂ

Start Hop

L

Map-=tart
Start Hop Destination-1

Destination-2

Destination-3

Mestinatinn-4 |

Update Hop Drata

7]

The Camera tab defines the mode for camera tracing.

Progress: Indicates the animation position of the 3D Line object. This field is
disabled and cannot be modified.

Trace Camera: Manually driven (standalone) or control a navigator's animation
between a specified hop and the corresponding one. Available options are Off,
Navigator, Standalone, General and Locks.

Off: No camera tracing.

Navigator: trace the camera animation between the selected hop and the
following hop.

General: the general tab defines the tracing parameters:
- Smooth Camera Position (%): Smooth camera position path
- Smooth Camera Direction (%): Smooth camera direction path
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- Start Hop: Select a hop in the Navigator animation. The camera trace will be
inserted between the selected hop and the next one.

- Update Hop Data: updates data in NavFinder plugins where the camera trace
is inserted (actually sets start and end values of the tracing route to insert
camera trace smoothly to the navigator animation).

Locks: the locks tab enables the user to lock camera animation parameters:

- Lock Pan: when set ON, the camera pan will follow the path direction. When
set Off, pan animation will be use the navigator parameters.

- Pan Offset: Set the pan offset to path directions.

- Lock Tilt: when set ON, the camera tilt will follow the path direction. When
set Off, tilt animation will be use the navigator parameters.

- Tilt Offset: Set the tilt offset to path directions

- Lock Distance: when set ON, the camera distance from the map during the
animation will be use the Distance parameter value. When set Off, the
distance during the animation will use the navigator parameters.

- Distance: Set the distance to use during the animation.

Standalone: trace the camera animation between the selected hop and the
following hop.

General: the general tab defines the tracing parameters:

- Smooth Camera Position (%): Smooth camera position path

- Smooth Camera Direction (%): Smooth camera direction path

Locks: the locks tab enables the user to lock camera animation parameters:

- Lock Pan: when set ON, the camera pan will follow the path direction. When
set Off, pan animation will be use the navigator parameters.

- Pan Offset: Set the pan offset to path directions.

- Lock Tilt: when set ON, the camera tilt will follow the path direction. When
set Off, tilt animation will be use the navigator parameters.

- Tilt Offset: Set the tilt offset to path directions

- Lock Distance: when set ON, the camera distance from the map during the
animation will be use the Distance parameter value. When set Off, the
distance during the animation will use the navigator parameters.

- Distance: Set the distance to use during the animation.
Advanced

Figure 184: Advanced, Trace It editor

Tracelt Plugin

General | Camera I Advanced

Segmentatioin I Auto Largest | Sectioned I all
Owerlay |DEF on

Segmentation: When tracking, a line can be split into different segments (for
example a region might have several islands) the segmentation option tells
the Trace It plugin what segment to track. Available options are Auto, Largest,
Sectioned and All.

IMPORTANT! Maximum number of line segments are 10000. Shape files that exceed
this limit will result in lines not being drawn.
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Overlay: Transfers the object from a position on the actual map to a position
in a different camera (similar to the Label It plugin’s Overlay options).

13.34 World Image Refresh
’M-i-uell:‘!
o . |
Y
- i
Milmage R efrsk
The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Weather.
Viz Artist 3: Built Ins -> Container Plugins -> Weather.
The WimageRefresh plugin is placed on a map container and when the map is
changed the WimageRefresh plugin will refresh objects residing under the map
container. This action will cause all the geographically referenced objects, under
the map container, to recalculate their position and move to the correct position
according to the new map.
This section contains information on the following topics:
Plugin Description
13.34.1 Plugin Description
The World Image Refresh plugin has no parameters.
13.35 World Position
ﬂuﬂ:i-n
N - S
} -
tﬂk’
i Position
The plugin can be found in the following folders:
Viz Artist 2: Function -> Container (button) -> Maps.
Viz Artist 3: Built Ins -> Container Plugins -> Maps.
The WPosition plugin is used to place an object over a geographically referenced
map by setting the Longitude, Latitude and Altitude parameters. When the object
is moved over the map, the current values of Longitude, Latitude and Altitude will
be updated in the WPosition plugin. The object with the WPosition plugin must be
placed under a map in the hierarchy.
This section contains information on the following topics:
Plugin Description
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13.35.1 Plugin Description

Figure 185: World Position editor
WPosition Plugin @

Latitude i‘ﬂ
T - |
Tangent To Globe IE

Update Long/Lat From Position Auto MNewver | Always

Longitude Offset _iﬂ
Latitude Offset | 00 Eeald

Move To Map Centerl Update Lat/long From Container Position

Altitude

Longitude: Sets the parameter to the requested Longitude. The object will

move over the map to the requested location. Another option is to move the

object and read its Longitude value from this field.

Latitude: Sets the parameter to the requested Latitude. The object will move

over the map to the requested location. Another option is to move the object

and read its Latitude value from this field.

Altitude: Sets the parameter to the requested Altitude. The object will move

over the map to the requested location. Another option is to move the object

and read its Altitude value from this field.

Tangent To Globe: When enabled (On), this parameter will always keep the

object parallel to the globe surface. The parameter is enabled when the

WPosition plugin is placed in a child container of a container with a Globe

plugin.

Update Long/Lat From Position: Gets the current container location and

updates the Longitude, Latitude and Altitude parameters:

- Auto: Updates the Longitude and Latitude values when a new position is
dragged over the container and never again.

- Never: Never updates the object’s position, only Longitude and Latitude
values are updated.

- Always: Always check the object’s position and update WPosition when it
changes.

+ Follow Terrain - The height (Altitude) will be read from the terrain in case of a

terrain geometry.

Longitude Offset: Positions the object at a given offset from the actual

Longitude.

Latitude Offset: Positions the object at a given offset from the actual Latitude.

Move to Map Center: When clicked, the object will move to the center of the

parent map.

Update Lat/Long From Container Position: When clicked, the Latitude and

Longitude position parameters will be updated.:
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14 Shader Plugins

The Viz World Client (WoC) installation includes a package of plugins used for
enhancing the geographic referencing ability in Viz Artist. The WoC plugins
includes geometry, container, shader and scene plugins.

This chapter describes all shader plugins. The shader plugins are found in two
plugin folders:

Maps: Contains Standard plugins.
Texture: Contains Texture plugins.

See the following sections for more information:

Standard

3D Line Shader

Curious 3D Terrain Shader
Color Matrix

Region Halo Shader

Texture

Fade Texture

See Also

Geometry Plugins
Container Plugins
Scene Plugins

14.1
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3D Line Shader

J0LineSH
— —

2DLineShad

The plugin can be found in the following folders:
Viz Artist 2: Function -> Shader (button) -> Maps.

Viz Artist 3: Built Ins -> Shader -> Maps.
The 3DLineShader is used by the 3D Map Setting plugin to draw the borders using

the parameters set in the various 2D Label plugins. The plugin has no parameters
and it is added automatically when adding a 2D Label object to the scene tree.
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14.2 Curious 3D Terrain Shader

CiDTerr_SH

C2DTerrain

The plugin can be found in the following folders:
Viz Artist 2: Function -> Shader (button) -> Maps.

Viz Artist 3: Built Ins -> Shader -> Maps.

This shader has no configuration and is added automatically when using the Atlas
plugin.

14.3 Color Matrix

ColorMatrix

olorMatrix

1

The plugin can be found in the following folders:
Viz Artist 2: Function -> Shader (button) -> Maps.

Viz Artist 3: Built Ins -> Shader -> Maps.

Color Matrix is used to perform automatic color correction on tiles when
performing zoom operations on for example satellite imagery.

Zooming can be a problem (e.g. when zooming to street levels) as the tiles often
shift color from one level to another. Tiles also change color depending on the
size of the tile(s) used. The result will often be that the tiles look like stamps.

The color correction is done using Pyramid Control which assigns the Color Matrix
shader plugin to fix the colors.

This section contains information on the following topics:
Plugin Description
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14.3.1  Plugin Description

Figure 186: Manual, Color Matrix editor

CalorMatrix Plugin (10.0.0) [
Mode M Slave
Translate R Eﬁﬂ
Translate 5 [ 00 S
Translate B | oo Sl
Scale R -
Scale G 0 S
Seale B 0 5
Fade Factor [ oo [
Keying Mods None | Full |T Alpha l Color and Alpha |
Calor Or Alpha J
Key Color . EA E!
key Color Threshold  [IEHI =R
Ky Color Attack —% R

Mode: Sets the color matrix mode. When set to Fading, only fading of texture
edges are active. When set to Manual, all parameters of the plugin can be
managed manually. When set to Slave, all parameters of the plugin is managed
by other plugins.

Translate R,G,B: Shifts the corresponding color component.

Scale R,G,B: Shifts the corresponding color component.

Fade Factor: Sets the fade factor for the texture edges.

Keying Mode: Sets the keying mode.

- None: Color keying is disabled.

- Full: All colors are keyed out.

- Color: All colors in the range (Key Color - Key Color Threshold, Key Color +
Key Color Threshold will be keyed out.

- Alpha: All colors with the 0.0 in the alpha channel will be keyed out.

- Color and Alpha: All colors in the range (Key Color - Key Color Threshold,
Key Color + Key Color Threshold and colors with the 0.0 in the alpha
channel will be keyed out.

- Color or Alpha: All colors in the range (Key Color - Key Color Threshold, Key
Color + Key Color Threshold or colors with the 0.0 in the alpha channel will
be keyed out.

Key Color: Sets the key color used in Keying Mode.
Key Color Threshold: Sets the key color threshold use in Keying Mode.
Key Color Attack: Smoothens the key color edges.
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14.4  Region Halo Shader
E_eul-lalnﬁl-l
i, T
RegionHaloS
The plugin can be found in the following folders:
Viz Artist 3: Built Ins -> Shader Plugins -> Maps.
The RegionHaloShader is applied automatically when using the Region Halo
plugin.
Note: The plugin has no user interface.
14.5 Fade Texture
e -
FadeTexturs
The plugin can be found in the following folders:
Viz Artist 2: Function -> Shader (button) -> Texture.
Viz Artist 3: Built Ins -> Shader -> Texture.
The FadeTexture plugin is used to apply soft edges to a texture and to crop the
texture.
This section contains information on the following topics:
Plugin Description
14.5.1  Plugin Description

The plugin has three plugin editor views that enables the different Curve control
options; Constant, Spline and Uniform.

This section contains information on the following topics:
Constant

Spline
Uniform
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Constant

Figure 187: Constant curve, Fade Texture editor

FadeTexture Plugin
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Texture edges are controlled separately but no softness is applied to the texture
edges.

Crop Top: Sets the crop value for the top of the texture.

Crop Bottom: Sets the crop value for the bottom of the texture.
Crop Left: Sets the crop value from the Left of the texture.
Crop Right: Sets the crop value for the right of the texture.

Spline

Figure 188: Spline curve, Fade Texture editor

FadeTexture Plugin
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Texture edges are controlled separately and a common softness value is applied
to all edges.

Crop Top: Sets the crop value for the top of the texture

Crop Bottom: Sets the crop value for the bottom of the texture
Crop Left: Sets the crop value for the Left of the texture

Crop Right: Sets the crop value for the right of the texture
Fade: Sets the softness value for the edges of the texture.
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Uniform

Figure 189: Uniform curve, Fade Texture editor

FadeTexture Plugin
Uniform Crop 0.0 %ﬂ
Curve Cnnstant| Spline | Uniform
1~

All texture edges are controlled together with a fixed softness value applied.
Uniform Crop: Sets the crop value for all edges of the texture (fixed softness
will be added to all edges).
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15 Scene Plugins

The Viz World Client (WoC) installation includes a package of plugins used for
enhancing the geographic referencing ability in Viz Artist. The WoC plugins
includes geometry, container, shader and scene plugins.

This chapter describes all scene plugins. The scene plugins are all found in one
plugin folder:

Maps: Contains Standard plugins.

See the following sections for more information:

Standard

3D Map Setting
Label Manager
Light On Globe
Map Builder

See Also

Geometry Plugins
Container Plugins
Shader Plugins

15.1
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3D Map Setting

A0MapSetti

The plugin can be found in the following folders:
Viz Artist 2: Function -> Scene (button) -> Maps.

Viz Artist 3: Built Ins -> Scene Plugins -> Maps.

The 3DMapSetting plugin is a scene plugin used for managing borders data from
the server. The border data is retrieved from the Viz World Server (WoS), according
to the setting in the 3DMapSetting plugin, is used for applying a graphic design to
the borders in the map, drawn by the 2D Label plugins.

This section contains information on the following topics:
Plugin Description
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15.1.1  Plugin Description

The 3DMapSetting plugin has two sections of parameters (General and Border
Data) and a 3D Line button.

This section contains information on the following topics:
- General

Border Data
Window
GUI
Advanced
Buttons

General

Figure 190: General, 3D Map Setting editor

3DMapSetting Plugin (12.0.0) i
General Border Data | Window Gui Advanced

Geographic Container E
3D Global Designs Path |
3D Global Designs ﬂ
30 Global Holder E
Units Degrees I Kilometers Miles MNautical Miles |

Reset Design Holders | Update Project List | Update All map elements Sync Local Cache Folder |
2

Geographic Container: Draws the border of the selected map. Drag the
CWMClient container that defines the map area to the container place holder.
3D Global Designs Path: Sets the path to a Viz folder containg the global
designs.

3D Global Designs: Drag the global designs container to the container place
holder.

3D Global Holder: Defines the container that will hold all the global 3D objects
created from the global designs.

Units: Defines the type of units used to measure how many degrees,
kilometers, miles or nautical miles you see. The selection you make here will
affect your Navigator’s Height Units setting and the label appearance Units in
the Label Manager plugin (see Definitions).
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Border Data

Figure 191: Border data, 3D Map Setting editor

3DMapSetting Plugin (12.0.0) i
General I Border Data Window | Gui | Advanced
World None Full
Additional Region Data None Country Region | Sub-Region |
Region List
Americas
. . Asia
Region List Europe
Middle East
North America
Oceania |
o DU A S . r'-l
Country Borders Internal | Coastline | Both
Rebuild | Rebuild (Force New) |
Reset Design Holders | Update Project List | Update All map elements | Sync Local Cache Folder
2

World: Defines if the border data will be fetched for the entire world (country
borders) or other data as defined in the Additional Region Data parameter.

- None: Retrieves the border data as defined in the Additional Region Data
parameter.

- Full; Retrieves the country borders data for the entire world (country
borders only).

Additional Region Data: Defines additional border data that will be retrieved
from the server with the data defined in the Wor/d parameter. The additional
data will be limited to the selected region in the Region List parameter.

- None: No additional data will be used.
- Country: Country borders data in the selected region area will be used.
- Region: Region borders data in the selected region area will be used.

- Sub-Region: Sub-Region borders data in the selected region area will be
used.

Region List: Defines an area of the world for which the additional region data
will be retrieved from the server. The parameter limits the data size retrieved
from the server.

Rebuild: Retrieves the information from the Viz World Server (WoS).

Rebuild (Force New): Recreates the data on the Viz World Server (WoS) and
saves it to the cache folder, even if cached data already exists.
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Window

Figure 192: Window, 3D Map Setting editor

3DMapSetting Plugin (12.0.0) i
General | Border Data | Window Gui Advanced
Window Active an
Effect Cullling on Off
Window Mode Manual | Camera | Image
Window Units Percents Pixels
Window Width % [ 1000 IR

Window Center Offset X % mi‘ﬂ
Window Center Offset ¥ % milﬂ
_on [ of —
o0 BN

Contraol Win Mask
Window Mask Scale %

Show Debug Window Mask off
Reset Design Holders | Update Project List | Update All map elements Sync Local Cache Folder

]

Window Active: Enables the user to define an area in the renderer as an active

window. All maps data created by the Viz World Client will be redrawn to fit

into the defined window. When set to ON additional paramters will be enabled:

- Effect Culling: Defines if the window will effect the culling of the vector data
(streets, borders, etc.).

- Window Mode: Defines the source of the window aspect: Manual sets the
window aspect to be user defined, Camera sets the window aspect to be the
same as the render window, and Image sets the window aspect to be the
same as the the image aspect of the map.

- Window Units: Defines the units used to set the window size and position.
When set to Percents, the window size will be calculated as the defined
percentage of the Viz render window size. The window position will be
calculated as the defined offset percentage of the render window.

- Window Width: Defines the width of the window in percents or pixels.

- Window Height: Defines the height of the window in percents or pixels. This
parameter is enabled only if window mode is set to Manual.

- Window Center Offset X: Defines the X position (percents or pixels) of the
window in relation to the render window (center to center).

- Window Center Offset Y: Defines the Y position (percents or pixels) of the
window in relation to the render window (center to center).

- Control Win Mask: Defines if a WindowMask plugin (added to the map) will
be controlled by the 3DMapSettings plugin to mask the defined window or
not.

- Window Mask Scale: Defines the scale of the mask over the defined window.

- Show Debug Window Mask: When enabled (on), a red rectangle around the
defined window will be displayed.

GUl

GUI defines general parameters for controlling container names and container
colors in the Viz GUI (effecting the Viz scene tree display), and the creation of
Control Channels from added Viz World Client objects. The Control Channels in
Viz are displayed under the Control tab and serve as an index for the scene tree.
For additional information about Control Channels please refer to the Viz Artist
user guide.
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Figure 193: GUI, 3D Map Setting editor

3DMapSetting Plugin (12.0.0) i
General | Border Data | Window Gui Advanced

Hops None Control | Name Full

Designs None Control Name Full
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Hops: Defines GUI parameters for hop containers in the scene tree:
- None: No control channel or name conversion will be applied to the hop

containers.

- Control: Only a control channel will be added for the hop containers.
- Name: The created hop containers will be named Hop-1, Hop-2, etc.,

according to the hop point selected in the NavFinder plugin. No control
channel will be added.

- Full: A control channel will be added for every hop container and the hop

containers will be renamed Hop1, Hop2, etc.

Designs: Defines GUI parameters for any design containers (region designs,
road designs, label designs, and so on) in the scene tree:

- None: No control channel or name conversion will be applied to the design

containers.

- Control: Only a control channel will be added for the design containers used

in the scene. The containers will not be renamed.

- Name: The design containers (dragged to the CWM Client plugin) will be

renamed Label-Designs, Region-Designs, and so on. No control channel
will be added.

- Full: A control channel will be added for every design container and the

design containers will be renamed.

Holders: Defines GUI parameters for any object holder containers (regions,
roads, labels , and so on) in the scene tree:

- None: No control channel or name conversion will be applied to the holder

containers.

- Control: Only a control channel will be added for the holder containers used

in the scene. The containers will not be renamed.

- Name: The holder containers (dragged to the CWM Client plugin) will be

renamed Label-Holder, Region-Holder, and so on. No control channel will
be added. If the holder container is dragged to a hop CWM Client, it will be
named with a sufix indicating the hop number: Label-Holder-H1, Label-
Holder-H2, and so on.

- Full: A control channel will be added for every design container and the

Holder containers will be renamed.

Hops Color: Sets the color index, as defined in the User Interface parameter in
Viz Config (Viz 3 only), that will be used for the Hop containers in the scene
tree.

Design Color: Sets the color index, as defined in the User Interface parameter
in Viz Config (Viz 3 ONLY), that will be used for the design containers in the
scene tree.
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Holder Color: Sets the color index, as defined in the User Interface parameter
in Viz Config (Viz 3 ONLY), that will be used for the generated objects holder
container in the scene tree.

Advanced

Figure 194: Advanced, 3D Map Setting editor

3DMapSetting Plugin (12.0.0) i
General | Border Data | Window | Gui I Advanced
Culling Threshaold Largest Large Medium Small | Smallest |
Polygon Quality High Medium Low I Auto

Polygon Quality Factor (6] i‘ﬂ

Reset Design Holders | Update Project List | Update All map elements | Sync Local Cache Folder |

]

Culling Threshold: Sets the size of polygons to be culled (not rendered). It is
generally better to cull small polygons as they may not look good when
rendered.

Polygon Quality: Defines the quality of the drawn border lines. The higher the
quality the smoother the line will be.

Polygon Quality Factor (%): Enables the user to change the automatic polygon
quality levels by setting a factor that will change the border quality. Values
under 100% will decrease the quality of the lines. Values above 100% will
increase the quality of the lines.

Tip: For more information about Viz Config and its configuration options, see the Viz
Engine Administrator’s Guide.

Buttons

Reset Design Holders: Cleans up all design holders (labels, regions, borders
and so on).

Update Project List: Updates the list of Viz World map projects available to the
designer. By default Viz Artist always checks the Viz World Server for a list of
projects and if a a scene is opened and its project does not exist an error
message is displayed. However, if a project is added after Viz Artist is started
you can click the Update Project List button in order to update Viz Artist and to
avoid the error message.

Update All Map Elements: Checks all map elements in the scene (CWM clients,
Place finder and so on) and refresh them.

Sync Local Cache Folders: Synchronizes the local cache folder with the primary
cache folder. For more information see Maps Configuration.
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Label Manager

LabelMgr

RIT A
., TARA
s I o
LabelManag

The plugin can be found in the following folders:
Viz Artist 2: Function -> Scene (button) -> Maps.

Viz Artist 3: Built Ins -> Scene Plugins -> Maps.

The LabelManager plugin is a scene plugin, used for retreiving label information
from Viz World Server and control the label’s appearance when working in an
automatic label mode. The LabelManager generates labels, based on the defined
label designs, according to parameters defined in the Navigator plugin, Label It
objects and 2D Label objects in the label designs.

In order for the Label Manager to resolve conflicts it needs different presets to
work with. The more presets and the bigger difference between them the better
chance overlaps are resolved. When working with Label Manager please pay
attention to and check all presets it uses to make sure that they are acceptable for
the plugin. Do not create a preset where the label is under the marker if you do
not want to see it. Labels without markers (e.g. country) can have presets as-well
which means their position can change slightly.

Label Manger basically has two ways of detecting conflicts:

1. Based on the marker (zero size) labels (bounding box) and the line between
them. You set this for the 2D Label (see Special, Collision Mode = Tip Based)
and when used with good and different presets it will solve almost any
problem, but if a you have a big marker there is always a chance of a marker
overlap.

2. Based on the bounding box, the entire (square) bounding box is calculated
and used. In this case there is less chance of resolving conflicts but you will
have no overlaps.

This section contains information on the following topics:
Plugin Description

Plugin Description

Map Data
Auto Labels
Definitions
Shadows
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Map Data

Figure 195: Map Data, Label Manager editor

LabelManager Flugin (12.0.0) i
Map Data Auto Labels | Definitions Shadows
Type Other Roads
Secondary Roads
Main Roads
L T s T P
Life Span Full Long | Regular Short Manual
Auto Labels Off On
Recalculate Take Current Height
]

The Map Data tab defines settings for the label types received from the Viz World
Server (WoS). These settings will be used when calculating label appearance in
automatic mode. For every type of label selected in the list, set the required
parameters.

Type: Sets the type of labels data to display.

Start View: Defines the map size from which the labels of the selected type will
appear during the Navigator animation. Parameter units are defined in the
Definitions tab’s Units parameter.

Life Span: Defines the duration of the label appearance on screen. Note that

this setting is most useful for country and region types.

- Full: The label appears at the defined Start View and remains on screen
throughout the entire animation.

- Long: The label remains on screen for a long period of time.

- Regular: The label remains on screen for a medium period of time.

- Short: The label remains on screen for a short period of time.

- Manual: The label remains on screen until the defined End View value is
reached.

End View: Defines the map size at which the labels of the selected type will

disappear. This parameter is only enabled if the Life Span is set to Manual.

Parameter units are defined in the Definitions tab’s Units parameter.

Note: The Label Manager plugin controls and manages the automatic labels
appearance, using various parameters from different plugins. The Life span and
Auto Label parameters will vary between labels during the animation (hop), to
optimize labels display.
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Auto Labels

Figure 196: Auto Labels, Label Manager editor

LabelManager Flugin (12.0.0)

Map Data I Auto Labels Definitions Shadows

Aute Labels Disabled Enabled | Interactive
Manual Labels No WOos | File | wosaFile |
Road Labels 0-None | 1 2 | 3
Street Labels Style | iz Designs Internal (Open Gl) |
Labels Visibility (%) il R
Gap For Same street Name % milﬂ
3D Designs & Holder Local Global

Designs |

Designs E

Holder E

Recalculate Take Current Height
I [

The Auto Labels tab defines if automatic labelling will be enabled and the label

designs used for automaic labelling.

Auto Labels can be limited to specified countries and/or regions. The format of

valid input is:
-’ between locations.
‘/” or ‘\’ to specify the path to the regions.

Some examples:
« USA;Mexico

USA\TX;Mexico;Canada

United States of America\Florida;United States of America\Georgia;USA\NY

Auto Labels: Sets the auto labels mode to disabled, endabled or interactive.
- Disabled: No automatic labelling will be used in the scene.

- Enabled: The scene will use automatic labelling based on the defined
designs and labels holder container.

- Interactive: Enables the Auto Labels Quantity.

Auto Labels Quantity: Allows you to set the amount of labels that should be
shown. Few will show approximately 75 labels (or less), Average 100 labels (or
less) and Many 150 labels (or less). Manual sets the distance where the labels
should appear (see Start View under Map Data) providing a consistent behavior
(e.g. Town 1K will always appear/disappear at the same distance).

Manual Labels: Defines if manual labels, defined for the map, will be displayed
with the auto labels. When Enabled is set, the Select Manual Labels button will
appear at the bottom of the editor. When clicked, WME will open, enabling the
user to set manual labels.
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Road Labels: Defines the level (number) of road labels that will be displayed.
Select the required option, ranging from 0-None to 5-All.

Street Labels Style: Defines the label style of the scene. Options are Viz Design
and Internal (Open GL) labels.

- Viz Design: If set to Viz Designs you can define your own Viz labels. Note
that this limits the number of labels that can be used before Viz. Depending
on your system 300-500 labels may cause Viz Engine to not render in real
time. Using Viz Design will also give you the option to set other parmaters
such as the visibility of the label and local and global placeholders for your
label design (see 3D Designs & Holder).

- Internal (Open GL): If set to internal you may use up to 100.000 labels;
however, this will limit your design options to the font used and relative
position and scale. When used with the Street Labels plugin this setting will
only work for Navigator scenes.

3D Designs & Holder:

- Designs (text field): Defines a path in Viz’s objects database that contains
label designs. Automatic label designs are based on 2D Label and Label It
plugins.

- Designs (place holder): Displays the selected (drag&drop) top container
holding the label designs.

- Holder (place holder): Displays the selected (drag&drop) container that
resides under the map. This container will be used by the Label Manager
plugin to store the scene’s generated labels.

- Limit Auto Labels: Defines if the auto labels will be limited to a defined
region/s or not. When enabled, the Limit To Region text field will be
enabled.

- Limit To Region: Defines the region to which the auto labels will be
generated.

Definitions

Figure 197: Definitions, Label Manager editor

LabelManager Plugin (12.0.0) i
Map Data | Auto Labels | Definitions
Intersection Mode Full Offsets | None |
Screen Culling Mode Center Anything Complete |
Map Culling Mode Disabled Enabled
Ignore Distance Rules For User Added Labels Disabled Enabled
Units Degrees I Kilometers Miles | Iy
Fade Time (Fields) B
Labels In Overlay Disabled I Enabled
Label Camera )
Debug Info Mode Disabled Accepted | Rejected
Recalculate Take Current Height
]

The Definitions tab is used to set general parameters for Label Manager
behaviour.
Intersection Mode: See Map Data.
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Screen Culling Mode: Defines if a label will be drawn when it is outside the Viz

renderer’s scope/view.

- Center: The label object fades out when the center of the object is outside
the Viz renderer’s scope/view.

- Anything: The label object fades out when any part of the object is outside
the Viz renderer’s scope/view.

- Complete: The label object fades out when the entire object is outside the
Viz renderer’s scope/view.

- None: No culling will be used. The labels will be drawn according to the map
data parameters only.

Ignore Distance Rules for User Added Labels: When Enabled labels that are

associated with a hop will ignore the distance rules that apply to their type.

Map Culling Mode: Defines if a label will be drawn when it is outside the map

area but inside Viz renderer’s scope/view.

Units: Defines the units used to calculate map size for the Start View and End

View parameters. Available options are Degrees, Kilometers, Miles and

Nautical Miles, where the default measurment unit is Kilometer. Note that this

setting is also affected by the Units option in the 3D Map Setting plugin (see

General).

Fade Time (in fields): Defines the label’s fade duration in fields.

Labels in Overlay: When enabled the labels will be in a different layer (dynamic

image/layer). When disabled the labels will be on the map.

Label Camera: Defines the camera that will be used to draw the labels

(normally camera 2).

Debug Info Mode: Shows different levels of debug information regarding the

auto layout.

Shadows

Figure 198: Shadows, Label Manager editor

LabelManager Plugin (12.0.0) i
Map Data | Auto Labels | Definitions W
Cast Shadows off on
Light Type ’m Spot
Horizontal Angle milﬂ
Vertical Angle milﬂ
Distance _ il
Shadow Plane Stright - Up Tilt Down Tilt IW World
Tangent Point Bottom Middle Top
Shadow Pan milﬂ

Shadow Tilt
Shadow Distance

Shadows Camera

Show Light Direction

| o0 S

| o0 SN
15wl

_of

Arrow Lit Ball

Intersection Mode: See Map Data.
Cast Shadows: Turns option to cast label shadows on/off.
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Light Type: Simulates different light types to cast the shadows.
Horizontal Angel: Defines the horizontal angle position of the light.
Vertical Angel: Defines the vertical angle position of the light.
Distance: Defines light distance.

Shadow Plane: Casts planar shadows on an imaginary plane and this option
defines the spatial rotation of such a plane. Select one of the options:

- Straight: The casted plane is parallel to the screen.

- Up Tilt: The casted plane is tilted 45 degrees up from the screen.

- Down Tilt: The casted plane is tilted 45 degrees down from the screen.
- Manual: Manually set the pan and tilt values of the casted plane.

- World: The casted plane is tangent to the world.

Tangent Point: Pivot point for connection shadow to object.

Shadow Pan: Manual Shadow Pan.

Shadow Tilt: Manual Shadow Tilt.

Shadow Distance: Distance of the shadow plane from the object.

Shadows Camera: Select a camera for rendering the shadows. Since shadows
are done by first rendering objects in a distant place and then overlaying their
black silhouettes on the screen, this option defines the camera that will look at
such distant place where objects are rendered. (Actually this camera is used
for overlay).

Show Light Direction: Visualize light direction on screen or not. The light
direction is visualized by showing a lit ball or an arrow.

15.3 Light On Globe

. 1
[

Li-;T'ltDnGlul:l
The plugin can be found in the following folders:

Viz Artist 2: Function -> Scene (button) -> Maps.
Viz Artist 3: Built Ins -> Scene Plugins -> Maps.
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Figure 199: Light on globe example

The LightOnGlobe plugin is a scene plugin used for applying light sources to a
globe object. The plugin is required when designing a Aops scene and the
animation is going from the lighted area of the globe to the dark area of the
globe. When using the LightOnGlobe plugin, the lights will follow the camera
animation. The light sources are Viz lights, and the lighting parameters should be
adjusted in the Viz light editor. The LightOnGlobe plugin will lock the light
sources to the selected camera in the plugin parameters.

This section contains information on the following topics:
Plugin Description
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Plugin Description

Figure 200: Light On Globe editor
LightCnGlobe Plugin @I

Camera ==l

Key Light Type Local I Spot Infinite I off |
Key Light &ngle j R_

Key Light Elevation

Distance Scale

Attenuation

Back Light Type Local Spot | Infinite off
Back Light Angle

Back Light Elevation 40.0
30 mald

Fill Light Type m Spot | Infinite Off
Fill Light Angle R
Fill Light Elevation R
R

Distance Scale

Distance Scale

| Infinite | Qff

Camera Light Type

Camera Light Horizontal Shift

Camera Light Vertical Shift

Toggle Mode Static ID}rnami:

Camera: Sets the camera number for setting the light sources. The light
sources will be locked to the selected camera number.

Key Light Type: Sets the main light source type. Available types are Local,
Spot, Infinite or None.

Key Light Angle: Sets the angle of the key light source, which is the longitude
value for the center of the light projected on the globe.

Key Light Elevation: Sets the elevation of the key light source, which is the
latitude value for the center of the light projected on the globe.

Distance Scale: Sets a scale value on the globe distance so the light can be
closer or further away.

Attenuation: Sets the level of light attenuation.

Back Light Type: Sets the back light source type. Available types are Local,
Spot, Infinite or None.

Back Light Angle: Sets the angle of the back light source, which is the
longitude value for the center of the light projected on the globe.

Back Light Elevation: Sets the elevation of the back light source, which is the
latitude value for the center of the light projected on the globe.

Distance Scale: Sets a scale value on the globe distance so the light can be
closer or further away.
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Fill Light Type: Sets the fill light source type. Available types are Local, Spot,

Infinite or None.

Fill Light Angle: Sets the angle of the fill light source, which is the longitude

value for the center of the light projected on the globe.

Fill Light Elevation: Sets the elevation of the fill light source, which is the

latitude value for the center of the light projected on the globe.

Distance Scale: Sets a scale value on the globe distance so the light can be

closer or further away.

Camera Light Type: Sets the camera light source type. Available types are

Local, Spot, Infinite or Off. The camera light will follow the camera

movements.

Camera Light Horizontal Shift: Sets the horizontal shift of the light source in

relation to the camera location.

Camera Light Vertical Shift: Sets the vertical shift of the light source in relation

to the camera location.

Toggle Mode: Sets the lights behavior mode during camera movement:

- Static: All light sources, except for the camera light, will remain in a fixed
location in relation to the globe.

- Dynamic: All light sources will keep a fixed location in relation to the
defined camera (that is it will move with the camera).

15.4

270

Map Builder

MapsBuilg

MapBuildar

The plugin can be found in the following folders:
Viz Artist 2: Function -> Scene (button) -> Maps.

Viz Artist 3: Built Ins -> Scene Plugins-> Maps.

Map Builder is a wizard like solution, with a simple and easy interface to create
generic map scenes.

The Map Builder solution consists of 2 major parts:

1. Map Builder Plugin - is a Viz Artist scene plugin that builds a scene from a map
template (*.mtpl) file, and saves the map scene changes to the map template
file.

2. Map Builder Wizard - is a simple user interface that allows the user to create a
scene descriptor (*.mtpl files) that represents a map scene and its containing
elements. The wizard is accessible from within Viz Artist, and as a standalone
application (see C:\Program Files\Vizrt\Common\Maps\MapBuilder.exe).

This section contains information on the following topics:
Plugin Description

Map Builder Wizard
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15.4.1  Plugin Description

Figure 201: Map Builder editor
MapBuilder Plugin (10.0.0) @

Map Template filename C:/MapTemplate.mtpl

Rebuild Scene |

Launch Wizard |

Clean Scene |

Build Scene From Scratch |

Map Template Filename: Sets the name of the scene template file or click the
browse button to select a file.

Build Scene: Updates the scene tree with changes from the wizard.
Launch Wizard: Runs the MapsBuilder wizard application.
Clean Scene: Cleans the scene heirarchy.

Build Scene From Scratch: Cleans the scene tree and rebuilds the scene
heirarchy using the defined map template file.

15.4.2 Map Builder Wizard
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In general, a map scene consists of a few basic elements, built in this order:

Create a Base Map.

Define the Navigation.

Create a Destination List.

Define label, region and border Designs.

Set the map Orientation.

Configure the design source and object pool Settings.

Refresh Thumbnails when re-launching the wizard to make changes.

NOoO uvih WN —

This section contains information on the following topics:
- Base Map

Navigation

Destination List

Designs

Orientation

Settings

Refresh Thumbnails

To import basic map elements

Base Map

Map type: | Globe

Ressolution: | SD 4:3 L

Labels: MNone Managed | Automatic

Base Map is the Globe/Flat World Map in a specific style and data. The map
created at this level is usually good for country level view.

Navigation

Global hop settings

Hop hase d

Hop dur

Defines the camera’s trajectory animation setting. It describes how the navigation
animation should be (e.g. map origin + 3 destination animations, each “hop”
animation based on 5 seconds, with stop points between destinations).
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Destination List

Move: 4 W

Map Origin

Barders

Type: Pyramid of maps Hop Duration: Control: [

Labels and regions Map elements. - misc
On Map Labels Loads Tesrain

0Oin Screen Labels

Defines if each destination could be of type Geo Position Only, Map - Single Image
or Pyramid of Maps.

A Geo Position Only destination will only use a Geo Position reference to the
navigation. This mode is useful for destinations that are always far away from the
base map. No map will be created in this mode (as it will save texture memory).
Note: When destination is set to Geo Position Only, it cannot be controlled by an

external application such as Viz Trio or Viz Content Pilot.

Map - Single Image enables operators to control a destination using an external
application (either a Map or Pyramid has to be selected). If the selected
destination is used for a reference point, and it needs to be controlled, use this
type (e.g. a far away starting point).

Pyramid of maps is used when the base map is not suitable for close-ups. A
pyramid of maps built around the destination will smoothen the resolution
difference between the base map and the destination target.

Each destination can consist of map elements (labels, regions and miscellaneous
map elements), and if it is controlled (e.g. by Viz Trio or Viz Content Pilot)
destinations can be linked to each other - to allow the user to easily control
multiple destination elements. Linking is on/y a help to the user and has no effect
on the scene.

Copying (duplicating) a destination is possible by selecting a destination and
clicking the add button.

Note: The selected destination will not be duplicated if the destination type is Geo
Position Only.
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Designs
On map labels design

Town labels: | Capital

Region labels: | Any Region

Miscellanies labels: | Any Location

On screen label design

Town labels: | Town = 100K
Regions labels: | Region

Miscellanies labels: | Place

Reqgions and borders design

Regions settings: | Sub Region
Border setfings: | Sub Region
Border color:  Unified [ Per type
Line settings: |

Area settings: |,

Describes how complex and complete the map elements designs will be, the
Designs part is divided into 3 major groups:
On map labels.

On screen labels design.
Regions & borders design.

Each design group can be customized; however, in addition they also have four (4)
predefined presets: None, Simple, Detailed and Complete.

To distinguish on a country level using Region labels, it is possible to select the
Country option as this will create two region label designs:
- Country - designs for selected countries.

- Any Region - for all other regions labels.

To distinguish between major towns, capitals and all other towns, it is possible to
select the Town > 1M option as this will create three town label designs:
- Town > 1M: for major towns.

- Capital: for country capitals.
- Any Town: for all other town types.
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Orientation

Orientation

" | Add orientation map

Center map [ Locator

Orientation is a small map in the bottom corner of the screen, which shows a
small world map and a marker showing what part of the world is currently being
navigated to.

Settings

Settings

Designs source: flln ;Scene Object Pool

Objects pool path: | Default Custom

User folder:

Allows the user to specify the design source and object pool path.

Designs source is an option that allows designs to be shared between scenes by
using the Object Pool, instead of the in-scene designs.

Object Pool Path is an option to specify an alternative Viz Graphic Hub or Object
Pool folder instead of the default object path (/vizrt/VizCuriousMapsClient/
MapBuilder).

Note: A custom Object Pool Path must use the same hierarchy structure as the

default object path (see /vizrt/VizCuriousMapsClient/MapBuilder).

Refresh Thumbnails

-

Refreshing Thumbnails must be done after manually editing a wizard generated
scene and re-launching the wizard as all thumbnails of maps (Base Map,
Destinations and Orientation) are lost. In order to refresh them press the F5 key,
or click the refresh button in the toolbar.
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To import basic map elements

1. Start Viz Artist.
2. Click Import and select Archives from the drop-list

3. Navigate to C:\Program Files\Vizrt\Common\Maps\Archives, and select the
VizCuriousMapsClientObjects3x.via archive.

4. Click Import Archive.
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16 Geographically Referenced Maps

Figure 202: Geo Maps, Viz Artist 3.x.

Server Built Ins Control
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CWM Client plugin produces geographical maps (geo maps). Geo maps are images
of maps that are geographically referenced (that is the image contains
information about its longitude and latitude).

Figure 203: Geo Maps icon, Viz Artist 2.x.

eUrope

Geo maps are identified by a little globe icon next to the image icon. Containers
that will be placed under the GeoMap container and using geographic data
referencing will be placed relatively on the GeoMap.

Do not scale, rotate or change the position of the image in the image editor.
Changing any of these parameters will result in loss of the image’s geographical
reference.

All modifications should be done in the container properties editor.
The geo map can be placed on any Geometry Object; however, the geographical
referencing will not be correct when placed on 3D objects other than Globe. It is

recommended, for best geographical referencing results, to use Geolmage, Globe
or terrain objects.
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17 Viz World Plugin API

The Viz World Plugin API offers an easy to use geo-reference capability when
building your own Viz Artist plugins. The API allows you to communicate and
manipulate Viz World scenes and get Navigator information.

This chapter has information on the following topics:
Including the API

Working with the API
Best Practices

17.1 Including the API

This section explains where the APl can be found and how to include it to your
development environment in Microsoft Visual Studio.

The Viz World Plugin API files are installed at:
Windows 7: C:\Program Files (x86)\Vizrt\Common\Maps\API

Windows XP: C:\Program Files\Vizrt\Common\Maps\API

To use the API, Visual Studio 2005 SP1 and later is required. Examples showing
how to use the API are located under the Examples directory. The exmaples
provide Visual C++ 2005 SP1 and 2010 solutions.

To use the API in you plugin

1. Add the path ApI\Include to the include directories

2. Include the File VizWorld.h

3. Link to the appropriate library file based on the Viz configuration you use
+ Viz 3.x: Lib\VizMapsManager 3.x.lib
« Viz 2.x: Lib\ VizMapsManager 2.x.lib

See Also

Working with the API
Best Practices

17.2  Working with the API

This section contains short descriptions on how to use the APl and what it does.
For more information see the following topics:

VWPosition
VWMousePosition
VWNavigatorControl
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See Also

Including the API
Best Practices

17.2.1  VWPosition

Can be used to to position a container based on a longitude/latitude coordinate
on a geo-referenced map.

To use VWPosition

1. Add a geo-referenced map on a container (using Geolmage/Globe geometry)

2. Add a child container to the newly created container with a geometry and the
VWPosition plugin

3. Changing the longitude/latitude will update the position of the new container

17.2.2 VWMousePosition

Can be used to translate a Mouse position into a longitude/latitude coordinate.

To use VWMousePosition

1. Add a geo-referenced map on a container (using Geolmage/Globe geometry)

2. Add a child container to the newly created container with a geometry and
VWMousePosition plugin

Click the E button (events button next to the Scene Editor)
4. Click on the map and see that the new container moves to the coordinate

w

17.2.3 VWNavigatorControl

Can be used to get or set Navigator values.

To use VWNavigatorControl

1. Create a Navigator scene

2. Under the scene‘s GeoReferenceMap container, add a new container with a
VWNavigatorControl

Clicking the Update Geo Ref Data button will read navigator current values
4. Changing one of the plugin’s fields will set Navigator values

w

17.3 Best Practices

When using a geo-reference (VWGeoref object it is best to use a class member
that will be initialized in the constructor or only when you would like to explicitly
do a refresh, doing so on the ExePerField will impact performance.

The scene object (VWScene) has to be initialized in the constructor and has to be

freed on the destructor, avoiding to do so will result a performance impact as Viz
World’s memory consumption will not be freed.
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Example

class MyPlugin
private:
VWScene * m_pVWScene;

MyPlugin: :MyPlugin ()

m pVWScene = VWScene::AddVWScenelInstance (this) ;
MyPlugin: : ~MyPlugin ()

VWScene: :RemoveVWSceneInstance (m_pVWScene, this);

See Also

« Including the API
- Working with the API
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18 Viz World Server REST Support

This section contains a list of searches and functionalities of Viz World Server that
can be accessed with a Representational State Transfer (REST) architecture using
the atom protocol.

The Viz World Server has the following entry point:
http://<hostname>:10301/Directory
This section contains information on the following topics:

Browsing Regions

Browsing Projects and Favorite Folders
OpenSearch Support

Place Finder

18.1 Browsing Regions

Viz World Server allows browsing regions (e.g. administration levels country,
adminl1, admin2) by form of returning a feed that represent each region and
contains entries for each sub-region (or if none, entries representing towns in
that region).

Each entry contains an atom description of the region, link to its feed, links to
towns contained in that region, link to a map of the region (using the Place Finder
functionality shown later) and an XML representation that is used by the Viz World
clients.

The below URL is the main URL that returns a feed of all countries.

http://<hostname>:10301/Browse

The below URL is an example region URL that returns a feed containing an entry
for each sub-region of the queried region. If no sub-regions exist, a list of towns
in that region wil be returned.

http://<hostname>:10301/Browse?id=91296a0a00000600

The following describes the main fields (XML tags) of each entry:

Id: Viz World database unique id of the region/town.
Title: Viz World database name of the region/town.

Summary: http text containing feature details - thumbnail, feature type, name,
link to map (using Place Finder URL), link to major/minor/both towns of the
region (if exists).

Content: Contains an xml representation of the feature, containing
information like log/lat, full region description (i.e. “Paris France” for Paris),
feature type and more information that the querying application might need.
Link (down): Contains the same link as the link (alternate). Required by Viz
FeedBrowser.
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Belgium
18:22 2010 "2 07 whan O

Countey

Get Image
See Towns: 13 Major Towns

The summary (depicted above) is displayed in browsers like this (circled in red).
For more details, see the XML Example below.

Example

<entry>
<1d>1000000000001200</1id>
<title type="text">Belgium</title>

<summary type="html">&lt;table&gt;&lt;tr&gt;&lt;td&gt;

&lt;img src="http://<hostname>:10301/FeatureThumbnail/
?feature=Country"&gt;&lt;/td&gt; &lt;td&gt;Country&lt;br&gt;&lt;a
href="http://<hostname>:10301/PlaceFinder/?Search=(null) "&gt;Get
Image&lt;/a&gt;&lt;br&gt;See Towns:&lt;a href="http://
<hostname>:10301/Browse/?1d=71£2d1c100001200&amp; filter=Capital, Town
1m, Town 100k"&gt;13 Major Townsé&lt;/a&gt;&lt;/td&gt;&lt;/tr&gt;&lt;/
table&gt; </summary>

<updated>2010-07-07T15:22:39Z</updated>
<author><names>VizWorldServer</name></authors>

<thumbnail url="http://<hostname>:10301/FeatureThumbnail/
?feature=Country"/>

<link rel="up" type="application/atom+xml;type=feed" href="http://
<hostname>:10301/Browse/"/>

<link rel="self" type="application/atom+xml;type=entry" href="http://
<hostname>:10301/PlaceFinder/?Search=Belgium"/>

<link rel="alternate" type="application/atom+xml;type=feed"
href="http://<hostname>:10301/Browse/?id=71£2d1b900001200" />

<link rel="down" type="application/atom+xml;type=feed" href="http://
<hostname>:10301/Browse/?id=71£2d1b900001200" />

<content type="application/atom+xml;type=feed">
<MapFeature>
<FeatureID>1000000000001200</FeatureID>
<Name>Belgium</Name>
<DBName>Belgium</DBName>
<AlterName>Belgium</AlterName>
<Type>Country</Type>
<GeoPoint>4.466875, 50.259453</GeoPoint>
<Diameter>280.409729</Diameters>
<FullDesc>Belgium</FullDesc>
</MapFeature>

</content>

</entry>

18.2  Browsing Projects and Favorite Folders

Viz World Server allows browsing folders of projects (tpl files) and favorites (cxp
files) that are stored in the browser.
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A folder feed contains an entry for each sub-folder and project/favorite contained
in the folder.

A project feed contains an entry for each stylesheet contained in the browser. A
favorite link and project-style link returns an image of the favorite/style.

Main URLs:
http://vizworldserver:10301/ProjectsFolder/
http://vizworldserver:10301/FavoritesFolder/

Each favorite/project/style entry also contains a thumbnail tag that contains a
URL of a thumbnail image of the project/favorite/style for use by Viz
FeedBrowser. The thumbnail URL is also included in the summary of the entry, for
use by browsers.

18.3 OpenSearch Support

Viz World Server supports using OpenSearch to search features in the server
database, plugins and web.

OpenSearchDescription URL:
http://<hostname>:10301/0OpenSearchDescription

OpenSearch template:

http://<hostname>:10301/
OpenSearch?q={searchTerms}&pw={startPage?}&visible={viz:visible?}&filt
er={viz:filter?}&source={Internal/All/MapDB/ExtraData/Web}

Examples URLs:
http://<hostname>:10301/g=Paris&filter=Capital&source=MapDB
http://<hostname>:10301/g=Salem&filter=Town 10k

18.4 Place Finder

Viz World Server allows receiving maps of locations/features, same as the Place
Finder plugin. This can be used by Escenic or any other web application, or for
demonstrations of Viz World.

Example URLs:
http://vizworldserver:10301/PlaceFinder/
?Longitude=40.0&Latitude=40.0&FrameMapBy=Country&AddRegions=Full
http://vizworldserver:10301/PlaceFinder/
?Search=USA&MapWidth=1000&MapHeight=500&AddSearchlLabel=1

Most parameters are taken from the configuration server (and stored in registry).
Upon first use (or if missing in registry) the default values below are used. For
parameters that are not stored in registry use the default values below.

ProjectName: Desired project (default is VizDefProject.tpl)
Style: desired stylesheet

MapWidth: Sets the width of the map (default is 512)
MapHeight: Sets the height of the map (default is 512)

Longitude, Latitude: Defines the center of the map if Search is empty (default
is 0.0, 0.0)

Search: Desired feature name
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AddSearchlLabel: If search is used, adds the found label to the map.

DefaultMapSizeDeg: Size of map to be retrieved in degrees (used when
FramMapBy = DefaultMapSize)

FrameMapBy: Can be DefaultMapSize, Country, Admin1, Admin2 or Search
PlaceText: Add text label to map (if not empty)

FullDescription: Displays full-description feature labels (i.e. “Paris France” for
Paris)

AddRegions: Can be Disabled, FrameOnly, FrameAndBelow or Full
Returnimage: 1 for image (default), O for representing xml
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19 Frequently Asked Questions

This section contains some of the frequenctly asked questions concerning the use
of Viz World Client and Server.

I can connect Client A to the map server, client B is able to ping the map

server, but Client B still has no connection to the map server. What is wrong?

- Sometimes, a machine is not accessible to all other computers in the
network by its hostname.

- For example, if there are two clients, Client A & Client B, and the Viz World
Server and the Server Allocator running on the MapServer machine, Client A
might resolve MapServer to the IP 192.168.1.100, but Client B might not
resolve it to the same IP, or might not resolve it at all because ClientB is on
another subnet or for any other given reason.

- Both clients can access the MapServer if it was defined as 192.168.1.100 or
MapServer.company.domain.

- A frequenct problem is therefore that users might write in Client B’s Viz
Config the IP 192.168.1.100, and in Client A’s Viz Config MapServer
(because that is the address each can resolve); however, this will result in
that the Server Allocator will return to both clients the same hostname that
was specified in the Server Launcher Configuration tool and therefore only
accessible to ClientA.

- In other words, in the field of ControledMapServer, the hostname/IP that is
specified has to be known to all clients and the Server Allocator machine.

| have problems loading my map scenes in Viz Trio?

- Map scenes often use a large amout of texture memory; hence, this will take
time to load and might cause Viz Trio’s local preview channel to time out.

- In Viz Trio it is possible to adjust the Viz Engine Connection Timeout for the
local preview channel.

- Click the Config button, and under the Miscellaneous section select Local
Viz Renderer, and set the Viz Engine Connection Timeout parameter.

Note: There is no such setting for the Viz Content Pilot (VCP) client as the VCP client
itself does host the Viz process for local preview

- What are the Digital Globe proxy and firewall configuration settings?
- If you need to use a proxy, remember to set your Proxy Server settings.

-+ All communication to Digital Globe servers goes through https to
services.digitalglobe.com because https encrypts the entire request
(i.e. both header and body) .

- Ask your IT department to allow communication to the following Digital
Globe server address: 205.166.175.52.

- See also Digital Globe cache settings.

What are the Microsoft Bing Maps proxy and firewall configuration settings?
- If you need to use a proxy, remember to set your Proxy Server settings.

- All communication to Microsoft Bing Maps servers goes through http (SOAP
and regular HTTP GET) on port 80.
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- Any sub-domain of virtualearth.net should be accessible to Viz World Server
and Viz Curious Maps. For example: dev.virtualearth.net,
t1.tiles.virtualearth.net, t3.tiles.virtualearth.net etc.

- See also Bing cache settings.
See Also

Configuring Viz Engine
Server Launcher
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